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ISTIKLAL MARSI

Korkma, sonmez bu safaklarda yiizen al sancak;
Sénmeden yurdumun iistiinde tiiten en son ocak.
O benim milletimin y1ldizidir, parlayacak;
O benimdir, o benim milletimindir ancak.

Catma, kurban olayim, ¢ehreni ey nazlh hilal!
Kahraman 1rkima bir giil! Ne bu siddet, bu celal?
Sana olmaz dokiilen kanlarimiz sonra helal.
Hakkidir Hakk’a tapan milletimin istiklal.

Ben ezelden beridir hiir yasadim, hiir yasarim.
Hangi ¢ilgm bana zincir vuracakmis? Sasarim!
Kiikremis sel gibiyim, bendimi ¢igner, asarim.
Yirtarim daglari, enginlere sigmam, tasarim.

Garbin afakini sarmissa ¢elik zirhli duvar,
Benim iman dolu gégsiim gibi serhaddim var.
Ulusun, korkma! Nasil boyle bir iman1 bogar,
Medeniyyet dedigin tek disi kalmis canavar?

Arkadas, yurduma alg¢aklart ugratma sakin;
Siper et govdeni, dursun bu hayasizca akin.
Dogacaktir sana va’dettigi giinler Hakk’1n;
Kim bilir, belki yarm, belki yarindan da yakin.

Bastigin yerleri toprak diyerek gecme, tant:
Diisiin altindaki binlerce kefensiz yatan.
Sen sehit oglusun, incitme, yaziktir, atant:
Verme, diinyalar1 alsan da bu cennet vatani.

Kim bu cennet vatanin ugruna olmaz ki feda?
Siiheda figkiracak topragi siksan, siiheda!
Canm, cananu, biitiin varimu alsin da Huda,
Etmesin tek vatanimdan beni diinyada ciida.

Ruhumun senden 14hi, sudur ancak emeli:
Degmesin mabedimin gégsiine namahrem eli.
Bu ezanlar -ki sehadetleri dinin temeli-

Ebedi yurdumun iistiinde benim inlemeli.

O zaman vecd ile bin secde eder -varsa- tasim,
Her cerihamdan [1ahi, bosanip kanl yasim,
Fiskirir rub-1 miicerret gibi yerden na’sim;

O zaman yiikselerek arsa deger belki basim.

Dalgalan sen de safaklar gibi ey sanli hilal!
Olsun artik dokiilen kanlarimin hepsi helal.
Ebediyyen sana yok, irkima yok izmihlal;
Hakkidir hiir yasamis bayragimin hiirriyyet;
Hakkidir Hakk’a tapan milletimin istiklal!

Mehmet Akif Ersoy



GENCLIGE HITABE

Ey Turk gengligi! Birinci vazifen, Tirk istiklalini, Tirk Cumhuriyetint,
ilelebet muhafaza ve miidafaa etmektir.

Mevcudiyetinin ve istikbalinin yegane temeli budur. Bu temel, senin en
kiymetli hazinendir. Istikbalde dahi, seni bu hazineden mahrum etmek
isteyecek dahili ve harici bedhahlarin olacaktir. Bir giin, istiklal ve cumhuriyeti
midafaa mecburiyetine diisersen, vazifeye atilmak i¢in, i¢inde bulunacagin
vaziyetin imkan ve seraitini diisinmeyeceksin! Bu imkan ve serait, c¢ok
namiisait bir mahiyette tezahiir edebilir. Istiklal ve cumhuriyetine kastedecek
dismanlar, biitin diinyada emsali goriilmemis bir galibiyetin miimessili
olabilirler. Cebren ve hile ile aziz vatanin biitiin kaleler1 zapt edilmis, biitiin
tersanelerine girilmis, biitiin ordulart dagitilmis ve memleketin her kosesi bilfiil
1sgal edilmis olabilir. Biitiin bu seraitten daha elim ve daha vahim olmak tizere,
memleketin dahilinde iktidara sahip olanlar gaflet ve dalalet ve hattad hiyanet
iginde bulunabilirler. Hatta bu iktidar sahipleri sahsi menfaatlerini,
mustevlilerin siyasi emelleriyle tevhit edebilirler. Millet, fakr u zaruret i¢inde
harap ve bitap diismiis olabilir.

Ey Tiirk istikbalinin evladi! iste, bu ahval ve serait i¢inde dahi vazifen,
Turk 1stiklal ve cumhuriyetini  kurtarmaktir.  Muhta¢ oldugun kudret,
damarlarindaki asil kanda mevcuttur.

Mustafa Kemal Atatiirk
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KITABIN TANITIMI_/

Etkilesimli kitap, video, ses, animasyon,
uygulama, oyun, soru vb. ilave kaynaklara
ulasabileceginiz karekodu gésterir.

Ogrenme biriminin
numarasini gosterir.

3. OGRENME BIRIMi
DIJITAL URETIM « |-

* KAVRAMLAR

Kafi Modelleme, CAD, CAM, CAE Dijfal Urefim Progiamian

U Boyutiu Modelleme, 3D Yazict Bast Parametrik Mode!

U Boyuu Montai, Diftal Urefim Tasiak Gim Komutian

Sketch, Eskiz, Montaj, Joint, Design Komut Yardimiyia Obisier Olugtuma

Tasanm, Assgmble Komut Yordimiyia Nesneleri Dizenieme
Assembly (Nesnelein Montai)

Tasarianan Modein (g Boyuiu Basksm Alma

Ogrenme biriminin
adini gosterir.

Ogrenme biriminin
béliimlerini gésterir.

Ogrenme biriminin
kavramlarini gésterir.

Konu basligini
gosterir.

1. TEMEL TEKNIK RESIM

- @ __________________________________________________ :

Derse baslamadan '
once yapilacak olan
hazirliklari
gosterir.

1. Teknik resim kavramini ve norm yazi standartlarini arastiriniz.

2. izdiisiim ve perspektif kavramlarini aragtiriniz.

1.1. Temel Geometrik Gizimler
e

1.1.1. Gizgi ve Norm Yaz:
Teknik resim cizimler; teknik resim standartlarina gore olusturulan gizgiler, geometrik sekiller ve
yazilardan olusmaktadir. Bu gizimler yapilirken kullanilan gesitli gizim arag geregleri vardir.

1.1.1.1. Teknik Resimde Kullanilan Arag Geregler

Gizin im gizi ag gu masadir. Gizim Gseleri kenarlari

Ve yiizeyi piriizsiiz olmalidir. Bu masalar genellikle egimi ayarlanabilir sekilde dretilir.

; v Alt konu bashiklarini
: gésterir. ;

& :

Gérsel 1.1: Teknik resim masalor
T Cetveli: Teknik resimde en gok kullanilan araglardan biridir. T cetveli genellikle paralel, egik ve diiz
sizgilerin gizilmesinde kullanilir. Gonyelerle yapilacak gizimlerde gonyelere kilavuzluk yapar.

r___ﬁl -

Gérsel 1.2: T cetveli
Gonyeler: Genellikle T cetveli iizerinde kaydirilarak dikey ve eik cizgiler gizmek ve ag1 olusturmak icin
kullanili. Standart gonyelerin agilari 45°x45°x90° ve 30°x60°x90°dir.

Sayfa numarasini
gosterir.

16/ 1. o6ReNNE BiRiMI

g |



Konu igcinde dikkat
edilmesi gereken
yerleri

gosterir.

Ogrenme biriminin

adini gosterir.

Galeri Blog Ofren Ofret Q. @ :

Gérsel 2.5: Cizim programi iist meniisii d

Gizim yeni kendi 2
Ogretmenlerin égrenci gruplar olusturup takip edebilmesi icin Ogret meniisii,
Kullanici profili ile lgili islem yapilmak isteniyorsa profil resmi segilmelidir.

amf:n programinda daha 8nceden tasarlanmis bir tasarim iizerinde degisiklik yapildiginda

cevrimigi olarak degisiklik yapildig: igin tiim ortamlarda degisiklik uygulanacaktir.

iicin Ogren menilsi,

2.1.3. Yeni Tasarim Olusturma

Gizim programi yeni olusturulan her tasarima otomatik olarak isim vermektedir. Kullanici, bu ismi
istii istedigi adi
diigmesine tiklanmas1 yeterli olacaktir.

. Yeni bir tasarim icin Yeni lus

Kayith tasanimlar izerinde galismak

igin tasanim segilerek Bunu diizenle digmesine
tiklanmalidir.

2.1.4. Calisma Diizlemi Kontroll

Gizim programi tasarim ortami, kullanicilara kolaylik saglayacak sekilde tasarlanmistir.

Calisma diizleminde yer alan kontrolleri kullanmak icin asagidaki yonergeleri uygulayiniz.

Yeni bir tasanim olusturunuz.
Gizim programinin tasarima verdigi ismi degistirmek igin tasarim ismini tiklayiniz.
Tasarimin adini ilk Tasarim olarak degistiriniz.

Hon

e = T —
EE.

Gorsel 2.6: ilk Tasarim

SO 2 OGRENME BIRIMI

DUJITAL URETIM

Nesneyi seginiz.
Egri ile olusturulan yiizeyi seginiz.
OK tusuna basarak islemi tamamlayiniz.

Gérsel 3.54: Egiri le govde bolme

3.4. Komut Yardimiyla Objeler Olusturma
Dijital iretim programinda esitli komutlar yardimiyla yeni nesneler olusturulabilir.
3.4.1. Profil Nesnelerini Déndiirerek Yeni Nesne Olusturma

Dijital retim programinda iki boyutlu izimler belirli ydntemlerle bir eksen etrafinda déndirilerek

yeni nesneler olusturulabilir

3.4.1.1. Revolve [Déndiirerek Nesne Olusturma)

Revolve, iki boyutlu nesneleri belirlenen bir eksen etrafinda dondiirerek yeni bir nesne olusturma

komutudur. D8ndiirme ekseni sirekli sizgi veya eksen izgisi olabilir.

httpiitap.eba.gov.tr/KodSor.
Php?KOD=21376

Revolve komutunu kullanarak 80 cm gapinda yuvarlak masa tablasi olusturmak igin

asagidaki yonergeleri uygulayiniz.
XY dilzlemini segerek asaida Slcilleri verilen iki boyutlu sekli iziniz.
Sekli gizdikten sonra Finish Skecth tiklayiniz.

Gorsel 3.55: ik boyutlu gizim

3 0GRANME BIRIMI G117

Konu igindeki

Uygulama
oégrenci

calismalarini
gosterir.

faaliyetlerini gésterir.

Etkilesimli kitap,
video, ses, animasyon,
uygulama, oyun,
soru vb. kaynaklara
ulasabilecediniz link ve
karekodu gésterir.

1. Teknik resimde goriinmeyen kenarlar ve gevreler asagidakilerden hangisi ile gizilir?

A) Sirekli ince cizgi B) Siirekli kalin izgi C) Kesik orta cizgi

O/cme ve D) ince kesik gizgi E) Noktali kesik ince gizgi
degerlendirme
Sayfaslnl 2. Teknik resimde kursun orta kodu
.. . hangisidir?

gosterir.

A) 2H B)28 C)HB D) 3H )38

3. Asagidaki yazi tiplerinden hangisinin yazi kalinhig daha incedir?
A) Yazi tipi A B) Yazi tipi B C) Yaz tipi C

D) Egik yazi

E) Dik yaz!




* KAVRAMLAR

Teknik Resim, Norm Yazi
Uc Boyutlu Gorinis

lzdUistm, Perspekif



1. OGRENME BiRIMI
TEMEL TEKNIK RESIM

E OGRENME BiRiMi BOLUMLERI

Temel Geometrik Cizimler

lzdUstim GoéranUglerini Cizme ve Olgeklendime



1. TEMEL TEKNIK RESIM

@ Hazirlik Caligmalar: |

1. Teknik resim kavramini ve norm yazi standartlarini arastiriniz.

2. Izdlisiim ve perspektif kavramlarini arastiriniz.

1.1. Temel Geometrik Cizimler
1.1.1. Cizgi ve Norm Yazi

Teknik resim cizimleri; teknik resim standartlarina gore olusturulan cizgiler, geometrik sekiller ve

yazilardan olusmaktadir. Bu ¢izimler yapilirken kullanilan gesitli ¢izim arag geregleri vardir.

1.1.1.1. Teknik Resimde Kullanilan Arag¢ Geregler

Cizim Masasi: Resim gizilecek kagidin tutturuldugu masadir. Cizim masasinin koseleri 90 derece,
kenarlari ve ylizeyi plirlizsiiz olmahdir. Bu masalar genellikle egimi ayarlanabilir sekilde Uretilir.

Gorsel 1.1: Teknik resim masalari

T Cetveli: Teknik resimde en ¢ok kullanilan araglardan biridir. T cetveli genellikle paralel, egik ve diz

cizgilerin gizilmesinde kullanilir. Gonyelerle yapilacak gizimlerde gonyelere kilavuzluk yapar.

Gorsel 1.2: T cetveli

Gonyeler: Genellikle T cetveli Gizerinde kaydirilarak dikey ve egik cizgiler cizmek ve aci olusturmak icin
kullanilir. Standart gonyelerin agilari 45°x45°x90° ve 30°x60°x90°dir.
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iletki (Agi6lger): Acilarin dlgiilmesi ve gdnyelerle cizilmesi imkansiz agilarin isaretlenmesi igin kullanilan

Ol¢ii Cetvelleri: Uzunluklarin élgiilmesinde kullanilir.

bir aractir. iletkinin 0°-180°lik ve 0°-360°lik olmak iizere iki ¢esidi mevcuttur.

Gorsel 1.3: Gonye, 6l¢ii cetveli, agidlger
Pergel: Daire ¢izimi, yay ¢izimi, bir 6l¢linlin bir yerden baska bir yere tasinmasi ve belli bir 6lginiin birkag
defa tekrarlanarak isaretlenmesi icin kullanilr.
Sablonlar: Cesitli hazir sekillerin gizilebildigi araglardir. Daire ve yay sablonu, yazi sablonu, elips sablonu

ve sembol sablonlari seklinde cesitleri vardir.

Gorsel 1.4: Daire sablonu

Kalemler: Kursun kalemler, takma uglu kalemler ve teknik ¢izim kalemleri olmak lzere ¢esitleri vardir.

e Kursun kalemler: Teknik resmin cizilmesinde ve yazilarinin yazilmasinda kullanilan siyah kursun
kalemler, sertlik derecelerine gére Uge ayrilir. Kursun kalemlerin sertlik dereceleri, tizerlerine yazilan
harf ve rakamlar ile belirtilir. Bu kalemler sert, yumusak ve orta sertlikte olmak lzere gruplandirihr.

o Sert Kalemler: ingilizce hard (sert) kelimesinin ilk harfi ile ifade edilir. Kursun kalemlerin sertlik
derecesini ifade eden rakamlar harfin soluna konur (2H, 3H, 4H).

o Yumusak Kalemler: ingilizce black (siyah) kelimesinin ilk harfi ile ifade edilir. Harfin soluna konulan
rakamlar blyldikge kalemin yumusakhigi artar (2B, 3B, 4B...).

o Orta Sertlikte Kalemler: HB ve ingilizce firm (dolgun) kelimesinin ilk harfi ile ifade edilir.
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e Takma Uglu (Versatil) Kalemler: 0,3 - 0,5 - 0,7 - 0,9 mm kalinhgindaki grafit uclarin bir boru icinden
gecirilmesiyle olusturulan kalemlerdir. Cizimin 6zelligine gére uglari B, HB ve F sertliginde takma uglu
kalemler tercih edilmelidir.

e Teknik Cizim Kalemleri: Genellikle proje calismalarinda bu kalemlere 6zel miirekkep ile kullanilan,
aydinger kagida ayni kalinlikta yazip cizebilen kalemlerdir.

Gorsel 1.5: Teknik ¢izim kalem takimi

1.1.1.2. Standart Kagit Olgiileri

Teknik resimde kullanilan kagitlar, cizilecek resmin cinsine ve kullanilacagi yere gore secilir. Genel olarak
teknik resimde kullanilan kagitlar bes gruba ayrilir.

e Saydam Olmayan Resim Kagidi: Beyaz renkte, sert ve yirtilmaya karsi dayanikh kagitlardir. Kursun
kalemle iyi ¢izim yapilmasina imkan veren, iz birakmadan silinebilen kagitlardir.

e Aydinger: Bu kagitlara genellikle kopyasi c¢ikarilarak ¢ogaltilacak resimler cizilir. Bu ylizden aydinger
kagitlar, alttaki resmi en ince ayrintisina kadar gosterecek saydamliktadir.

e Ozalit Kagidi: Aydingere cizilmis resimlerin en ucuz cogaltma metodu, ozalit kagidina cikarilan
kopyalardir. Ozalit kagitlari, bir yliziine 1siga karsi hassas 6zel madde strilmus kagitlardir.

e Fotokopi Kagitlari: Teknik resimler fotokopileri alinarak da ¢ogaltilabilir. Fotokopinin ozalit kopyaya
Ustlinltga, resimlerin aydinger kagidina gizilme zorunlulugunun olmamasidir.

e Milimetrik Kagit: Uzerlerine herhangi bir renkte milimetrik taksimat basilmis kagitlardir. Milimetrik
kagitlar genel olarak grafiklerin veya krokilerin cizilmesinde kullanilir.

Teknik resimde kullanilan standart kagit 6l¢lisu, A serisi kagitlardir. Resim kagitlari, tam olgtsiinde veya
resim masalarina yapistirma payi ilaveli olarak kesilir.
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Gorsel 1.6: A serisi kdgit olgiileri
1.1.1.3. Cizgi Cesitleri ve Cizgilerin Kullanildig: Yerler

Bir noktadan baslayip noktanin yiritilmesiile olusan, uzunlugu belli olan bigime ¢izgi adi verilir. Cizgiler,
teknik resmin ayrilmaz unsurlaridir. Teknik resmin dogru okunmasi icin cizgilerin dogru okunmasi gereklidir.

Makine pargalarinin ve endistriyel gizimlerin kagit Gzerindeki anlatimi gesitli cizgilerle olusturulur.
Teknik resimde kullanilan gizgilere standart gizgiler denir.

Tablo 1.1: Cizgi Cesitleri ve Cizgilerin Kullanildigi Yerler

Goriinimi Tiirii ve Kullanim Yeri

Surekli Kalin Gizgi (0,5 mm)
e  Gorunen Kenarlar

GoOrlinen Cevreler

Vida Sonu Cizgisi

Surekli ince Cizgi (0,25 mm)
Olgi Cizgileri
ic Sinir Cizgileri

e  Kesit Taramalari

\/\/\/\/\ Surekli ince Serbest El Cizgisi (0,25 mm)
L[]

Bolgesel Kesit Siniri

ince Kesik Cizgi (0,25 mm)
e  GoOrlinmeyen Kenarlar ve Cevreler
Kalin Kesik Cizgi (0,5 mm)
e islenmis Yiizey Sinirlarinin Gosterilmesi
Noktali Kesik ince Cizgi (0,25 mm)
e  Daire ve Yay Eksenleri
Noktali Kesik Kalin Cizgi (0,5 mm)
e Ozelislemli Yiizeylerin Sinirlarinin Gosterilmesi
iki Noktali Kesik Cizgi (0,25 mm)
Hareketli Pargalarin Sinir Konumlari
Agirlik Merkezi Cizgileri
e  Komsu Pargalarin Cevreleri

Sira Sizde 1

Tablo 1.1'de verilen cizgi cesitlerini teknik resim defterinize sayfa kenar cizgilerinin
1 cm uzagindan baslayip 1 cm uzaginda bitirerek lger tane giziniz.
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1.1.1.4. Standart Yazi Tipleri ve Norm Yazi

Teknik resimde yazilar, karisikhgr dnlemek icin Tirk Standartlari Enstitlist tarafindan yazi tipi A ve yazi
tipi B olmak Uzere iki ayri standarda baglanmistir. Bu iki yazi tipi arasindaki fark, yazi kalinligidir. A tipi yazi,
B yazi tipine gore incedir. Teknik resimde B yazi tipi tercih edilir. Yazi ayrica teknik resimde bigimlerine gore
dik norm yazi ve egik norm yazi olmak Uzere ikiye ayrilir.

Dik norm yazilar, insaat ve mimari teknik resminde kullanilir. Harfler ve rakamlar, satir gizgisine dik yazilir.
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Gorsel 1.7: Dik norm yazi

Sira Sizde 2

Gorsel 1.7’de verilen alfabe, rakam ve sembolleri teknik resim defterinize dik norm
yazi kurallarina uygun olarak yaziniz.
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Egik norm yazilar; makine, elektrik ve elektronik teknik resminde kullanilir. Harfler ve rakamlar, satir

cizgisine 75° saga egik olacak sekilde yazilir.
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Gorsel 1.8: Egik norm yazi

Sira Sizde 3

istiklal Marsi metnini teknik resim defterinize egik norm yazi kurallarina uygun olarak
yaziniz.

1.1.2. Temel Geometrik Cizimler

1.1.2.1. Dogru Gizimi

Cetvel yardimiyla belirlenen uzunlukta bir dogru parcasi ¢izilir ve dogru parcasinin ug¢ noktalari A ve B

olarak adlandirilir. Gonye kullanilarak kaydirma yontemi ile AB dogru parcasina paralel dogrular cizilebilir.

Gorsel 1.9: AB dogru pargasi
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Uygulama: Paralel Cizgiler Cizme

Paralel ¢izgi cizmek icin asagidaki yonergeleri uygulayiniz.
o 30°x60°x90°lik ve 45°x45°x90°lik gonyeleriniziteknik resim defterinizin ¢calisma sayfasina Gorsel 1.10’daki

gibi yerlestiriniz.
e GoOnyelerinizi sabit tutarak 45°x45°x90°lik gényenizin Ust kenart ile bir gizgi ¢iziniz.

Gorsel 1.10: ilk dogruyu cizme

o 45°x45°%90°lik gbnyenizi diger gonyenizi sabit tutarak asagi veya yukariya kaydirip tekrar bir ¢izgi giziniz.

Gorsel 1.11: jlk dogruya paralel dogruyu cizme

e Son islemi tekrarlayarak istediginiz kadar paralel ¢izgi ciziniz. Bu islemi diger c¢izgi cesitleriyle

tekrarlayiniz.

Gorsel 1.12: Cesitli tiirlerde paralel dogrular ¢izme
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Uygulama: Dogrunun Uzerindeki Herhangi Bir Noktadan Dikme Gikma

Dogrunun Uzerindeki herhangi bir noktadan dikme ¢ikmak icin asagidaki yonergeleri uygulayiniz.
e Teknik resim defterinize AB dogrusunu giziniz.

e O noktasindan dogruya A ve B yoniinde iki yay ¢iziniz, bu noktalari C ve D olarak adlandiriniz.

el v,
\ 0 J/

Gorsel 1.13: Dogru tizerinde C ve D noktalarini bulma

e Cve D noktalari merkez olmak tizere dogru tzerinde kesisecek sekilde iki yay ciziniz ve kesisen noktay!
E olarak adlandiriniz.

E

X

- AV
% 8 7

Gorsel 1.14: E noktasini bulma

e E noktasliile O noktasini bir dogru ile birlestiriniz. Boylece AB dogru pargasina dikme ¢ikmis olacaksiniz.

E

—

Gorsel 1.15: E ve O noktasini birlestirme
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Uygulama: Dik Agi Olusturma

Dik aci olusturmak icin asagidaki yonergeleri uygulayiniz.
e Teknik resim defterine BA dogrusunu ciziniz.

A noktasi merkez olacak sekilde pergeli istenilen degerde acarak AB dogrusunu kesen bir yay c¢iziniz ve
dogruyu kesen noktayi C olarak adlandiriniz.

Gorsel 1.16: Dogru lizerinde C noktasini bulma

C merkezli 6nceki yayi kesecek bir yay ciziniz ve yayi kesen noktayi D olarak adlandiriniz.
D

B C\ A

Gorsel 1.17: Yay lizerinde D noktasini bulma

e Cve D noktasindan gececek sekilde bir dogru iziniz.

D noktasini merkez alarak ¢izilen dogruyu kesecek sekilde bir yay giziniz ve kesisen noktayi E olarak
adlandiriniz.

B C\ A

Gorsel 1.18: D ve E noktalarini bulma
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e Ave E noktalarini birlestiriniz.

C

\

Gorsel 1.19: A ve E noktalarinin birlestirilmesi

Uygulama: Dogru Pargasini D6rt Esit Parcaya Bélme

Dogru pargasini dort esit parcaya bdlmek icin asagidaki yonergeleri uygulayiniz.
e Teknik resim defterine AB dogrusu ciziniz.

e ABdogru pargasinin altinda veya Ustlinde olacak sekilde, istenilen agida yardimci bir x dogrusu ¢iziniz.
X

Gorsel 1.20: Yardimci x dogrusunu gizme

e xdogrusu lzerine pergel yardimiyla dort yay kadar isaret koyunuz.
X
) /// B

Gorsel 1.21: x dogrusu lzerine esit aralikli yay ¢izimi

e saretlenen Cile B noktasini birlestiriniz.

X
//<
A B

Gorsel 1.22: C ve B noktalarinin birlestirilmesi
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Gonye yardimiyla CB dogru parcasina paralel dogrular gizerek AB dogrusunu dort esit pargaya bolliniz.

X
C

Gorsel 1.23: CB dogru pargasina paralel ¢izgilerin gizimi

Sira Sizde 4

Teknik resim defterinize bir dogru pargasi gizerek dogruyu yedi esit pargaya bollndiz.

1.1.2.2. Cokgenlerin Cizimi

Uygulama: Daire igine Eskenar Uggen Gizme

Daire igine eskenar liggen ¢izmek icin asagidaki yonergeleri uygulayiniz.

Teknik resim defterinize ilk 6nce O merkezli, birbirine dik iki eksen ¢iziniz. Pergel yardimiyla da O merkezli
bir daire ¢iziniz.

Dairenin eksen ¢izgilerini kestigi noktalari A, B, C ve D olarak adlandiriniz.
B!

Gorsel 1.24: Koordinat diizlemi (izerine daire ¢izimi

D noktasini merkez alarak O noktasindan gececek ve daireyi kesecek sekilde bir yay ¢iziniz.
Yayin daireyi kestigi noktalari E ve F olarak adlandiriniz. E ve F noktalarini cetvel yardimiyla birlestiriniz.

Gorsel 1.25: E ve F noktalarini bulma ve birlestirme
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e Cetvel yardimiyla B ve E ile B ve F noktalarini birlestiriniz. Boylece eskenar licgen olusturacaksiniz.
B!

Gorsel 1.26: B ve E ile B ve F noktalarini birlestirme

Uygulama: Daire igine Eskenar Dortgen Cizme

Daire igine eskenar dortgen ¢izmek icin asagidaki yonergeleri uygulayiniz.

e Teknik resim defterinize ilk nce O merkezli birbirine dik iki eksen ¢iziniz. Pergel yardimiyla da O merkezli

bir daire ciziniz.
e Dairenin eksen ¢izgilerini kestigi noktalari A, B, C ve D olarak adlandiriniz.
e Pergeli B-C araligi kadar aginiz.
e B ve Cnoktalarindan dairenin disina birer yay ciziniz.
e Yaylarin birbirini kestigi noktayi E olarak adlandiriniz.
e Ave B noktalarindan dairenin disina birer yay ciziniz.
e Yaylarin birbirini kestigi noktayi F olarak adlandiriniz.

Gorsel 1.27: E ve F noktalarini bulma

e Eve O noktalarindan gececek, daire kenarlarini kesecek bir dogru ¢iziniz.

e Fve O noktalarindan gececek, daire kenarlarini kesecek bir dogru daha ciziniz.

e Dogrularin daireleyi kestigi noktalari k, I, m, n olarak adlandiriniz.

iD
Gorsel 1.28: k, |, m ve n noktalarini bulma
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e k-l, I-m, m-n ve n-k noktalarini birlestirdiginizde eskenar dortgen ortaya cikacaktr.

F B! 3

Gorsel 1.29: E,skenaf dértgeni olusturma

Uygulama: Daire igine Eskenar Besgen Gizme

Daire icine eskenar besgen cizmek icin asagidaki yonergeleri uygulayiniz.

e Teknik resim defterinize birbirine dik ¢izilen iki eksen lzerine istenilen yaricapta pergel acarak O merkezli
bir daire giziniz.

e Dairenin eksen lizerinde kesistigi noktalari A, B, C, D olarak adlandiriniz.

e Cnoktasini merkez alarak O noktasindan gececek ve daireyi kesecek bir yay ciziniz.

e Yayin daireyi kestigi noktalari E ve F olarak adlandiriniz.

e E ve F noktalarini birlestiren bir dogru giziniz.

e Dogrunun ekseni kestigi noktayi S olarak adlandiriniz.
B!

iD
Gorsel 1.30: E ve F noktalarini bulma ve birlestirme

e Pergeli S-B araligi kadar agarak S merkezli bir yay giziniz.
e Yayin ekseni kestigi noktayi T olarak adlandiriniz.
e Pergeli T-B araligi kadar acarak B merkezli bir yay ¢iziniz.

e Yayin daireyi kestigi noktalari | ve K olarak adlandiriniz.
B!

Gorsel 1.31: T ve K noktalarini bulma
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e B, I, M, N ve K noktalarini birlestirdiginizde eskenar bir besgen ortaya ¢ikacaktr.
B!

e | ve K merkezli, daireyi kesen birer yay ciziniz.

e Yaylarin daireyi kestigi noktalari M ve N olarak adlandiriniz.

Gorsel 1.32: M ile N noktalarini bulma ve eskenar besgeni olusturma

Uygulama: Daire igine Eskenar Altigen Cizme

Daire icine eskenar altigen gizmek icin asagidaki yonergeleri uygulayiniz.

e Teknik resim defterinize birbirine dik ¢izilen iki eksen lizerine pergel agarak istenilen yaricapta O merkezli
bir daire giziniz.

e Dairenin eksen tizerinde kesistigi noktalari A, B, C, D olarak adlandiriniz.

e Cnoktasl merkezli, O noktasindan gececek ve daireyi kesecek bir yay ciziniz.

e Yayin daireyi kestigi noktalari E ve F olarak adlandiriniz.

e A noktasi merkezli, O noktasindan gececek ve daireyi kesecek bir yay giziniz.

e Yayin daireyi kestigi noktalari G ve H olarak adlandiriniz.
B!

Gorsel 1.33: E, F, G ve H noktalarini bulma

e G, A, H, E, C ve F noktalarini cetvel yardimiyla birlestirdiginizde daire icinde diizgiin bir altigen elde

edeceksiniz.
B!

G ——_ —F
iD
Gorsel 1.34: Diizgiin altigeni ¢cizme
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1.2. izdiisiim Goriinislerini Cizme ve Olgeklendirme

1.2.1. izdlisiim Tanimi ve Siniflandiriimasi

izdiisiim, cismin bir diizlem Uzerine ¢izilmis sekli veya izdiisiim diizlemine diisen goriintisidir. Ornegin,
bir 151k kaynagindan (odak noktasi) ¢cikan isinlarla (izdstm isinlari) bir cismin duvara disen gorintlsi bir
izdlslimddr.
iki cesit izdiistim vardir.
e Merkezi (Konik) izdiisiim: Isik kaynaginin yakin mesafede olmasi, cismin boyutlarinin kiiciilerek
veya blylyerek izdlisim dizlemine dismesiyle olusan izdlisimdur. Bu izdlGsim; mimari, reklam ve
dekorasyon teknik resimlerinin gizimlerinde kullanilir.

i/

izDUSUM DUZLEMI

LEHHHHHEEEEEET T

izDUSUM ISINI

Cisim

izpUsUM

ODAK NOKTASI

4 ™™

Gorsel 1.35: Konik izdiisiim
e Paralel izdiisiim: Isik kaynaginin sonsuzda olmasi, cismin boyutlarinin izdiisiim diizlemine biiylime veya
kiicilme gostermeden diismesiyle elde edilen izdlisimdur. Paralel izdiisim, egik ve dik izdiisim olmak
Gzere ikiye ayrilir.

iz DUSUM ISINI o . )
? iz DUSUM DUZLEMI

BRI R

ST

Cisim

ST

iz DUSUM

BT,

S T ™

s

 ics

Gorsel 1.36: Paralel izdiisiim
1.2.2. izdiisiim Diizlemleri

Uretimi yapilacak bir parcanin sadece bir yiizeyinin gériintiisii o parcay! tanimlamaya yetmez. Cismin
tek yonden gorinisi o cisim hakkinda yeterli bilgiyi vermez. Bu nedenle cisimlerin gortntileri birden fazla
izdiistim diizlemine dusirilir. Uzerine izdiisim cizilecek olan diizlemler birbirine bitisik ve dik kabul edilir.
Diedri, temel izdlsiim diizlemlerini bir arada bulunduran kapali sekildir.
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Uygulama: Noktanin izdiisiimii

Uzaydaki bir noktanin diizlem yizeylerine dik gelen isinlarinin degme noktalari, o noktanin izdlisimuni
verir. Bir a noktasinin uzaydaki yerini belirlemek igin aralik, kot ve uzaklik degerleri olmak izere (i¢ elemana
ihtiyag vardir. Teknik resimde bir a noktasinin izdisimu ¢ikarilirken Aralik (noktanin profil izdlisimine
olan mesafesi), Kot (noktanin yatay izdiisiimine olan mesafesi), Uzaklik (noktanin alin izdisiimiine olan
mesafesi) degerleri bilinmelidir.

Diedri tizerinde bulunan izdistiim dizlemleri sunlardir:

1. Alin izdiisiim diizlemi: Onden gériinim icin kullanilir.

2. Yatay izdiisiim diizlemi: Yandan gorinim icin kullanilir.

3. Profil izdiisiim diizlemi: Ustten gériiniim igin kullanihr.

ALIN X PROFiL
U A —_ —
" Aralik : Uzakhk
(] > P
~
< [ I | I N | >
< T N >X
] |
YATAY v

Gorsel 1.37: Diedri gizimi
a noktasinin (Aralik: 3, Kot: 5, Uzaklk: 5) izdtisimlerini bulmak icin asagidaki yonergeleri uygulayiniz.

e Teknik resim defterinize bos bir koordinat dizlemi giziniz.
e Kot: 5 ve Aralik: 3 degerlerine bakarak alin bolgesine y ekseni kot, x ekseni aralik olacak sekilde noktayi

yerlestiriniz.

ALIN A PROFIL

YATAY v

Gorsel 1.38: Noktanin alin izdiisiim diizlemindeki gériintiisii
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e Kot: 5 ve Uzaklik: 5 degerlerine bakarak profil bélgesine y ekseni kot, x ekseni uzaklik olacak sekilde

noktayi yerlestiriniz.

y )
ALIN A PROFiL
a T a
a. it 32
< I A O B | I A R S | >
DB N B B N I B I B
YATAY v

Gorsel 1.39: Noktanin profil izdiisiim diizlemindeki gériinttisii

e Alin bolgesindeki a noktasinin x eksenini kestigi cizgiyi yatay bélgesine kadar uzatiniz.

e Pergeli profil bolgesindeki a noktasinin uzaklk degeri kadar agarak y eksenine dek O merkezli bir yay
giziniz.

e Yayin kestigi noktadan kesik cizgi ile yatay bélgesine bir dogru ciziniz. iki dogrunun yatay bolgesinde

kesistigi nokta, cizdiginiz noktanin son izdlisimudur.

Y .
ALIN A PROFIL

YATAY v

Uzayda iki nokta birlestirildiginde bir dogru parcasi meydana gelir. Dogru pargasinin u¢ noktalarina ait
izdlslmleri ayri ayni cizilip birlestirilirse dogrunun izdlistimleri elde edilir.

iki u¢ noktasi a (Aralik: 3, Kot: 5, Uzaklik: 5) ve b (Aralik: 5, Kot: 2, Uzaklik: 6) olan dogru pargasinin
izdtslmlerini bulmak icin asagidaki yonergeleri uygulayiniz.
e Teknik resim defterinize bos bir koordinat dizlemi ¢iziniz.

e ave b noktasinin kot ve aralik degerlerine bakarak alin bdlgesine iki noktayi yerlestirip birlestiriniz.
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Gorsel 1.41: Dogru pargasinin alin izdiisiim diizlemindeki goriintiisii

e ave b noktasinin kot ve uzaklik degerlerine bakarak profil bolgesine iki noktayi yerlestirip birlestiriniz.

Gorsel 1.42: Dogru pargasinin profil izdiisiim diizlemindeki gériintiisii

Alin bolgesindeki a ve b noktasinin x eksenini kestigi cizgileri yatay bolgesine kadar uzatiniz.

Pergeli profil bolgesindeki a ve b noktalarinin uzaklik degeri kadar agarak y eksenine kadar O merkezli
yaylar ¢iziniz.

Yaylarin kestigi noktalardan kesik cizgi ile yatay bolgesine iki dogru ciziniz. iki dogrunun yatay bélgesinde

kesistigi noktalar, a ve b noktasinin son izdlstimuddr.

Yatayda olusan a ve b noktalarini birlestirdiginizde ab dogru parg¢asinin son izdiisiim{inl olusturacaksiniz.

Gorsel 1.43: Dogru pargasinin yatay izdiisiim diizlemindeki goriintiisi
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Uygulama: Diizlemin izdiisiimii

Uzayda bulunan bir dogru pargasinin yon degistirmeden ve kendi dogrultusunda olmayan hareketiyle
meydana getirdigi ylzeylere diizlem denir. Dizlemler uzayda temel izdlisim dizlemlerine gore cesitli
konumlarda bulunur.

Ug kdse noktasi a (Aralik: 3, Kot: 5, Uzaklik: 5), b (Aralik: 5, Kot: 2, Uzaklik: 6) ve c (Aralik: 1, Kot: 2, Uzaklik:
4) olan diizlemin izdGstmlerini bulmak icin asagidaki yonergeleri uygulayiniz.

e Teknik resim defterinize bos bir koordinat diizlemi giziniz.
e a, b ve c noktalarinin kot ve aralik degerlerine bakarak alin bolgesine bu Ug¢ noktay yerlestirip abc

dizlemini olusturunuz.

v
Gorsel 1.44: Diizlemin alin izdlistim diizlemindeki gériintiisii

e 3, b ve c noktasinin kot ve uzaklik degerlerine bakarak profil bélgesine bu l¢ noktayi yerlestirip abc
dizleminin profil izdlisimini olusturunuz.

v

Gorsel 1.45: Diizlemin profil izdiisiim diizlemindeki gériintiisii

Alin bolgesindeki a, b ve ¢ noktasinin x eksenini kestigi cizgileri yatay bolgesine kadar uzatiniz.

Pergeli profil bolgesindeki a, b ve c noktalarinin uzaklik degeri kadar aciniz. Y eksenine kadar O merkezli

yaylar ciziniz.

Yaylarin kestigi noktalardan kesik cizgi ile yatay bolgesine birer dogru ciziniz. U¢ dogrunun yatay
bolgesinde kesistigi noktalar, a, b ve ¢ noktalarinin son izdtstimleridir.
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Ug noktalarinin degerleri a (Aralk: 4, Kot: 4, Uzakhk: 3), b (Aralik: 4, Kot: 1, Uzaklik: 3),
c (Aralik: 1, Kot: 1, Uzaklik: 1) ve d (Arahk: 1, Kot: 4, Uzaklik: 1) olan abcd dizleminin
izdUstmlerini koordinat diizlemi Gizerine ¢iziniz.

1.2.3. Goriiniis Cikarma

Temel izdlisim dlzlemlerine (alin, profil ve yatay), dik izdUsiim yontemiyle ¢izilen izdlisiimlere goériiniis

adi verilir. Temel izdisiim diizlemlerine pargalarin gériinuslerinin gizilmesine de goriiniis ¢ikarma adi verilir.

Her parcanin yikseklik, genislik ve derinlik olmak Uzere lg¢ boyutu vardir. Bir parganin goriinusleri

cizilmeden once gorinislerin isimleri ve konumlari belirlenir. Parcaya bakarak parca boyutlari ve

gorundslerin birbirleriyle iliskileri bulunur. Gorlintslerde delikler veya kesik gizgiler (goriinmeyen kisimlar)
varsa ifade ettikleri yerler belirlenerek inceleme tamamlanir.

3.USTTEN GORUNUS

\

3

2.YANDAN 1 Q
—

GORUNUS

1.ONDEN GORUNUS

Gorsel 1.47: Parcanin 6nden, lstten ve yandan gériiniisii

Gorilinlsler dizleme yerlestirilirken her bir goriintisiin diizlem eksenlerine uzakliklari esit
olmalidir.
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ALIN (ON GORUNUS) Y PROFIL (YAN GORUNUS)
A

YATAY (UST GORUNUS) ¥

Gorsel 1.48: Gériiniislerin diedri lizerine yerlestirilmesi

Uygulama: Perspektifi Verilen Parganin Ug Gériiniisiinii Koordinat Diizlemine Cikarma

Perspektifi verilen parcanin (g goriinlsini koordinat diizlemine cikarmak icin asagidaki yonergeleri
uygulayiniz.

© N

Gérsel 1.49: Uc gériiniisii ¢izilecek parca

e Koordinat diizlemini giziniz ve cismi inceleyiniz.

e Parganin On, yan ve Ust goriintsinin nasil olabilecegini diisiinlip bos bir yere kabaca cizerek oranl bir
sekilde olgllerini planlayiniz.

e Kenarlar igin ince ¢izgi, gorinmeyen kenarlar icin ince kesik cizgi ve eksenler icin noktali ince kesik ¢izgi
kullaniniz.

e Parganin gorlinisiiniin dizgin yerlestirilmesi i¢in y ve x ekseninde bulunan esit araliklari kullanarak
orantil bir sekilde tagima gizgileri giziniz.

e Koordinat diizlemi lzerine par¢anin 6n goriinlisiini ¢iziniz.
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Gorsel 1.50: Parganin 6n gériintsiiniin diedri lizerine yerlestirilmesi

e Parcanin yan gorlnlsini koordinat dizlemine yerlestirmek icin her dogrunun ug¢ noktalarinin
izdlslmlerini profil bolgesinde bulunuz.

e Tasima gizgilerinizi profil bolgesine uzatarak parganin yan gorindslind ciziniz.

v
x

Gorsel 1.51: Parcanin yan g6riintisiiniin diedri lizerine yerlestirilmesi

Gorilndsler ile eksenler arasinda 1 birim bosluk birakmayr unutmayiniz. Eksenlerden

¢cizdiginiz tasima cizgilerini kolayca silinebilecek sekilde hafif ¢iziniz.
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e Parcanin Ust gorlinisind koordinat dizleminde yerlestiriniz.

A

Gorsel 1.52: Parcanin (ist gériiniisiiniin diedri lizerine yerlestirilmesi

e Tasima cizgilerinizi dikkatli bir sekilde siliniz.

©

Gorsel 1.53: Gortindislerin son gérinimi
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Asagida perspektifi verilen parcanin gorinuslerini teknik resim kurallarina goére
koordinat dizlemi (izerine ¢iziniz.

Gorsel 1.54: Gériiniis cikarilacak par¢anin perspektifi
1.2.4. Olgeklendirme ve Olgekler

istenilen pargalarin yapimi igin gerekli élgiilerin belirli kurallara gére parca veya goriinislerin {izerine
yazilmasi islemine 6lgeklendirme adi verilir.

Teknik resim kurallarina gore ¢izilmis parcanin goériintsleri sadece parcanin sekli hakkinda bilgi verebilir.
Bu nedenle parganin boyutlarinin olglilerine ihtiyag vardir. Ayri ayri yapilan pargalar birlestirildiginde
sorunsuz calismalidir. Bu pargalarin tretimi ancak eksiksiz ve kurallara uygun olcllendirilmis cizimlerle
mumkinddr.

Teknik resmi gizilen parganin resim {izerindeki ¢izim Olglsiiniin o parganin gergek 6lglsiine oranina
olgek adi verilir.

Gergek Olcek, kicliltme 6lgegi ve buyiltme Olcegi olmak tizere (g tiir 6lgek vardir.

o Gergek Olgek: Parcanin gercek 6lciileri ile yapilan 8lgeklendirme gesididir. Olgek 1:1 olarak belirtilir.

e Kiigiiltme Olgegi: Parcanin dlcilerinin kiicltiilerek cizildigi 6lceklendirme cesididir. 1:10, 1:20, 1:30 ...
olarak belirtilir.

o Biiyiiltme Olgegi: Parcanin dlciilerinin biiyiltilerek cizildigi dlgeklendirme gesididir. 2:1, 5:1, 10:1 ...
olarak belirtilir.

Olgeklendirme ¢izim elemanlari ve ¢izim kurallari sunlardir:

o Olgii Sinir Gizgisi: Cizgi kalinhig 0,25 mm olan, surekli ve duz ¢izgidir. Bu gizgiler mutlaka birbirine

paralel olmalidir. Olceklendirme yapilacak yiizeylerin kenar noktalarindan uzatilarak kullanilmalidir.
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o Olgii Cizgisi: Cizgi kalinhig1 0,25 mm olan, strekli ve her iki ucunda ok sekli bulunan diiz ¢izgidir. Oklarin
ug acisi 15 derece ve ikizkenar tiggen seklinde olmalidir. Olgeklendirilen yiizeyin kenarindan yaklasik

7-10 mm uzakhkta, 6lglilendirilecek kenara paralel ve birbirini kesmeyecek sekilde gizilmelidir.

o Olgii Rakamlari: Olgii ¢izgisinin tam ortasina ve 0,5 mm Ustiine yazilan rakamdir.

Ol¢li Rakami

!

30 — Olgii Sinir Cizgisi

-

Olcii Cizgisi

Gorsel 1.55: Olceklendirme ¢izim elemanlari

Uygulama: Goriiniis Olgiilendirme

Gorlinls Olgeklendirme igin asagidaki yonergeleri uygulayiniz.

e Asagida verilen goriinlist teknik resim kurallarina gore cetvelle 6lgerek teknik resim defterinize ciziniz.

Gorsel 1.56: Olceklendirilecek gériiniis
!

o Olgi sinir gizgilerini giziniz.

Gorsel 1.57: Goriintistin 6l¢i sinir gizgilerinin gizilmesi
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o Olgli gizgilerini giziniz.

| ==t

gt

|

Gorsel 1.58: Gériintisiin 6l¢ii gizgilerinin gizilmesi

Olguler yazilmahdir.

e Norm yazi kurallarina gore 6l¢ii rakamlarini yaziniz.

Resimler hangi 6lgekle cizilirse ¢izilsin, Gizerine parcanin gercek buyiklugini gosteren

10

40

Gorsel 1.59: Gériintsiin 6l¢ii rakamlarinin yazilmasi

10
R

! A
B B 20
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20

Y
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Asagida perspektifi verilen parcanin ¢ goriinlisiinii gikarip 6l¢llendiriniz.

________________________________________________________________________

09

w
.

//‘7<3s /\ / .
A
SRR

Gorsel 1.60: Parga perspektifi
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— Ol¢me ve Degerlendirme

1. Teknik resimde goriinmeyen kenarlar ve ¢evreler asagidakilerden hangisi ile gizilir?

A) Sirekli ince gizgi B) Suirekli kalin ¢izgi C) Kesik orta cizgi
D) ince kesik ¢izgi E) Noktali kesik ince ¢izgi

2. Teknik resimde kullanilan kursun kalemlerden orta sertlikteki kalemlerin kodu asagidakilerden

hangisidir?

A) 2H B) 2B C)HB D) 3H E) 3B
3. Asagidaki yazi tiplerinden hangisinin yazi kalinigi daha incedir?

A) Yazi tipi A B) Yazi tipi B C) Yazi tipi C
D) Egik yazi E) Dik yazi

4. 45-30-60 derecelik gonyeler ile agsagidaki agilardan hangisi cizilemez?

A) 45 B) 75 C) 105 D) 90 E) 20

5. Teknik resimde asagidaki kagitlardan hangisi kullanilmaz?

A) Aydinger B) Kraft kagidi C) Ozalit kagidi
D) Milimetrik kagit E) Saydam olmayan resim kagidi
6. . Pergel
II. 45°%lik gonye
1. 30°-60°lik gonye
IV. iletki

Birbirine paralel cizgiler ¢izmek igin yukaridaki araclarin hangisi ya da hangilerinin kullanilmasi
yeterlidir?

A)lvell B) lll ve IV C)llvelll
D) Il ve IV E) I, lvelll
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7. Bir cismin izdiisiim diizlemine diisen goériintiisiine verilen ad asagidakilerden hangisidir?

A) izdiisim B) izdlsiim 151N C) izdiisiim noktasi

D) Odak noktasi E) Bakis agisi

8. Teknik resimde en ¢ok kullanilan izdiigiim sekli agagidakilerden hangisidir?

A) Konik izdisiim B) Egik izdlisiim C) Dik izdlisim

D) Paralel izdislim E) Capraz izdislim

9. izduisiim isinlarinin giktigi varsayilan noktaya verilen ad asagidakilerden hangisidir?

A) izdiisim noktasi B) izdisiim 151n1 noktasi C) izdiisiim noktasi
D) Odak noktasi E) Paralel izdiisiim noktasi
10.
Y
A
1.Bolge —+ 2.Bolge
3.Bolge :
v

Yukaridaki koordinat diizleminde 1.Bélge, 2.B6lge ve 3.Bolge olarak tanimlanan bélgelerin

siralanisi agagidakilerden hangisinde dogru verilmistir?

A) Alin-Profil-Yatay B) Yatay-Alin-Profil C) Profil-Alin-Yatay
D) Alin- Yatay-Profil E) Profil-Yatay-Alin
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11. Alin bolgesine yerlestirilen goriiniis asagidakilerden hangisidir?

A) Arka B) Yan C) Alt
D) Ust E) On

12. Noktaninizdiisiimii gcikarilirken noktanin alinizdiisiimiine olan mesafesine verilen ad asagidakilerden
hangisidir?

A) Uzaklik B) Aralik C) Kot
D) Deger E) izdiistim

13. Cisimlerin goriiniuslerinin temel izdliisim diizlemlerine cizilmesine verilen ad asagidakilerden

hangisidir?

A) Gorlinls B) Goriinis ¢ikarma C) On goriinis

D) Ust goriiniis E) izdiisiim

14. Parga Olgilerinin kendisi veya goriiniislerinin lizerine yazilmasina verilen ad asagidakilerden
hangisidir?

A) Olgii cizgisi B) Olgeklendirme C) Olgii
D) izdiisiim E) Olgii alma

15. Olgii gizgisinin cizgi kalinhig1 asagidakilerden hangisidir?

A) 0,5 mm B) 0,75 mm C) 0,25 mm
D) 0,1 mm E) 0,4 mm
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2.BILGISAYARLI CiziMm

% Hazirlik Caligmalar: |

1. Ug boyutlu gizim programlarini arastiriniz.

E 2. Ug boyutlu yazicilari arastiriniz.

____________________________________________________________________

2.1. Cizim Programi Araylizii

2.1.1. Hesap Olusturma

Web arayizlii ¢izim programinin en dnemli 6zelligi, tek kullanici hesabiyla tim ortamlardan kullanicinin
olusturdugu tasarimlara ulasilabiliyor olmasidir. Cizim programinin Tiirk¢e destegi bulunmaktadir. Tasarim
yapilabilmesi icin kayit islemi gerekmektedir. Cizim programina herkes kayit yaptirabilir. 12 yasindan kiiguk
bir kullanici kayit yaptiysa ebeveyninin mail adresine bir aktivasyon bilgisi gitmektedir. Kullanici, ebeveyni
onayladiktan sonra sisteme giris yapabilmektedir.

Uygulama: Hesap Olusturma

Hesap olusturma islemi igin asagidaki yonergeleri uygulayiniz.

e Cizim programi web sitesine giriniz.

e Sag st kosede yer alan Hemen Katil linkine tiklayiniz.

Galeri Blog Ogren Ogret Q  Girisyap [GEAYATEG: N

Gorsel 2.1: Cizim programina giris

e Kisisel Hesap Olustur linkine tiklayiniz.

e Hesapolusturmayontemleriicin birdenfazlasecenek sunulmaktadir. Diger oturum agcmaseceneklerinde
OAuth yontemi ile oturum agabilirsiniz. E-posta yontemi ile devam etmek icin E-postayla Kaydol
linkine tiklayiniz.

e Ulke ve dogum tarihi seceneklerini uygun sekilde isaretleyiniz.

e Sonraki linkine tiklayiniz.

OAuth, kullanicilarin kendi hesaplarina ait sifreleri paylasmadan lglncl taraf web |

sitelerine erismek icin kullanilan agik standarth bir yetkilendirme protokollddr. !

e E-posta adresinizi giriniz.

e Sifrenizi giriniz.

Sifre belirlerken giiclii sifre dlciitlerine uygun bir sifre olusturulmalidir. Sifre dlciitleri; en

az 1 harf, en az 1 sayi, en az 8 karakter, en az 3 benzersiz karakter girilmesidir. J
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e Hizmet sartlarini ve gizlilik beyanini kabul ediniz.
e Hesap olustur linkine tiklayiniz.

Hesap olustur
E-posta
kullanici@site.com.tr v

Parola

Tinkercad Hizmet Sartlanm ve Autodesk Gizlilik Beyanim
kabul ediyorum.

HESAP %L@TUR

Gorsel 2.2: Hesap olusturma

2.1.2. Gizim Programi Ortami

Cizim programi, kolay anlasilabilir bir araylize sahiptir. Cizim programina giris yapildiktan sonra

asagidaki arayliz ekrana gelecektir.

Galeri Blog Ogren  Ogret Q @
.
Gegmis tasarimlarm
&
Bilisim Teknolojileri Alanm

3D Tasanmlar

Circuits

Kod Bloklan YENI

Dersler

Projeler

i + i Proje olustur

Tweet'ler Takip et

Gorsel 2.3: Cizim programi arayiizii
Sol meniden;
e Ug boyutlu tasarim yapilmak isteniyorsa 3D Tasarimlar meniisi,
e Arduinoile sanal devreler kurulmak isteniyorsa Circuits mensd,
e Kod bloklari ile Gi¢ boyutlu tasarim yapilmak isteniyorsa Kod Bilisim Teknolojileri Alam
Bloklari menisd,
e Daha Onceden tamamlanmis egitimler goruntilenmek asarm ara...

isteniyorsa Dersler men(si secilmelidir.
3D Tasanmlar

Ust meniiden;

e Cizim programina kayith kullanicilarin paylasimlarini incelemek Circuits

ve kullanmak icin Galeri mensd, Kod Bloklar VENi

e Cizim programi ile ilgili ¢calismalar incelenmek istenirse Blog

meniisi, Dersler

Gorsel 2.4: Cizim programi sol mendisii
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Galeri Blog Ogren  Ogret Q @

Gorsel 2.5: Cizim programi tist mendisii

e Cizim programina yeni baslayanlarin kendi kendilerine 6grenme saglayabilmeleri icin Ogren meniisd,

e Ogretmenlerin 6grenci gruplari olusturup takip edebilmesi icin Ogret mendisi,

e Kullanici profili ile ilgili islem yapilmak isteniyorsa profil resmi secilmelidir.

e Son olarak arayliziin orta alani ise kullanici tarafindan daha 6nceden olusturulmus tasarimlarin yer
aldig1 bolimddr.

Cizim programinda daha 6nceden tasarlanmis bir tasarim tizerinde degisiklik yapildiginda

cevrimigi olarak degisiklik yapildigi i¢in tim ortamlarda degisiklik uygulanacaktir. :

2.1.3. Yeni Tasarim Olusturma

Cizim programi yeni olusturulan her tasarima otomatik olarak isim vermektedir. Kullanici, bu ismi
degistirerek tasarimlara istedigi adi verebilmektedir. Yeni bir tasarim olusturmak icin Yeni Tasarim Olustur
diigmesine tiklanmasi yeterli olacaktir.

Kayith tasarimlar lzerinde calismak icin tasarim secilerek Bunu diizenle diigmesine
: tiklanmahdr.

2.1.4. Galigma Diizlemi Kontrolleri

Cizim programi tasarim ortami, kullanicilara kolaylik saglayacak sekilde tasarlanmistir.

Uygulama: Temel Kontroller

Calisma dizleminde yer alan kontrolleri kullanmak icin asagidaki yonergeleri uygulayiniz.
e Yeni bir tasarim olusturunuz.

e Cizim programinin tasarima verdigi ismi degistirmek i¢in tasarim ismini tiklayiniz.
e Tasarimin adini ilk Tasarim olarak degistiriniz.

[T/ 1[N]
@ =] [lk Tasanm
c [AlD] = [ ]

Gorsel 2.6: ilk Tasarim
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Uygulama: Temel islem Kontrolleri

Calisma dizleminde yer alan kontrolleri kullanmak icin asagidaki yonergeleri uygulayiniz.

e Yeni bir tasarim olusturunuz.

e Tasarimin adini Temel islem Kontrolleri olarak degistiriniz.

qom
i [E] flk Tasanm
c|AlD]

Gorsel 2.7: Sekillerin ¢alisma diizlemine eklenmesi

B> s 2@

Ice Aktar  Disa Aktar Gonder
ﬁl E
it
Cahsma Duzlemi Cetvel

Tinkercad

Temel Sekiller

Silindir
) Kutu Silindir

Kure Scribble
Catl Koni

e Cahlsma dizleminde segcili sekli kopyalamak icin Kopyala (Ctrl+C) digmesine tiklayiniz.

o Kopyalanan sekli yapistirmak igin Yapistir (Ctrl+V) digmesine tiklayiniz.

e Cahsma dizleminde segili sekli gogaltmak igin Duplicate and repeat (Ctrl+D) digmesine tiklayiniz.

e (Calisma dizleminde secili sekli silmek icin Sil (Delete) digmesine tiklayiniz.

e Sonyaplilanislemleri geri almak icin Geri Al (Ctrl+Z) digmesine tiklayiniz.
e Son yapilan islemleri yinelemek igin Yinele (Ctrl+Y) digmesine tiklayiniz.

OOl « -

Gorsel 2.8: Temel islem kontrolleri

Tasarima farkl agilardan bakmak, tasarimi kolaylastiracaktir. Tasarimlara farkli agidan bakmak igin

gorinam kontrolleri kullanihr.
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Uygulama: Goriiniim Kontrolleri 1

Calisma dizleminde yer alan kontrolleri kullanarak gérinimu degistirmek icin asagidaki yonergeleri
uygulayiniz.

e Yeni bir tasarim olusturunuz.

e Tasarimin adini Goériiniim Kontrolleri 1 olarak degistiriniz.

e Calisma diizlemine kutu ekleyiniz.

e Calsma diizleminin sol tarafinda yer alan goriinim kipiinG fare (mouse) ile yénlendirerek tasarim

ortaminin bakis agisini degistiriniz.
gl:] Goriiniim Kontrolleri
|<[A[D]

i} “«- -

Gorsel 2.9: Gériiniim degistirme

e Calisma diizleminin tamamini gérmek icin Ana Ekran goriiniimii digmesine tiklayiniz.
e (Cizilen sekli ekrana sigdirmak i¢in Tumiinii goriiniime sigdir (F) digmesine tiklayiniz.
e Cahsma dizleminin gériinimini yakinlastirmak icin Yakinlastir (+) diigmesine tiklayiniz.

e Cahsma dizleminin goriinimiini uzaklagtirmak icin Uzaklagtir (-) digmesine tiklayiniz.

e (Cizilen seklin iki boyutlu gorinimine ge¢mek icin Diiz gériiniime geg diigmesine tiklayiniz.

Gorsel 2.10: Diiz gériiniime geg diigmesi
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Uygulama: Goriiniim Kontrolleri 2

CGalisma dizleminin boyutunu degistirmek icin asagidaki yonergeleri uygulayiniz.

e Yeni bir tasarim olusturunuz.
e Tasarimin adini Goriiniim Kontrolleri 2 olarak degistiriniz.
e Calisma dizleminin boyutunu degistirmek icin Calisma diizlemi 6lcimleri diigmesine tiklayiniz.

I1zg. Dil

V)

Izgakayl Tuttur - 1.0 mm =

[

Gorsel 2.11: Calisma alani élgiimleri diigmesi

e Birimler bolimini secerek 6lcl birimini degistiriniz.

e Genislik ve uzunluk degerlerini degistiriniz.

Cizim programi, calisma diizleminde genislik ve uzunluk icin maksimum 1000 mm

Olclsuni desteklemektedir.

e lzgarayi Giincelle linkine tiklayarak ¢alisma diizlemi 6lgiilerini degistiriniz.
e Sekillerin tasinmasi sirasinda kilavuz gizgilerine tutunma araliklarini degistirmek igin lzgarayi Tuttur

secenegini isaretleyiniz.

2,0 mm

5,0 mm

lzgakayi Tuttur | 10 @m -

Gorsel 2.12: Izgarayi tuttur diigmesi

Sira Sizde 2

Ana sayfaya dénerek 6nceden olusturdugunuz baska bir tasarimi acginiz. .
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2.2. Ug Boyutlu Modelleme

Nesneler gercek diinyada ii¢c boyutlu olarak algilanir. U¢ boyut; bir nesneye ait yiikseklik, genislik
ve derinlik algisidir. Cesitli programlar araciligiyla bir nesnenin giziminde genislik, yikseklik ve derinlik
dzelliklerinin kullanilmasi Gic boyutlu modelleme olarak tanimlanir. istenilen seklin modelini hazirlamak
icin hangi teknigin kullanildigindan ¢ok gercege ne kadar yaklasildigi 6nemlidir (Giler, 2014).

Ug boyutlu modelleme yapilirken nesnenin 6nden, yandan ve Uistten goriiniisleri cikartilir. Bu gériiniisler
Gzerinde nesnenin modeli olusturulur. Modelleme islemi ¢esitli yontemlerle yapilabilir: Bir nesneye ait U¢
boyutlu model tek bir gorintide hazirlanabilir veya nesnenin her bir parcasi ayri ayri modellenerek bu
parcalarin birlestirilmesiyle de olusturulabilir.

2.2.1. Temel Sekiller

Sekiller, cizim programinin temel yapi nesneleridir. Cizim programi, li¢ boyutlu nesnelerin hemen
hemen hepsini kullanicilarin hizmetine sunmaktadir. Calisma diizlemine eklenerek bu sekiller tzerinde
islem yapilabilir, birden fazla sekille yeni sekiller tasarlanabilir.

Temel sekiller mentsl altinda geometrik sekillerin (i¢ boyutlu modelleri yer almaktadir. Metin ve
sayilar menisi altinda Gg¢ boyutlu metin yazilmak istendiginde kullanilabilecek modeller vardir. Karakterler
menUsl altinda tasarimlarda kullanilabilecek basit karakter tasarimlari bulunmaktadir. Sekil olusturucular

altinda ise tasarlanmis sekiller yer almaktadir.

Uygulama: Sekil Yerlestirme

CGalisma dlzlemine bir sekil yerlestirmek ve seklin goriiniimini degistirmek igin asagidaki yonergeleri
uygulayiniz.
e Yeni bir tasarim olusturunuz.
e Tasarimin adini Sekil Yerlestirme olarak degistiriniz.
e Calisma dizlemine bir kutu ekleyiniz.

e Sekil 6zelliklerinden kutunun rengini mavi olarak degistiriniz.

A sekil s © L

Calisma Diizlemi Cetvel

’&} Tinkercad

Temel Sekiller

Delik

B Onayarlar Ozel

'\ @ e
. @ areeees o

. escsesnfesss"s

: Yi | | t [ Seffaf

Gorsel 2.13: Sekil renk 6zelligi

e Calisma diizlemine bir piramit ekleyiniz.
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e Sekil 6zelliklerinden piramidin rengini kirmizi olarak degistiriniz.

e Piramidin kose sayisini sekil taraflar 6zelliginden 10 olarak degistiriniz.

- seKil - v Eﬁa

Calisma Diizlemi

Temel Sekiller
Kati Delik

Yuvarlak Cats

_____ 1 1
f i { i i i \ | | \ \ \ . \ A 01mm
/ { | { | 4 | 4 + i} '. A X ._ { Dilim
/ ! | i 1 \ 3 A | 0,25 mm
Gorsel 2.14: Sekil taraflar ézelligi
e Calisma diizlemine bir B harfi ekleyiniz.
e B harfinin rengini yesil olarak degistiriniz.
- seKil m v Eﬁj

Calisma Dizlemi

Metin ve sayilar
Kati Delik

Onayarlar Ozel

[
a8 co00080
T ecocsees
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ey

Cetvel

Piramit

By

Cetvel

| " ‘: [ seffaf ?

Gorsel 2.15: Harf ekleme

e Karakter mendsiini seginiz.
e Calisma diizlemine Scuba Maskesi (dalis maskesi) karakterini ekleyiniz.

- Scuba Mask . Y m}_—j
i

Calisma Diszlemi

Karakter
Kat1 Delik
| Adventures under the sea! g—p :'-—\
) El

Gorsel 2.16: Karakter ekleme

by

Cetvel

&

Bans Eli

@/
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Uygulama: Sekil Tagima

Calisma dizlemine eklenen seklin yerini degistirmek icin asagidaki yonergeleri uygulayiniz.
e Yeni bir tasarim olusturunuz.
e Tasarimin adini Sekil Tagima olarak degistiriniz.

e Calisma diizlemine yan yana dort tane kutu ekleyiniz.

Gorsel 2.17: Tasinacak sekillerin eklenmesi

e Farenin sol tusunu tiklayarak her kutuyu calisma diizleminin kdselerine tasiyiniz.

Gorsel 2.18: Tasima islemi

Uygulama: Sekil Dondiirme

Calisma dizlemine eklenen sekli dondiirmek icin asagidaki yonergeleri uygulayiniz.
e Yeni bir tasarim olusturunuz.
e Tasarimin adini Sekil Déndiirme olarak degistiriniz.

e Calisma diizlemine yan yana (g tane kutu ekleyiniz.

T S S R T e

[ SR ST YOS (PSRN (YA e Sy SO [ TS GBI § LA FRSUIARS, W, testn Ty, SV fE0in PG )

Gorsel 2.19: Déndiiriilecek sekillerin eklenmesi
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e Dondirmek istediginiz sekli seciniz. Sekli dondirmek icin tutamaclari kullanabilirsiniz.
e Dondirme isleminde en iyi goriinimi elde etmek igin ¢alisma dizlemini dondiriniz.
e Her sekli gorselde goruldugi gibi 45 derece dondirmek icin egri oklari kullaniniz.

Gorsel 2.20: Sekil dondiirme

Uygulama: Sekil Boyutlandirma

Calisma duzlemine eklenen sekli boyutlandirmak icin asagidaki yonergeleri uygulayiniz.

e Yeni bir tasarim olusturunuz.
e Tasarimin adini Sekil Boyutlandirma olarak degistiriniz.
e Calisma dizlemine (g tane kutu ekleyiniz.

Gorsel 2.21: Boyutlandirilacak sekillerin eklenmesi

Boyutlandirma isleminde en iyi goriinim elde etmek i¢in ¢alisma dizlemini dondiriiniz.

e Her sekli gorselde gorildigi gibi bir kenari 50 mm olacak sekilde boyutlandiriniz.

Elegdpd i cin Hh il

Tzgaray1 Tuttur | 1.0 mm =

Gorsel 2.22: Sekillerin boyutlandiriimasi
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Tasima degeri, dondirme acisi ve boyut degerleri fare yardimiyla veya klavyeden degerler

AY
1
1

girilerek yapilabilir. '

Sira Sizde 3

Temel sekillerle ilgili tasima, dondirme ve boyutlandirma islemini silindir Uzerinde \:
uygulayiniz. '

2.2.2. Gruplama ve Grup Cozme

Temel sekillerle tasarim yapmak bazen yetersiz kalmaktadir. Temel sekiller birlestirilerek yeni sekiller
olusturulabilir.

Uygulama: Sekil Gruplama

CGalisma dizlemine eklenen sekilleri gruplandirmak igin asagidaki yonergeleri uygulayiniz.

e Yeni bir tasarim olusturunuz.
e Tasarimin adini Sekil Gruplama olarak degistiriniz.
e (Calisma diizlemine iki tane kutu ekleyiniz.

Gorsel 2.23: Gruplama islemi icin birinci nesnelerin eklenmesi

Calisma dizlemine kutularin ortasina gelecek sekilde iki tane silindir ekleyiniz.

Silindirleri 10x10x30 mm olacak sekilde boyutlandiriniz.

Gorsel 2.24: Gruplama islemi igin ikinci nesnelerin eklenmesi

e Shift tusuna basili tutarak birinci kutuyu ve birinci silindiri seginiz.
e Ust meniiden Gruplandir (Ctrl+G) diigmesine tiklayiniz. Grup rengi, grubu olustururken segilen ilk sekil
ile eslesecektir.

e Shift tusuna basili tutarak ikinci silindiri ve ikinci kutuyu seginiz.
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e Ust meniiden Gruplandir (Ctrl+G) diigmesine tiklayiniz. Grup rengi, grubu olustururken segilen ilk sekil

ile eslesecektir.

Gorsel 2.25: Gruplanan sekiller
e Grubu ¢ézmek igin st mentiden Grubu €6z (Ctrl+Shift+G) digmesine tiklayiniz.
2.2.3. Eksiltme Ozelligi

Sekil birlestirme isleminde bir sekil, baska bir sekilden eksiltme yoluyla cikartilarak yeni sekiller

olusturulabilir.

Uygulama: Sekil Eksiltme

Calisma dizlemine eklenen sekillerde eksiltme islemi yapmak icin asagidaki yonergeleri uygulayiniz.

e Yeni bir tasarim olusturunuz.

e Tasarimin adini Sekil Eksiltme olarak degistiriniz.

e Calisma diizlemine bir kutu ekleyiniz.

e Calisma diizlemine kutularin ortasina gelecek sekilde bir silindir ekleyiniz.
e Silindiri 10x10x30 mm olacak sekilde boyutlandiriniz.

e Silindir seklini seciniz ve silindirin 6zelliklerinden Delik 6zelligini seciniz.

A T
e

Gorsel 2.26: Eksiltme uygulanacak sekillerin eklenmesi

e Shift tusuna basili tutarak kutuyu ve silindiri seginiz.
e Ust meniiden Gruplandir (Ctrl+G) diigmesine tiklayiniz. Béylece kutu seklinden silindir sekli eksiltilmis

olacaktir.

Gorsel 2.27: Eksiltme uygulanan sekiller
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2.2.4. Hizalama Ozelligi

Hizalama secgenegi, bir sekil olustururken sekilleri siralamak igin kullanicilara yardimci olmaktadir.
Hizalama islemi, yatay ve dikey olmak lzere iki sekilde yapilabilir.

Uygulama: Sekil Hizalama

Calisma dlzlemine eklenen sekilleri hizalamak i¢in asagidaki yonergeleri uygulayiniz.

e Yeni bir tasarim olusturunuz.
e Tasarimin adini Sekil Hizalama olarak degistiriniz.
e Calisma duzleminde farkl yerlere (¢ kutu ekleyiniz.

e Birinci sekle dokunmadan ikinci sekli 5 mm, Gglincu sekli ise 10 mm yikseltiniz.

Gorsel 2.28: Hizalanacak sekillerin eklenmesi

e Shift tusuna basili tutarak g sekli de seginiz.

o Tumsekiller seciliyken Gst menlde yer alan Hizala (L) diigmesine tiklayiniz. Hizala digmesine tikladiktan
sonra hizala tutamaclari sekillerin cevresinde gorindr.

e Hizalamanin 6n izlemesini gormek icin farenizi siyah hizalama tutamaclarinin her birinin Gzerine
getiriniz.

e Hizalama tutamaclarindan herhangi birine tiklayarak sekilleri tasiyiniz.

e Arag cubugundaki Geri Al diigmesini kullanarak gerekirse son isleminizi geri alabilirsiniz.

e Calisma duzlemindeki kutulari yatay hizalama tutamaclarini kullanarak birinci kutuya yatayda

hizalayiniz.

Gorsel 2.29: Yatay hizalama uygulanan sekiller

e Calisma dizlemindeki kutulari dikey hizalama tutamaglarini kullanarak ikinci kutuya dikeyde hizalayiniz.
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- S flapes[B)
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Gorsel 2.30: Dikey hizalama yapilan sekiller

2.2.5. Ornek Uygulamalar

http://kitap.eba.gov.tr/KodSor. '

e _ FEal 3
. hp?KOD=21370 Fytd =
Uygulama: Yiziik Yapimi php ) .!_.1_ x i

e Yeni bir tasarim olusturunuz.

e Tasarimin adini Yuziik Yapimi olarak degistiriniz.

e Calisma diizlemine bir silindir ekleyiniz ve ¢api 21 mm olacak sekilde silindiri boyutlandiriniz.

e (Calisma dizlemine yeni bir silindir daha ekleyiniz ve ¢capi 17 mm olacak sekilde silindiri boyutlandiriniz.

e Her iki sekli de seginiz ve 4 mm yikseklige olgeklendiriniz.

e ikinci silindiri secerek silindirin dzelligini Delik olarak degistiriniz.

e Hizalama 0Ozelligini kullanarak sekilleri merkezde hizalayiniz.

e Her iki 6geyi de secili tutunuz ve meni ¢ubugundaki Gruplandir (Ctrl+G) digmesini kullanarak bunlari
gruplandiriniz.

e Calisma diizleminde dik duracak sekilde ylziigli dondiriniz.

Gorsel 2.31: Cizim programi ile ytiziik yapimi

Uygulama: Cikolata Yapimi

e Yeni bir tasarim olusturunuz.

e Tasarimin adini Cikolata Yapimi olarak degistiriniz.
e Calisma diizlemine bir kutu ekleyiniz.

e Kutunun yiksekligini 10 mm olarak ol¢eklendiriniz.

e Kutunun enini ve boyunu 100x100 mm olarak olceklendiriniz.
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Gorsel 2.32: Cikolata zemininin olusturulmasi

e Calisma dizlemine bir ¢ati sekli ekleyiniz.
e Catinin enini ve boyunu 20x100 mm olarak 6lgeklendiriniz.
e Cati seklini Duplicate and repeat (Ctrl+D) diigmesi ile 6 adet yan yana ¢ogaltiniz.

e (Cati sekillerini Gruplandir (Ctrl+G) diigmesi ile gruplandiriniz.

Gorsel 2.33: Gruplandirilmis ¢ati sekilleri

e Cati sekillerini ters donecek sekilde 180 derece dondiriiniiz.

e Kutu ve ¢ati grubunu Hizala (L) diigmesi ile merkezden hizalayiniz.
e Catigrubunu 5 mm yukari kaldiriniz.

e Cati grubunun 6zelligini Delik olarak degistiriniz.

e Catigrubunu Duplicate and repeat (Ctrl+D) diigmesi ile cogaltiniz.
e Yeni ¢ati grubunu yatayda 90 derece dondiriiniz.

- ST o Bk B gl S et A

Gorsel 2.34: Cikolata kalibinin olusturulmasi

e Tuam sekilleri seciniz ve Gruplandir (Ctrl+G) diigmesi ile gruplandiriniz.

e Olusturdugunuz seklin rengini kahverengi olarak degistiriniz.
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Gorsel 2.35: Tamamlanmis gikolata tasarimi

O Sira Sizde 4

Cikolata yapimi uygulamasini farkl sekillerle yapiniz. .

http://kitap.eba.gov.tr/KodSor. g3
php?KOD=21372
Uygulama: Bayrak Yapimi

e Yeni bir tasarim olusturunuz.

e Tasarimin adini Bayrak Yapimi olarak degistiriniz.
e Calisma diizlemine bir kutu ekleyiniz.

e Kutunun yiksekligini 3 mm olarak élgeklendiriniz.

e Kutunun enini ve boyunu 100x150 mm olarak dl¢eklendiriniz.

Gorsel 2.36: Bayrak zemininin olusturulmasi

e Calisma diizlemine bir silindir ekleyiniz.

e Silindirin ytksekligini 3,1 mm olarak 6lgeklendiriniz.
e Silindir capini 50 mm olarak olgeklendiriniz.

e Calisma dizlemine yeni bir silindir ekleyiniz.

e Silindirin yiksekligini 3,5 mm olarak 6lceklendiriniz.
e Silindirin capini 40 mm olarak 6l¢ceklendiriniz.

e ki silindiri secip Hizala (L) diigmesi ile merkezden hizalayiniz.
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Gorsel 2.37: Hilalin olusturulmasi igin silindirlerin kullanimi

e Kiglk silindiri merkezden saga dogru 6,25 mm kaydiriniz.

e Kk silindirin 6zelligini Delik olarak degistiriniz.

o ki silindiri secerek Gruplandir (Ctrl+G) diigmesi ile gruplandiriniz.
e Silindir grubunun rengini beyaz olarak degistiriniz.

Gorsel 2.38: Hilalin olusturulmasi

e Kutu ve silindir grubunu orta-solda Hizala (L) digmesi ile hizalayiniz.

e Silindir grubunu 27 mm saga kaydiriniz.

Gorsel 2.39: Hilalin yerlestirilmesi

e Calisma duzlemine bir yildiz ekleyiniz.

e Yildizin yiksekligini 3,10 mm olarak ol¢eklendiriniz.

e Yildizi 110 derece dondiiriniz.

e Yildizin enini ve boyunu 23x23 mm olarak dlgeklendiriniz.

e Yildizin rengini beyaz olarak degistiriniz.
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Gorsel 2.40: Yildizin olusturulmasi

e Kutu, yildiz ve silindir grubunu orta-sagda Hizala (L) digmesi ile hizalayiniz.
e Yildizi 73 mm saga kaydiriniz.

e Yeni bir tasarim olusturunuz.

e Tasarimin adini Bardak Yapimi olarak degistiriniz.

e Calisma duzlemine silindir ekleyiniz.

e Silindirin yiksekligini 50 mm olarak olgeklendiriniz.

e Silindirin capini 50 mm olarak dlgeklendiriniz.

e Koseli gorintlyl ortadan kaldirmak igin silindir 6zelliginde Taraflar degerini 64 olarak degistiriniz.
e Silindiri gogaltiniz ve yeni silindirin gapini 47 mm olarak glincelleyiniz.

e fkinci silindirin yiiksekligini 60 mm olarak giincelleyiniz.

e ikinci silindirin 6zelligini Delik olarak degistiriniz.
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e kinci silindiri 3 mm yiikseltiniz.

o ki silindiri merkezde hizalayiniz.

Gorsel 2.42: Bardak gévdesinin olusturulmasi

e Calisma diizlemine metin ekleyiniz ve sekil 6zelliklerinden metni BiLiSiM olarak degistiriniz.
e Metnin enini ve boyunu 40x20 mm olarak 6l¢ceklendiriniz.

e Bardak govdesi ile ayni goriinimde olacak sekilde metni 90 derece dondiiriiniz.

e Bardak ylizeyinde ortada gorlinecek sekilde metni tasiyiniz.

Gorsel 2.43: Bardak metninin olusturulmasi

e Birinci silindiri gogaltiniz ve gapini 55 mm olarak gilincelleyiniz.
e Birinci silindir ile Gglincu silindiri merkezden hizalayiniz.
e Ugtinci silindirin yiiksekligini 60 mm olarak giincelleyiniz.

e Ugiinci silindirin 6zelligini Delik olarak degistiriniz.

Gorsel 2.44: Bardak metninin ovallestirilmesi

e Calisma diizlemine bir kutu ekleyiniz ve tiim sekli kapatacak sekilde kutuyu boyutlandiriniz.
e Kutu ve lglncd silindiri gruplandiriniz.
e Kutunun 6zelligini Delik olarak degistiriniz.

e Tiam sekilleri segerek gruplandiriniz.
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Gorsel 2.45: Bardak gévdesi

Calisma dizlemine bir halka ekleyiniz.
Halkanin ¢apini 30 mm olarak 6lgeklendiriniz.
Halkayi dik duracak sekilde 90 derece dondiiriiniz.

Halkayi bir kutu yardimi ile yarim halkaya dondstirip kulpu olusturunuz.

& sekil s Q

® 2

0 Kati Delik

Gorsel 2.46: Bardak kulpunun olusturulmasi

Bardak govdesine kulpu yerlestiriniz.
Tim sekilleri segerek gruplandiriniz.

Gorsel 2.47: Bardak tasarimi

Uygulama: Kalemlik Yapimi

Yeni bir tasarim olusturunuz.
Tasarimin adini Kalemlik Yapimi olarak degistiriniz.
Calisma dizlemine silindir ekleyiniz.

Silindirin yiiksekligini 50 mm olarak 6l¢eklendiriniz.
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e Silindirin capini 50 mm olarak 6l¢eklendiriniz.

e Koseli goriintlyl ortadan kaldirmak igin silindir 6zelliginde Taraflar degerini 64 olarak degistiriniz.
e Silindiri gogaltiniz ve yeni silindirin gapini 47 mm olarak glincelleyiniz.

e fkinci silindirin yiiksekligini 60 mm olarak giincelleyiniz.

e kinci silindirin 6zelligini Delik olarak degistiriniz.

e kinci silindiri 3 mm yiikseltiniz.

e ki silindiri merkezden hizalayiniz.

o ki silindiri gruplandiriniz.

Gorsel 2.48: Kalemlik gévdesinin olusturulmasi

e Calisma diizlemine metin ekleyiniz ve sekil 6zelliklerinden metni BiLiSiM olarak degistiriniz.
e Metnin enini ve boyunu 20x10 mm olarak 6lgeklendiriniz.

e Kalemlik gbvdesi ile ayni gériinimde olacak sekilde metni 90 derece dondiriiniz.

e Metnin 6zelligini Delik olarak degistiriniz.

e Kalemlik gbvdesinde ortada goriinecek sekilde metni tasiyiniz.

Gorsel 2.49: Kalemlik iizerine metin ekleme

e Calisma dizlemine yildiz ekleyiniz.

e Yildizin enini ve boyunu 10x10 mm olarak 6l¢eklendiriniz.

e Kalemlik gbvdesi ile ayni gériiniimde olacak sekilde yildizi 90 derece dondiriiniz.
e Yildizin uzunlugunu 60 mm olarak degistiriniz.

e Kalemlik gbvdesinin her iki ylizeyinde goriinecek sekilde yildizi tasiyiniz.

e Yildizi ¢cogaltiniz ve yeni yildizi 45 derece dondiriniz.

e ikinci yildizi cogaltiniz ve {iclincii yildizi 45 derece déndiiriiniiz.

e Ucilincii yildizi cogaltiniz ve dérdiincii yildizi 45 derece déndiiriiniz.
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Gorsel 2.50: Kalemlik desenlerinin eklenmesi

e Yildizlari seciniz ve 6zelligini Delik olarak degistiriniz.
e Tiam sekilleri seginiz ve gruplandiriniz.

A sekil s ©

@ @

Kati Delik

Sira Sizde 5

Yeni bir tasarim olusturunuz.

Tasarimin adini Piyon Yapimi olarak degistiriniz.

Calisma dazlemine bir silindir ekleyiniz.

Silindirin yliksekligini 3 mm olarak degistiriniz.
Silindirin Ustline bir Calisma Dizlemi (W) surikleyiniz.

Gorsel 2.52: Piyon tabaninin yapilmasi
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e Bir koni seklini silindirin Ustline ekleyiniz.
e Koninin yiiksekligini 11 mm olarak degistiriniz.
e Calisma diizlemine bir kiire ekleyiniz.

e Kireyi 18 mm capinda olceklendiriniz.

Bir sekil Uzerine ¢alisma diizlemi eklendiginde yeni eklenen sekiller icin ¢alisma

diizlemi olarak yeni eklenen diizlem kabul edilecektir.

e Kiirenin yiksekligini 5 mm olarak 6l¢eklendiriniz.

Gorsel 2.53: Piyon yapimi tabaninin tamamlanmasi

e Calisma diizlemine bir koni sekli ekleyiniz.

e Koninin yliksekligini 28 mm olarak 6l¢eklendiriniz.
e Koninin ¢apini 14 mm olarak 6lgeklendiriniz.

e Koniyi diger sekillerin Ustline tasiyiniz.

e Koniyi calisma diizleminden 3 mm yikseltiniz.

Gorsel 2.54: Piyon gévdesinin olusturulmasi

e Baska bir koniyi calisma dizlemine ekleyiniz.

e Koninin ¢apini 12 mm olarak 6l¢eklendiriniz.

e Koninin yliksekligini 19 mm olarak 6l¢eklendiriniz.
e Koniyi 180 derece dondiriiniz.

e Koniyi 5 mm yikseltiniz.

e Koniyi diger sekillerin Gzerine tasiyiniz.

e  Bir calisma diizlemini koninin Ustlne surikleyiniz.
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Gorsel 2.55: Piyon gévdesinin tamamlanmasi

e Calisma dizlemine bir kire ekleyiniz.

e Kiirenin ¢capini 8 mm olarak 6lceklendiriniz.

e Bir Calisma Diizlemini seklin disinda bir alana sirikleyerek galisma diizleminin orijinal konumuna
getiriniz.

e Tum sekilleri merkezden hizalayiniz.

e Tuam sekilleri gruplandiriniz.

Gorsel 2.56: Tamamlanmis piyon tasi

’SII‘E Sizde 6

Piyon govdesini kullanarak kale tasini tasarlayiniz.

2.2.6. iki Boyutlu Gorseli U¢ Boyutlu Gorsele Doniistiirme

Cizim programi disindaki bir resim (¢ boyutlu hale getirilebilir. Resmin Ui¢ boyutlu hale getirilebilmesi
icin calisma dlizlemine aktarilmasi gerekmektedir.
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http://kitap.eba.gov.tr/KodSor.
o A e php?KOD=21374 ¢
Uygulama: Ug Boyutlu Hale Doniistiirme

e Yeni bir tasarim olusturunuz.

e Tasarimin adini Ug Boyutlu Hale Déniistiirme olarak degistiriniz.

e Ust meniiden ige Aktar diigmesini tiklayiniz.

e ki boyutlu resmi seginiz.

e Cevrimici format dondstirici ile dosyanizi .svg formatina dondstiriniz.

e Bir dosya se¢ diigmesine tiklayiniz.

e Resmi seciniz ve onaylayiniz.

o sterseniz Olgeklendir degerini degistirerek resmin boyutunu degistiriniz.
e ige Aktar digmesine tiklayiniz.

e Shift tusuna basili tutup fare ile seklin genisligini 100 mm olarak degistiriniz.

e Ana Ekran goriiniimi digmesine tiklayarak ekran goriintisiini ortalayiniz.

Gorsel 2.57: Ug boyuta déniistiiriilmiis sekil

2.2.7. Hareket Edebilen Bir Nesne Olusturma

Cizim programi yardimiyla birbirinden bagimsiz sekiller bir arada tasarlanabilir. Boylece hareketli

nesneler olusturulabilir.

http://kitap.eba.gov.tr/KodSor. -
php?KOD=2137%

7 Uygulama:Dislicark
e Yeni bir tasarim olusturunuz.

e Tasarimin adini Digli Cark olarak degistiriniz.

e Calisma dizlemine bir cati ekleyiniz.

e Catiy1 90 derece dondiriiniz.

e Catinin ylksekligini 10 mm olarak 6lgeklendiriniz.

e Catinin enini ve boyunu 9x9 mm olarak 6l¢eklendiriniz.

e Calisma dizlemine bir kutu ekleyiniz.

e Kutunun yiksekligini 4 mm olarak 6lgeklendiriniz.
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e Kutunun enini ve boyunu 1x1 mm olarak 6lceklendiriniz.
e Kutunun 6zelligini Delik olarak degistiriniz.
e Kutu ile catiyl merkezden hizalayiniz.

e Kutuyu gatinin bir kdsesine dogru 6 mm taslyiniz.

Gorsel 2.58: Carkin disinin olusturulmasi

e Cative kutuyu gruplandiriniz.

e Calisma dizlemine bir kiire ekleyiniz.

e Kiirenin ¢capini 3 mm olarak 6lceklendiriniz.

e Kiireyi catinin tabanindan 40 mm uzaga yerlestiriniz.
e Cative kireyi gruplandiriniz.

e Yeni sekli cogaltiniz ve 36 derece dondiriniz.

Gorsel 2.59: Carkin dislerinin ¢ogaltiimasi

e Carkin disleri tamamlanincaya kadar bir dnceki adimi tekrarlayiniz.

Gorsel 2.60: Carkin dislerinin tamamlanmasi
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e Disleri gruplandiriniz.

e Calisma diizlemine bir silindir ekleyiniz.

e Silindirin yiksekligini 10 mm olarak 6l¢eklendiriniz.
e Silindirin gapini 34 mm olarak degistiriniz.

e Disli grubunu ve silindiri merkezde hizalayiniz.

Gorsel 2.61: Disli gévdesinin olusturulmasi

e Calisma duzlemine bir silindir ekleyiniz.

e Silindirin yuksekligini 12 mm olarak 6lceklendiriniz.
e Silindirin capini 15 mm olarak 6l¢eklendiriniz.

e Silindirin 6zelligini Delik olarak degistiriniz.

e Silindiri ve ¢ark govdesini merkezden hizalayiniz.

Gorsel 2.62: Tamamlanmus disli ¢ark

e Digli ¢arki cogaltiniz.
e Olusturulan disli carklari, disler birbirine uygun olacak sekilde yerlestiriniz.

Gorsel 2.63: Tamamlanmus disli ¢ark grubu
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Cizim programinda (i¢c boyutlu ya da iki boyutlu tasarimlar ice Aktar secenegi ile calisma diizlemine

2.2.8. Tasarimlarin ige veya Disa Aktarimi

aktarilabilir ve yeni tasarimlarda kullanilabilir. Cizim programi, ice aktarma isleminde .stl, .obj ve .svg dosya
uzantilarini desteklemektedir.

e Yeni bir tasarim olusturunuz.

e Tasarimin adini ige Aktarma olarak degistiriniz.

o Ust meniiden ige Aktar diigmesini tiklayiniz.

e Bir dosya se¢ diigmesine tiklayiniz.

e Dosyanin yerini bulunuz ve dosyayi seciniz.

e ki boyutlu ya da {i¢ boyutlu resmi seginiz.

e ige Aktar diigmesini tiklayiniz.

e ge aktarilan sekli tasariminiza gore dlceklendiriniz.

Uygulama: URL ile ice Aktarma

e Yeni bir tasarim olusturunuz.

e Tasarimin adini URL ile ige Aktarma olarak degistiriniz.
o ige Aktar digmesini tiklayiniz.

e Import From URL diigmesine tiklayiniz.

e URL adresini yapistiriniz ve ige Aktar digmesini tiklayiniz.

Cizim programinda hazirlanan tasarimlar, Disa Aktar secenegi ile cizim programi disinda bir ortama
aktarilabilir.

Uygulama: Disa Aktarma

e Yeni bir tasarim olusturunuz.

e Tasarimin adini Diga Aktarma olarak degistiriniz.

e Calisma diizlemine bir kutu ekleyiniz.

e Disa Aktar diigmesini tiklayiniz.

e Uc boyutlu yazicidan ¢ikti almak icin .STL diigmesini tiklayiniz.

2.2.9. Olusturulan Uriinleri U¢ Boyutlu Yazicida Yazdirma

Ug boyutlu tasarim yapildiktan sonra érnekleri olusturulmak istendiginde geleneksel yéntemlerde
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parcalar halinde Uretilip tekrar birlestirilmesi gerekir. Ancak li¢ boyutlu yazici sayesinde tim detaylarla tek
parca halinde 6rnek olusturulabilmektedir.

Ug boyutlu yazicilarla ile ilgili en &nemli sorulardan biri, modelleri olustururken hangi ham maddenin
kullanildigidir. Filament adi verilen bu ham maddenin PLA ve ABS olmak Uzere iki farkh tird vardir.  PLA
filament, seker kamisi ve misir nisastasi gibi maddelerden iretilen doga dostu bir plastik tiridar. ABS
filament ise petrol tlrevlerinden Uretilmektedir.

Ug boyutlu yazicilardan ¢izim programiile tasarlanan bir model, Giretiminin yapilabilmesi icin dogrudan
yaziclya gonderilebilecegi gibi .stl formatinda disa aktar 6zelligi kullanilarak yaziciya gonderilebilir. .stl
formatindaki bir tasarim dilimleme programlari yardimiyla i¢ boyutlu yazicinin programlama dili olan
G-code diline donistlrilir. G-code dosyasi, hafiza karti ile Gi¢ boyutlu yaziciya tanitilir ve tasarimin g

boyutlu modeli yazdirilir.

Tasarladiginiz modeli Gi¢ boyutlu yazicidan yazdirmak igin asagidaki yonergeleri uygulayiniz.

e Daha 6nce tasarimini yaptiginiz Piyon Yapimi uygulamasini seginiz.

e Bunu diizenle butonuna tiklayarak tasarimi aginiz.
Piyon yapim WBegen0 | &

‘ tasarlayan:
“9¥ Bilisim Teknolojileri Alani

Diizenleme tarihi 5/18/20, Olusturma tarihi 5/18/20

Bunu iﬁzen ]

Indir

© ia)
3D'de Goruntile Gorsel Ekle

Gorsel 2.64: Daha 6nceden hazirlanan tasarimin agilmasi

e Disa Aktar diigmesine tiklayiniz.

e Tasarimi dogrudan Ug¢ boyutlu yaziciya gondermek icin 3D Baski sekmesini seginiz.
e Dosyay disa aktarmak icin indir sekmesini seginiz.

e STL diigmesini tiklayiniz.

Tasarimi dogrudan ¢ boyutlu yaziciya génderebilmek i¢in yazicinizin bilgisayariniza bagl

~

\
1
1

bulunmasi ve gizim programinin destekledigi yazicilardan biri olmasi gerekir. '

75 i 2 OGRENME BIRIMi



BILGISAYARLI Cizim

indir 3D Baski %

DahilEt  ® Tasanmdaki her gey.

3D Baski Icin
.0B] STL
[t
S
GLTF (.glb)

Lazerli Kesim Icin

.SVG

(?) Dpaha fazla bilgi

Gorsel 2.65: Disa aktarma dosya formatinin segilmesi

e Disa aktarilan .stl dosyasini dilimleme programi yardimiyla G-code diline dondstiriniz.

e .G-code dosyasini hafiza karti ile yaziciya aktariniz.
e Yazicida baski islemini baslatiniz.
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—_— Olgme ve Degerlendirme

Asagidaki sorulari dikkatlice okuyarak dogru secenegi isaretleyiniz.

1. Cizim programinda ¢ogaltma icin kullanilan kisayol kombinasyonu asagidakilerden hangisidir?

A) CTRL+C B) CTRL+D C) CTRL+V
D) CTRL+Y E) CTRL+Z

2. Cizim programinda ¢alisma diizleminin ya da secilen seklin ekrana sigdirilmasi igin kullanilan diigme
asagidakilerden hangisidir?

A) B) C)

3. Cizim programi ¢alisma diizlemi siniri asagidakilerden hangisidir?

A) 100 x 100 mm B) 500 x 500 mm C) 1000 x 1000 mm
D) 1500 x 1500 mm E) 2000 x 2000 mm

4. Cizim programinda iki veya daha fazla seklin birlestirilmesi ile yeni sekil olusturulmasini saglayan
ozellik asagidakilerden hangisidir?

A) Hizalama B) Cogaltma C) Kopyalama
D) Gruplama E) Eksiltme

5. Hizalama islemi icin kullanilan kisayol tusu asagidaki hangisidir?

A)D B) G CL
D) Y E)Z

6. Cizim programi ige aktarma dosya boyutunun iist siniri agagidakilerden hangisidir?

A) 10 MB B) 15 MB C) 20 MB
D) 25 MB E) 30 MB
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. .obj
Il. .psd
. .stl
IV. .svg

Cizim programi, ice aktarma islemi sirasinda yukaridaki dosya formatlarindan hangilerini
desteklemektedir?

A) 1=l B) I—1I—1Il Ql=1-Iv
D) I=1ll=1IV E)ll=11-1V

Hazirlanan tasarimin ii¢ boyutlu yazicida baskisini almak icin asagidaki dosya formatlarindan

hangisi kullanilir?

A) .stl B) .dxf C) .gib
D) .obj E) .svg

Ug boyutlu yazicilarin ham madde olarak kullandigi malzeme asagidakilerden hangisidir?

A) Arduino B) Filament C) Nozzle
D) Step motor E) Tabla

I. Geleneksel yontemlere gore daha kullanishdir.

Il. Kalipcilik gibi yiiksek maliyetler gerektirmez.

Ill. Model ayrintilari ayri ayri olusturulur.

IV. Kullanimiigin teknik bilgi gereklidir.

Yukaridakilerden hangisi ya da hangileri li¢ boyutlu yazicilarin kullanim avantaji olarak gésterilebilir?

A) Yalniz | B)I—1l Cl=1-=1u
D)I-ll—-1IV E)I—-1Il—1V
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3. DIJiTAL URETIM

é Hazirlik Caligmalar: |

1. Bolgenizdeki sanayi kuruluslarinda kullanilan bilgisayar destekli ¢izim
programlarini arastiriniz.

yapildigini arastiriniz.

. 2. Uc boyutlu modelleme yazilimlarindan faydalanarak modellemenin nasil

3.1. Dijital Uretim Programlari

Dijital Gretim programlari; Griin gelistirmeye yonelik, bulut tabanli, ti¢ boyutlu CAD: Computer Aided
Design (Bilgisayar Destekli Tasarim), CAM: Computer Aided Manufacturing (Bilgisayar Destekli Uretim) ve
CAE: Computer Aided Engineering (Bilgisayar Destekli Mihendislik) platformudur. Programdaki araglar,

entegre konsept Uretim arag seti ile tasarim fikirlerinin hizli ve kolay kesfine imkan tanir.
3.1.1. Egitim Hesabi Agma ve Bireysel Kurulum Adimlari

Programi kullanmaya baslamak icin hesap olusturmak gerekmektedir.

Uygulama: Hesap Olusturma

Hesap olusturmak igin asagidaki yonergeleri takip ediniz.
e Ekranin sagindan Hesap Olus-

tur digmesini tiklayiniz. ADIM 1: OTURUM AGIN VEYA HESAP OLUSTURUN

o “Ulke” alaninda Tiirkiye seginiz. | gir hesabim var Bir hesaba ihtivacim var
e “Egitimdeki roli” alaninda uy- : | '

e Kurumunuzun tlrind seciniz. Gorsel 3.1: Hesap olusturma

gun profil seginiz.

e Ad soyad bilginizi, dogum tarihinizi ve e-posta adresinizi giriniz.

e Birsifre belirleyiniz.

Kullaniciya ait bir e-posta adresi ile kaydolunur ancak program icinde Generative Design |
. erisimi de istenirse bu yeni teknolojiyi kullanabilmek icin Universite e-posta adresi ile E
i kaydolmak gerekir. E

e Onay kutucugunu seciniz ve Hesap Olustur diigmesine tiklayiniz.

e Kayitta kullanilan e-posta adresine dogrulama mesaji gonderilecektir. Bu mesajin icinde yer alan linke
tiklayarak e-posta adresinizi dogrulayiniz. Bu islemin ardindan ekranda Hesap Dogrulandi mesaj
gorilecektir.

e Hesap dogrulandiginda okulunuzun adini giriniz.

e Ogrenciyseniz brans seciniz. Bu okula ne zaman basladiginizi ve tahminen okulunuzdan ne zaman
mezun olacaginizi giriniz. Egitimciyseniz Egitimci veya Okul BT Yoneticisi rolinu seciniz, erismek
istediginiz lisans tlrlind de belirtiniz.
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Lisans seciminde iki lisans tiri ile karsilasilacaktir. Bunlar;
e Personal use only: Sadece bireysel egitim lisanslarina erisim,
e Personal Use and Educational Institution Deployment: Hem bireysel lisanslara hem

de kurumunuz igin ¢oklu kurulum lisanslarina erisim secenegidir.

e Buadimlari tamamlandiginizda ekranda Hesap Ayarlandi mesajini goreceksiniz.

Uygulama: Program Kurulum Adimlari

Dijital Gretim programini bilgisayariniza kurmak icin asagidaki yonergeleri uygulayiniz.

e Yenihesapile program lisansina erismek igin bu asamada tek adimhk erisim islemi gergeklestirilmelidir.
Bunun igin Erisim Elde Edin diigmesine tiklayiniz.

e Programibilgisayarinizaindiriniz. Daha 6nceden program kuruluise kullanicihesabiile giris yapabilirsiniz.

e Kurulum adimlarini tamamlayiniz.

e Kurulumun ardindan program ilk defa galistirildiginda Hesabinizi Koruyun baslikli, iki adimli kimlik
dogrulama ayarlari gelecektir. Daha Sonra Hatirlat secenegine tiklayarak bu islemi daha sonra da
tamamlayabilirsiniz.

e Bulut Gizerinde projelerin yer alacagi bir takim alani olusturmak gerekmektedir. Bu asamada Create a
Team segenegini isaretleyiniz ve takim adini giriniz.

Ortak bir e-posta alanina sahip olan kurumsal kullanicilar, birbirlerinin takim alanlarini !
arastirip onlara katilma istegi gonderebilirler. Herkese acik bir e-posta platformu :
1
1

kullaniliyorsa bu asamada baska takimlar gériilmeyecektir.

1
1
1
\

e Anonim veri toplama secenekleriyle ilgili bir bilgilendirme ekrana gelecektir. Bu secenekler daha sonra

Preferences (Tercihler) menisiinden degistirilebilir. Continue diigmesine tiklayiniz.

Uygulama: Hesabi Ucretsiz Kullanim igin Aktive Etme

Yazilim ilk acilista 30 giinliik Trial (Deneme) modunda acilacaktir. Ucretsiz kullanimi baslatmak igin

asagidaki yonergeleri uygulayiniz.

e Sag tarafta yer alan Subscribe Now diigmesine tiklayiniz.

e Buy Now (Satin Al) ekranina geginiz.

e Altta yer alan Are you a Startup, Non-commercial user or Student? (Tecriibesiz, Ticari Olmayan
Kullanici veya Ogrenci / Egitimci misiniz?) linkine tiklayiniz.

¢ Educational use (Egitim Kullanimi) segcenegine tiklayiniz. Buasamadan sonra program, egitim kullanimi
icin kaydolunmasi gerektigini size tekrar hatirlatacaktir. Yukaridaki tim adimlari tamamladiginizda

Continue digmesine tiklayiniz.
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3.1.2. Dijital Uretim Programi Arayiizii

Program kisayoluna tiklanarak program acilir. Program arayiziinden File > New Design secimi yapilir.

Onceden hazirlanip kaydedilen bir dosyadan baslanmak istenirse File > New Design From File secimine

basilir. Ekrana Untitled (Adsiz) gizim sayfasi gelir.

Uygulama: Cizim Ekranini Tanima

Dijital Giretim programi ¢izim ekrani ile ilgili asagidaki yonergeleri uygulayiniz.

L

(=3

=]

iak Biligim 1

ALL PROJECTS W 3

LIBRARIES

2 <

My Recent Data

Alist of what you've recently heen working on

Admin Project

This project is far tearm members with Admin
privileges in Biligim

AutoDesk - Part 1

Default Project

This comes with Fusion and is where your wark
is stored until you create of join another project

5

Project that containg assets used by Fusion 360
including termplates, libraries, and other
configuration files

Assets

SAMPLES 6

Basic Training

Sarmples used in the Hands-on exercises in our
Help topics.

Q

4 New Project

X

7

==Em i

v

Mew Design

Mews Electronics Library
Meswr Drawing

Meww Dirawing Template
Cpen...

Recover Documents (4]
Upload

Ctrl+M

Mew Electronics Design

Ctrl+O

Save
Save as
Export

Ctri+S

3D Print
Capture Image...
Share

View Details on Web
View

Gorsel 3.2: Cizim ekrani

Uyesi oldugunuz gruplari
listelemek, yeni grup kurmak
veya bir gruba katilmak igin
Team Accounts [Takim Hesabi
(1)] bolimiind seginiz.

Data Panel [Veri Paneli (2)]
icinde yenileme islemi icin Ref-
resh digmesini, arama islemi
icin Find digmesini ve ¢ikis icin
Exit digmesini kullaniniz.
Bulutta kayith bitlin projeleri
listelemek icin All Project (3)
bolimand kullaniniz.

Yeni proje dosyasi olusturmak
icin New Project (4) digmesini
kullaniniz.

Bulutta bulunan kiitliphane dos-
yalarina ulasmak icin Libraries

(5) bolimand kullaniniz.

e Program icindeki proje orneklerine ve egitim dokiimanlarina ulasmak icin Samples (6) bolimund kul-

laniniz.

e Veri panelini gosterip gizlemek icin Show / Hide Data Panel (7) secenegini kullaniniz.

e Yeni dizayn, yeni elektronik dizayn, kutliphane ve yeni ¢izimler olusturmak igin File [Dosya (8)]

mendisiini kullaniniz. Ayrica mevcut projeler agma, projelere yiklemeler yapma, projeleri kaydetme

gibi islemler icin bu meniyu kullanabilirsiniz.
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e Kaydetme islemi icin Save [Kaydet (9)] digmesini, geri alma islemi icin Undo digmesini ve ileri alma
islemi icin Redo diigmesini kullaniniz.
Dijital Gretim programi temel olarak 6 farkli modda calisabilmektedir. Her mod, yapilacak tasarimin
lizerinde uygulanacak islemlerle ilgilidir.
Anacalisma, Design modudur. Bumodda tasarim, tek bir parca halinde ya da montajolarak hazirlanabilir.

Uygulama: Komutlar

e Komutlarla ilgili asagidaki yonergeleri uygulayiniz.

e Ekranin st kisminda yer alan komut ikon ¢ubugu aracihigiyla komutlara erisiniz.

e Calisma modunu degistirerek komutlardaki degisimi izleyiniz. Her moda 6zgli komutlar ekraniniza
gelecektir.

e Komutlari yukari doniik ok isaretine tiklayarak komut ikon gubuguna tasiyiniz.

| g LS 2 @ Untitled”
SOLID SURFACE SHEET METAL TOOLS
e B @O DS FD DI PE S B
CREATE ¥ MODIFY » ASSEMBLE v CONSTRUCT
« BROWSER el

4 © [ EEGEEES I ©

D] Shorteuts
D %  Document Seftings esign Shorteu

D W Named Views 0 o AN oA
D © #M Orign
=

|

! ‘Fil\

| <% Fill Hole ]

: I Fillet )

’/C""“-—- [ Fillet

& Boundary Fil
T Frase And Fill
<% Frase and Fill

Gorsel 3.3: Komutlar

e Fare ¢alisma alanindayken klavyeden S kisayol tusuna basilarak sik kullanilan komutlara ve arama
ekranina erisilebilmektedir. S tusuna basarak sik kullanilan komutlari goriintileyiniz.

e Kullanilacak komut ismi, arama bolimiine bas harfleri yazilarak aratilabilir. Komutlari bas harfleri ile
arayiniz.

e Arama yaptiginiz komutlari, komutlarin yanindaki ok isareti ile sik kullanilan komutlara ekleyiniz.

e Sik kullanilan listesindeki komutlari,komutlarin yanindaki X isaretine tiklayarak listeden gikartiniz.

e Calisma sirasinda her bir ¢izim nesnesi olusturuldugunda ekranin sag kisminda Sketch Palette baslikli
bir menl ekrana gelir. Buradan c¢izim nesnelerine sinirlamalar eklenebilir. Kullanilan komutlar ve alt
komutlari bu mentiiniin Gst kisminda gorintilenir. Buradan da segim yapilarak ¢izime devam edilebilir.

Sketch Palette menisiline goz atiniz.
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Uygulama: Cizim Ekrani Boéliimleri

Cizim ekrani bolimlerine erismek icin asagidaki yonergeleri uygulayiniz.

— X
v @]~ :” & Bicycle_Tail_Light v1* 2 K & lamp v1 # +IIO3© @
SOLID SURFACE SHEET METAL TOOLS
ward G B RS FOIPES BB = = N
CREATE v MODIEY ¥ ASSEMBLE ¥ CONSTRUCT ¥ INSPECT ¥ INSERT v SELECT v
[« BROWSER Ll
ae ° 6 SJ I
Ty | gack
D % Document Settings ‘L_,
D @ NamedViews
[ Contact al
2 M  Origin
D B Joints
D © M Sketches
D © @ Construction
D © (@ Necki
D @ (J Swich1
D ©® (@ Basel
D @ (J shade
D ® @ Cordi
7 8
9 |#-8 o < a-lle- @8- =-| 10
|I<<-b-b > mé-@ﬁ‘DDijDDE"'»ETEHT'&!'DI"@_']TEM#@FD"T"»!JDOE‘-E‘-‘?-GG&ﬁﬂTI m

Gorsel 3.4: Cizim ekrani béliimleri

Hizh Erisim Meniisii (1): Burada dosya ve projelerin organize edildigi, dokuz kiiglik kare ile sembolles-
tirilmis Data Panel, siyah bir sayfa ile sembolize edilmis File acilir menusii ve ¢alismalari hizla kaydet-
meye yarayan Save ikonu bulunur. Hizli erisim menistindeki 6geleri deneyiniz.

Dosya Sekme Cubugu (2): Birden ¢ok calismanin ayni anda agik olmasi durumunda dosya adlari kar-
teks bigiminde gorullr. Bunlarin Gzerine tiklanarak dosyalar arasinda gegis yapilabilir. Birden fazla ¢a-
lisma dosyasi agarak dosya sekme ¢ubugunu deneyiniz.

Kullanici Hesabi islemleri ve Tercihler (3): Kullanici hesabi ayarlari ve program tercihlerinin degistirile-
bilecegi kisimdir. Kullanici hesabi ayarlarini ve tercihler menisini goérintileyiniz.

Komut ikon Cubugu (4): Burada yer alan komutlara dogrudan tiklanarak en sik kullanilan komut galisti-
rilabilir. Komut ikonlarinin altindaki asagi yonli okun Ustiine tiklandiginda o komut grubunda bulunan
alt komutlara ulasilir. Buradaki komutlardan herhangi birinin saginda bulunan yukari ok tusuyla alt
komut, komut seridine tasinabilir. Komut ikon cubugundaki komutlari gérintileyiniz.

Goriinis Kiipii (5): Kipin Gzerindeki dilimlere ve yizlere tiklayarak gorsel konumuna gore ekrani dén-
dirdnuz.

Browser [(Unsur Agaci) (6)]: Calisma alaninin sol yaninda yer alir. Modelleme esnasinda yapilan
islemler, eksen takimlari, calisma ylizeyleri burada bulunur. Calisma alaninin solundaki Eye (G6z) sim-
gesini tiklayarak ¢alisma unsurlarini aginiz ve kapatiniz.

Goriiniim komutlari (7): Ekran kaydirma, zoom ve orbit gibi gorsel ayarlamalari yapiniz.

Calisma Alani Ayarlari (8): Ekranin boliinmesi, 1zgara ve gorsellik ayarlarini yapiniz.
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e Timeline [(Zaman Cizelgesi) (9)]: Yeni bir dosya acilmasinin ardindan yapilan tim islem asamalarinin
gorsel olarak siralandigi bélimdiir. islemlerin herhangi birinin tizerinde sag tus meniileriyle diizenleme
yapilabilir. Solda yer alan oynatma tusu ile tiim islem asamalarinin ekranda tekrarlanmasi saglanabilir.
Timeline gorintuleyiniz.

e 10. Zaman Cizelgesi Ayarlari (10): Sirec seridinin gorsel 6zelliklerini ayarlayiniz.

Uygulama: Ekran Rengi ve Goriiniim Ayarlari

Ekran rengi ile ilgili asagidaki yonergeleri uygulayiniz.
e Ekran rengini ayarlamak i¢in ¢alisma alani ayarlari kismindan yararlanabilirsiniz.
e Environment basligi altinda bes sahne olarak hazirlanmis seceneklerden tercih yapabilirsiniz.

Yisual Style 4 ‘

Mesh Display 4

Enviranment 4 Dark Shy

Effects 4 Grey Room

Dhbiject Visibility P|@® Photo Booth

Camera 4 Trandquility Blue

Ground Flane Offset Infinity Poal
Enter Full Scresn  Ctri+Shift+F

+-ovca-Ps- -
Gorsel 3.5: Ekran rengi ve gériiniim

Izgara avyarlari ile ilgili e

asagidaki yonergeleri uygu- B '®)
layiniz. = ' = ®
e |zgara ayarlarinda gegerli '
. T Major Gnd Spac 10 v
olan Adaptive secimidir.
. e o . Minor SubdiyEions 5 A
e Fixed secimi ile deger gi-
rerek 1zgara araliklarini o Referepfetimbers @)
ayarlayiniz. Bu segimde, OK | Cancel

Adaptive seciminden LaitGid
Layout Grid Lock
Snap to Grid
lasihp  uzaklasildiginda B Grid Settings
Incremental Move

"§  SetIncrements

farkh olarak ekrana yak-

1zgara araliklarinin degis-

medigini gozlemleyiniz. 4.5 » @ g @~

Ea]
= Y

Gorsel 3.6: Izgara ayarlari
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Uygulama: Snap (Kenetlenme Ayarlan)
Kenetlenme ayarlari ile ilgili asagidaki yonergeleri uygulayiniz.
e Buzgara ayarlari icin Grid and Snaps > Snap to Grid kismindan yararlanabilirsiniz.
e Cizim esnasinda farenin belirli araliklarla sekme yaparak hareket etmesi icin Snap to Grid sec¢imini
yapiniz.
e (Cizim esnasinda imlecin 1zgaralarin koselerine kenetlenmesi icin Snap to Grid kutusunu isaretleyiniz.

3.2. Basit Parametrik Model

Dijital Giretim programi yazilimi, 6 hazir sekli hizli bicimde olusturmayi saglayan hizh sekil olusturma
aracini icerir. Bu araclar kullanilarak (i¢c boyutlu nesneler olusturulabilir.

Dijital Uretim programi ile li¢ boyutlu basit modelleme yapabilmek souo  surrace SHEET METAL
icin Solid (Kat1) komut ikonu penceresinde Create (Olustur) menidsinin ] [l @& =
altinda halihazirda kullanilabilecek basit modeller listelenmektedir. CREATE ¥

Gorsel 3.7: Solid modelleme

Box (Kutu), Cylinder (Silindir), Sphere (Kiire), Torus (Simit Halkasi), Coil (Yay) ve Pipe (Boru) listede

hazir olarak kullanilabilecek basit modellerdir.

e BROWSER Cizilecek basit model segilip komut ¢a-
d ® ® listirildiktan sonra ekrana gelen dizlem-
D & Document Seftings lerden gizim yapilacak diizlemin segilmesi

D @ Named Views yeterlidir. Koordinat merkezi, ici ¢apraz

olarak ceyrekleri dolu bir daire ile goste-

@ 4% 0 rilir. X ekseni kirmizi, Y ekseni yesil ve Z
® Jd X ekseni de mavi renklidir.

@ & ¥ — .

e B Duiizlemler, ¢izim alanindan veya unsur
- & 5 agacmd?n secilebilir. L-J‘nsur agacindan XZ
- [Front (On)], XY [Top (Ust)] veya YZ [Right
o @ \z (Sag)] duzlemlerinden biri secilmelidir.

Gorsel 3.8: Diizlem secimi

Eklenen nesnenin daha sonra diizenlenmesi istenirse Browser > Bodies (Govdeler) igindeki ilgili nesne
secildiginde nesneye odaklanilir. Odaklanilan nesne mavi renklidir. Eklenen nesne segili iken ya da Timeline
akisinda ilgili islem tizerine sag tus tiklandiginda gelen meniiden Edit Feature (Ozelligi Diizenle) komutu
calistirtlir.

Fare kaydirma tekerleginin tzerine basili tutularak Pan moduna gecis yapilir. Bu sayede tasarim ekra-
ninda saga, sola, ileri ve geri hareket edilebilir.

Fare kaydirma tekerleginin tzerine ve klavyeden Shift tusuna basili tutularak Constrained Orbit (Ser-
best Kamera) moduna gecis yapilir.

Fare kaydirma tekerlegi ileri hareket ettirilirse Zoom Out (Goriintiiyli Uzaklastir), geri hareket ettirilir-
se Zoom In (Goriintiiyili Yakinlastir) eylemleri gerceklesir.
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3.2.1. Box (Kutu)

Uygulama: Box (Kutu) Ekleme

Cizim alanina Box eklemek icin asagidaki yonergeleri uygulayiniz.

e Create > Box komutunu seginiz.

e XY duzlemini segerek gizmek istediginiz Box nesnesinin taban yizeyinin Width (Genislik) ve Length
(Uzunluk) degerlerini giriniz. Genislik ve uzunluk degerlerini belirledikten sonra klavyeden Enter tusuna
basarak Box nesnesini olusturunuz. Olusan kutunun genislik, uzunluk ve yikseklik degerleri, asagidaki
resimde gorilen ok tuslari secilerek okun gosterdigi dogrultuda ileri veya geri hareketle artirilip azalti-
labilir. Ayni islem Box Palette (Kutu Paleti) penceresinden deger girilerek de yapilabilir.

® BOX

Placement  EEERE]

Length 70.00 mm A
Width 50.00 mm v
Height 10.00 mm A
Operation (0 New Body b
i ] OK | |Cancel

Gorsel 3.9: Kutu ve kutu paleti

Yikseklik, eksi (-) deger alabilir. Eksi deger, bulundugu dogrultuda nesnenin olusturulma

yoniuni degistirir.

1
1
1
3

3.2.2. Cylinder (Silindir)

Uygulama: Cylinder (Silindir) Ekleme

Cizim alanina Cylinder eklemek icin asagidaki yonergeleri uygulayiniz.
e Create > Cylinder komutunu seginiz.
e XY dlzlemini secerek ¢izmek istediginiz Cylinder icin Diameter (Taban Capi) degerini giriniz.
e Fare kullanarak ya da Cylinder Palette menisiinden ¢ap ve ylikseklik degerlerini degistiriniz.

e CYLINDER
Placement
Diameter 100.00 mm -
Height 10.00 mm -
Operation & Mew Body -
i ] OK | Cancel

Gorsel 3.10: Silindir ve silindir paleti
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3.2.3. Sphere (Kiire)

Uygulama: Sphere (Kiire) Ekleme

Cizim alanina Sphere eklemek i¢in asagidaki yonergeleri uygulayiniz.
e Create > Sphere komutunu seginiz.
e XZ dizlemini segerek ¢cizmek istediginiz Sphere icin Diameter degerini giriniz.

e Fare kullanarak ya da Sphere Palette menisiinden cap degerini degistiriniz.

® SPHERE

Paint X

Diameter 50.00 mm A
| Operation  CJ New Body o

Li ] OK | Cancel

Gorsel 3.11: Kiire ve kiire paleti

3.2.4. Coil (Yay)

Uygulama: Coil (Yay) Ekleme

Cizim alanina Coil eklemek icin agsagidaki yonergeleri uygulayiniz.
e Create > Coil komutunu seciniz.

e COlL
e XY dizlemini secerek c¢izmek SR x
istediginiz Coil igcin Diameter
Type Revolution and Height >
ve Height degerlerini tasarim
. L Rotation )
alanina yerlestirirken giriniz.
. Di It 100.00 s
e Farekullanarakya da Coil Palette i L
menisiinden ¢ap ve yikseklik Revolutions S B
degerlerini  degistiriniz.  Coil Height 150,00 mm v
Palette mendsiinden ayarlari Angle 0.0 deg v
degistirerek gézlemleyiniz. S i -
Section Position 8 On Center e
Section Size 2500 mm v
Operation (Cf News Body b4
i ] OK | Cancel

Gorsel 3.12: Yay ve yay paleti
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3.2.5. Torus (Simit Halkasi)

Uygulama: Torus (Simit Halkasi)

Cizim alanina Torus eklemek icin agsagidaki yonergeleri uygulayiniz.

e Create > Torus komutunu seginiz.

e XY dizlemini secerek ¢izmek istediginiz Torus icin Diameter degerini tasarim alanina yerlestirirken
giriniz.

e Torus Palette menisinden ayarlari degistirerek gozlemleyiniz.

e [ORUS
Profile k Plane
Inner Diameter 100.00 mm v
Torus Diameter 2000 mm ¥
Position ¥4 On Center -
womomm - Operation (F MNews Body -

i ] OK Cancel

Gorsel 3.13: Simit halkasi ve simit halkasi paleti

3.2.6. Pipe (Boru)

Uygulama: Pipe (Boru) Ekleme
Pipe nesnesi gizebilmek igin bir Path (Yol) belirlenmelidir. Path, iki boyutlu bir tasarim nesnesi oldugu
icin dnce Sketch (Taslak) hazirlamak gereklidir.
Cizim alanina Pipe eklemek icin asagidaki yonergeleri uygulayiniz.
e Browser altinda Skectch cizilecek XZ dizlemini seginiz ve sag tus yaparak Create Sketch (Taslak
Olustur) komutuna tiklayiniz.
e Spline (Egri) komutunu seginiz.
e Duizleme noktalar yerlestirdikten sonra yesil daire icinde beliren tik isaretine tiklayiniz.
e Ust meniide en sagdaki Finish Sketch (Taslagi Sonlandir) komutuna tiklayiniz.
e Create > Pipe komutunu seginiz.
e Taslak olarak gizilen yolu Select (Seg) komutuyla seginiz.
e Yol boyunca borunun ne kadarinin cizilecegini belirlemek icin Distance (Mesafe) degerini kullaniniz.
Distance degeri 0-1 arasindadir.
e Pipe Palette menusiinden ayarlari degistirerek gozlemleyiniz.
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e FIFE

Fath k 1 selactad

Chain Selection @

Distance 1.00 v
Section @ Circular v
Section Size 5.00 mm v
Hallow D

Operation (5 Mew Body .3
a oK Cancel

Gorsel 3.14: Boru ve boru paleti

3.3. Taslak Cizim Komutlari
3.3.1. Sketch (Taslak) Olusturma

CAD programlariyla tic boyutlu nesne modelleme yapabilmek icin dncelikle iki boyutlu model taslaginin
bir diizlem Gzerine cizilmesi gerekir. Bunun icin de taslak ¢izim komutlari ile ¢cizime baslamadan dnce bir
Sketch acilmahdir.

Uygulama: Sketch (Taslak) Olusturma

Taslak olusturmak igin asagidaki yonergeleri uygulayiniz.

e Komut ikon ¢ubugu (zerindeki Create > Create Sketch komutunu calistiriniz ya da bir ¢izim komutu
seginiz.

e Duzlemleri gizim alanindan ya da Browser menisiinden segebilirsiniz.

e Secimin ardindan ekran donerek ¢izim yapmaya hazir hale gelecektir.

¢  Finish Sketch diigmesine tiklayarak taslagi tamamlayiniz.

e ikinci bir Sketch aciniz.

e Onceden Sketch ile cizilmis nesneler, Browser altinda Sketches dalinda bulunur. Nesne iizerine sag
tiklayarak ekran paletinden Edit Sketch (Taslak Diizenle) segimi yapiniz.

3.3.2. Nesne iliskilendirme Modlari (Kisitlamalar)

Kisitlamalar, cizimin bozulmamasina yardimci olur ve dgelerin parcalanmamasini ya da 6ngorilemeyen
alanlara tasmamasini saglar. Temelde ¢izimin seklini korumak icin nesne iliskilendirme modlari kullanilarak
cizimler ylzde yiz ongorilebilir hale getirilir. Kisitlamalar, cizimlerde degisiklik yapildiginda belirli

davranislarin korunmasina izin verir.

Uygulama: Nesne iliskilendirme Modlari

Nesneiliskilendirme iki bicimde gergeklestirilebilir. Nesne iliskilendirme islemiigin asagidakiyonergeleri
uygulayiniz.
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e Sketch ortamina girildiginde cizim yapma esnasinda c¢alismaya baslar. Her ¢izim isleminde onceki

Birinci yol i¢in;

cizim nesnelerinin referans olabilecek noktalarina kenetlenme saglanir. Cizim esnasinda kenetlenme
dogrultulart da kullanilabilir. Cizim bu dogrultulardan baslanarak sinirlandirilabilir. Kenetlenme
dogrultular siirekli kesik ¢izgi biciminde gorintulenir. Kesik gizginin gosterdigi dogrultulari tiklayarak
iliskilendiriniz ve bir ¢izim nesnesi olusturunuz.

e Cizim komutlari galistirildiginda otomatik nesne kenetlenmesi istenmiyorsa komut calisiyorken Ctrl
tusuna basili tutmak yeterlidir. Boylece herhangi bir kenetlenme gergeklesmez. Ctrl tusunu kullanarak
uygulayiniz.
ikinci yol igin;

e Cizim nesneleri olusturulduktan sonra da birbirleriyle iliskilendirilebilir. Sketch baslatildiginda ekranin
sag tarafinda otomatik olarak goriintlilenen Sketch Palette boliminden bu modlari seginiz ve gizim
nesnelerine tiklayarak iliskilendiriniz.

e Nesneiliskilendirme modlarinin ne ise yaradiginin bilinmesi 6nemlidir. Bu modlar, gizim sirasinda gizimi
kolaylastirir ve nesneler arasinda baglanti kurarak birbiri ile iliskilenmelerini saglar. Asagidaki modlari
sirasiyla uygulayiniz.

o Endpoint: Baslangi¢ veya son noktadir. Ayrica bir nokta yakalanacaksa Node (Diigiim), Endpoint
gibi islem gorir.

Midpoint: Orta nokta seger.

Center: Merkez nokta secer.

Intersection: Kesisim noktasi secer.

Extension: Bir gizginin hayali uzantisiyla hizali bir noktayi seger.

Perpendicular: Bir nesne {izerinde son segilen noktaya dik bir konum seger.

Tangent: Teget nokta secer.

Apparent Intersection: Kesismeyen iki nesnenin varsayilan kesisme noktalarini secer.

0 o O O O O o O

Parallel: Bir gizgiye paralel baska bir gizgi ¢cizmek igin kullanilir.

Kenetlenme komutlarinin tiimii otomatik olarak calisir ve ¢izim esnasinda her nesnede uygulanabilir.
Cizim esnasinda kenetlenme isleminin gerceklesmesi istenmiyorsa fare hareketleri yapilirken Ctrl tusuna
basili tutmak yeterlidir.

3.3.3. Line (Cizgi)

Line komutuna Sketch arag cubugundan L kisayol tusu ya da Sketch Toolbox menisiinden ulasilabilir.
Line komutu dogrudan veya bir Sketch agcma islemi sonrasinda calistirilabilir. Komut dogrudan ¢alistirilirsa
taslagin olusacagi cizim dizleminin gosterilmesi istenir.

Uygulama: Line (Cizgi) Cizme

Cizgi cizmek icin asagidaki yonergeleri uygulayiniz.

e Line komutunu isaretledikten sonra bir baslangi¢c noktasina tiklayiniz.

e Farenin hareketlendirilmesiyle birlikte ikinci bir nokta girilmesi (Specify next point) istenir. ikinci
noktayi tiklayiniz ve gizgi olusturunuz.

e Teget bir yay olusturmak icin son noktayi tikladiktan sonra farenin sol tusuna basili tutarak bir yay
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hareketi yapiniz. )

e ikinci izgi icin Line komutunu isaretledikten sonra bir >k

baslangi¢ noktasina tiklayiniz. Gizgi Boyu
Cizgi Agisi

e ilk noktayi tikladiktan sonra ekranda farenin hareketini g | t0mm (@ *

takip ederken iki adet oOlgii kutucugu belirir. Bu
kutucuklara cizgi boyu ve a¢i degerini girerek bir ¢izgi \ |
olusturunuz.

Gorsel 3.15: Cizgi olusturma

/ _ Uygulama: Cizginin Uzunlugunu Degigtirme .
Cizginin boyunu degistirmek icin asagidaki yonergeleri uygulayiniz.
e Bir deger girerek ¢izgi olusturunuz. Cizgi Gzerinde bir 6l¢l gorilecektir.
o Olgliyi cift tiklayiniz. Deger kutucugu goriinir hale gelecektir.
o Olcii degerini degistiriniz. Boylece cizgi boyu degisecektir.
o ki noktay tiklayarak yeni bir gizgi olusturunuz.

e (D) Sketch Dimension kisayoluna basarak Ol¢l veriniz. Bu 6l¢i ¢ift tiklanarak degistirilebilir.

Uygulama: Line Komutuyla Yay Cizmek

Line komutuyla yay cizmek icin asagidaki yonergeleri uygulayiniz.
e Cizimin son noktasini belirleyiniz.
e Son noktayi yerlestirirken farenin sol tusuna basili tutarak bir yay hareketi olusturunuz.
e Farenin sol tusunu yayin bitis noktasinda birakiniz.

e (Cizilen gizgiile yayin teget olduguna dikkat ediniz.

Uygulama: Cizgiyi Construction Line Haline Getirmek

Line komutu ile cizilen ¢izgiyi yardimci geometriye donlstiirmek icin asagidaki yonergeleri uygulayiniz.
e Line komutunu ¢ahstiriniz.
e Komut yardimiyla bir gizgi olusturunuz.
e Farenin sag tusu ardindan OK ya da ESC tusuna basarak Line komutundan gikiniz.
e (Cizilen gizgiyi seginiz.
e Sketch Palette menisiinden Construction secenegini isaretleyiniz ya da X kisayol tusuna basiniz.

Taslak gizimde herhangi bir geometri, yardimci geometri haline dénistirilmek istenirse ayni

adimlar uygulanir.

3.3.4. Circle (Daire)

Daire komutu, komut ikon gubugundan Sketch basliginin altindan galistirilabilir. Klavyede C kisayolu

tusuna basildiktan sonra daire cizimi icin komutlar Sketch Palette menisiinden goriintilenir.
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Uygulama: Merkez ve Yarigap Gostererek Daire Cizme

Merkez ve yaricap gostererek daire ¢cizmek icin asagidaki yonergeleri uygulayiniz.

e C(Circle > Center Diameter e SKETCHPALETTE
o Feat Opti
Circle komutunu calistiriniz. b i
. . e e . (&
e Dairenin capini 6lciilendirerek Sy i QI
<)

olusturunuz.

¥ Options

A

Construction

03

Look At

7 Sketch Grid

Snap

Slice

diameter of circle

Show Profile
/ Show Points

Show Dimensions
Showr Constraints

Séecifi
Show Projected Geometries

[0 B N O G (N T G B (N N

3D Sketch

Gorsel 3.16: Merkez yarigap gostererek daire ¢izme

Uygulama: iki Nokta Gostererek Yeni Daire Cizme

iki nokta gostererek yeni
® SKETCHPALETTE

\7}': ¥ Feature Options
yonergeleri uygulayiniz. | /
I<:>- )

daire ¢izmek icin asagidaki T

Circle

0S
L

e Circle > 2-Point Circle ko-

mutunu galistiriniz. /

¥ Options

e Ekranda iki nokta (cap ge- /

A

Construction

nisligi kadar) gosteriniz. 1/
/ Look At

| / Sketch Grid

120) / /| snep

/ . 4 Slice

05
e

/ . Show Profile
Show Points
Show Dimensions
Shavr Constraints

Show Projected Geometries

Fﬂ‘f
ORI O0RA

3D Sketch
v o OO B EHy

Gorsel 3.17: iki nokta gdstererek daire cizme
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Uygulama: Ug Nokta Gostererek Bir Daire Cizme

U¢ nokta goste-

® SKETCHPALETTE
rerek bir daire gizmek

1 ¥ Feature Options

icin asagidaki yonerge- g e Circle o) I 0

leri uygulayiniz. _ ©
e Circle > 3-Point b / ¥ Qptions

Circle komutunu ’,f" Canstruction <
calistiriniz. / ” LookAt
e Ekranda g nokta o j,/ I Skelch Gric %
gosteriniz. : e @
/// ' : / Slice ™
// i / Show Profile (%]
P | Show Points “
' Show Dimensions (]
5 mag L | Show Constrains “
Show Projected Geometries (@)
3D Sketch d

Gorsel 3.18: Ug nokta géstererek daire cizme
3.3.5. Arc (Yay)

Yay komutu, komut ikon gubugundan Sketch basliginin altindan galistirilabilir. Komut ikon gubugundaki
Sketch menisiinde Arc komutu altinda Gg¢ ayri komut oldugu gorilebilir. Komutun lg¢ se¢im yontemi vardir.

Uygulama: iki Ug ve Bir Orta Nokta Gosterilerek Yay Gizme ° =<7 "-=T'E

""""""""""""""""""""""""""""""" ¥ Feature Options

iki ug ve bir orta nokta gosterilerek yay ¢izmek )

n
=1
J

icin asagidaki yonergeleri uygulayiniz.
¥ Options

e Arc > 3-Point Arc komutunu galistiriniz.

A

Construction

e Baslangic ve bitis noktalarini isaretleyiniz.
Look At

isterseniz  baslangic ve bitis noktalari
e e e f Sketch Grid
arasindaki kiris mesafesini giriniz. /

e Yayin orta (kubbe) noktasini olusturacak Sk

Slice

}
noktayi isaretleyiniz. '

| Show Profile
Show Points

Show Dimensions

Show Constraints

G G R S R (S N

Show Projected Geometries
3D Sketch ™|

Gorsel 3.19: iki ug ve bir orta nokta gésterilerek yay ¢izme
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Uygulama: Merkez, Yarigap ve Bitis Noktalarini Gostererek Yay Cizme

Merkez, yarigap ve bitis noktalarini gdstererek yay ¢izmek i¢in asagidaki yonergeleri uygulayiniz.

e Arc > Center Point Arc komutunu ® SKETCH PALETTE

¥ Feature Options

cahstiriniz.

)
o4

e Yay merkezini gosteriniz. Al
e Yayin yarigapini ve bitis noktasini i ML

A

Construction

gosteriniz. Istediginiz takdirde bitis

Look At

m:

noktasina agi degeri vererek de
¢izimi gerceklestirebilirsiniz. i Sketch Grid

| Snap

= J Slice
+ | | Shows Profile
Show Points

Show Dimensions

Show Constraints

(G CS R CS i CS R CS R G S

Show Projected Geometries

(]

30 Sketch

Gorsel 3.20: Merkez, yarigap ve bitis noktasi (agi) gbstererek yay ¢izme

Uygulama: Cizgiye Teget Yay Cizme
Cizgiye teget yay cizmek icin e
asagidaki yonergeleri uygulayiniz. e
e  Bir ¢izgi giziniz. - l
Arc 1
e Arc > Tangent Arc komutunu

¥ Options
cahstiriniz.

A

. . . o ‘.\1 o o
e (Cizginin ucunu teget noktas B onstruction

olarak seginiz. Look At
e Arc bitis noktasini isaretleyiniz. Skelch Grid
Snap

Slice

Shaw Profile

Shaw Paints

Show Dimensions

Specify end point

Show Constraints

(CUJNCS I G N B C B 0 R CS N

Show Projected Geometries

()

3D Sketch

Gorsel 3.21: Cizim elemanin (teget) ucu, bitis noktasi ile yay gizme
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3.3.6. Rectangle (Dikdértgen)

DiJiTAL URETIM

Dikdortgen cizmek icin Rectangle komutu kullanilir. R, kisayol tusudur. Dikdoértgen gizimi l¢ yontemle

yapilabilir.

Uygulama: iki Nokta Gostererek Dikdortgen Gizme

iki nokta gostererek dikdértgen

¢izmek icin asagidaki yonergeleri uy-

gulayiniz.

e Rectangle > 2-Point Rectangle
komutunu g¢alistiriniz.

e Capraz iki koése noktasini
isaretleyerek dikdortgeni giziniz.

e Kenar Olgilerini ¢izimden son-
ra diizenleyiniz. Cizim sirasinda
TAB tusu yardimiyla kenar 6lgl-
leri arasinda gecis yapabilirsiniz.
Klavyeden deger vererek dik-
dortgeni gizilebilirsiniz.

© SKETCHPALETTE

¥ Feature Options

Rectangle I < =

¥ Options

7%

Construction

(nal

Look At

Sketch Grid

Snap

Slice

1 Show Profile

Show Points

70.00 mm Show Dimensions
Show Constraints

Show Projected Geometries

[0 G CN R (N B G RGN R IR (R N

30 Sketch

Gorsel 3.22: jki nokta ile dikdértgen ¢izme

Uygulama: Ug Nokta Gostererek Yeni Bir Dikdortgen Cizme

U¢ nokta gostererek yeni
bir dikdortgen cizmek icin asa-

gidaki yonergeleri uygulayiniz.

©® SKETCHPALETTE

¥ Feature Options

Rectangle gzl I =

. ¥ Options
e Rectangle > 3-Point Rec-
Construction <
tangle alt komutunu cals- g
Look At
triniz. Skelch Grid @
e Dikdortgenin ¢  kose - @
noktasini siraslyla ekran S m)
lizerinde isaretleyiniz. I Shows Profile @
in |
¥ Showy Points @
50 Show Dimensions @
: Shawy Constraints @
L= g Show Projected Geometries @
3D Sketch Q

Gorsel 3.23: Ug nokta ile dikdértgen gizme
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Uygulama: Merkez Noktasiyla Yeni Bir Dikd6rtgen Cizme

Merkez noktasiyla yeni bir abiSieE S
¥ Feature Options

dikdortgen cizmek icin asagidaki

. . Rectangle o & I
yonergeleri uygulayiniz.
¥ Options
e Rectangle > Center Rectangle «
- Construction =
komutunu galistiriniz. =
Look At
e Ekran Gzerinde dikdortgenin "
Sketch Grid
merkez noktasini secerek kdse : v
nap
noktasini isaretleyiniz. " 0
ICe
Gizim olgllerini diizenleyiniz. A, T @
50 mm A
Show Points @
Show Dimensions @
Shaow Constraints @
Show Projected Geometries @
30 Sketeh (|}

Gorsel 3.24: Merkez noktasiyla dikdértgen ¢izme

80

140

40

10
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3.3.7. Slot (Kanal)

Kanal olusturmak igin birden fazla yontem vardir.

Uygulama: iki Eksen Arasi Olgiiyle Yarigap Olgiisiinii isaretleyerek Kanal Cizme

iki eksen arasi olclyle yari- © SKETCHPALETTE

‘wFeature Options

s i---

cap Olglslini isaretleyerek kanal
¢izmek icin asagidaki yonergeleri

=
uygulayiniz. Zv Options

e Slot > Center To Center Slot ko- v il <

mutunu c¢alistiriniz. K T I 20/ EaeicR

e Eksenler arasi mesafeyi belirle- 1 R @

mek i¢in noktalari isaretleyiniz. ‘ . Y i g

e Kanalin yarigcap 6l¢isi olan nok- = ) jthmme @

tay! (Deger penceresine 6l¢li de S @

yazilabilirsiniz.) isaretleyiniz. Show Dimensions @

Show Canstraints @

Show Projected Geometries ()

3D Sketch o

#ra 9 Q- B @ B~

Gorsel 3.25: jki eksen arasi 6l¢iiyle yaricap 6l¢iisiinii isaretleyerek kanal cizme

Uygulama: Merkez, Eksen Noktasi ve Yarigcapla Kanal Cizme

Merkez, eksen nok-

® SKETCHPALETTE
tas! ve yaricapla kanal

wFeature Options

cizmek icin asagidaki
Slot =} I o &

ybnergeleri  uygulayi-

S
q niz.
wQOptions
, ) e Slot > Center Point
T Construction <
[20.00 1| _
K + ) Look At Slot komutunu ca
- h i e @ listiriniz.
3 5 . @ e Merkez noktayi isa-
s @ retleyiniz.
S @ e Eksenlerin Olgusi-
Show Points @ n[]n yar|5| Olan me-
Show Dimensions ] Safeyi belirlemek
Show Constraints @ icin diéer noktay|
Show Projected Geometries @ |§a retleyiniz_
3D Sketch |-
T TR P e e e = =) e Kanalin yarigap 6l

Gorsel 3.26: Merkez, eksen noktasi ve yarigapla kanal gizme clisi olan noktayi

isaretleyiniz.

3. OGRENME BIRIMi Wio!



Uygulama: iki U¢ Noktasi ve Yarigapla Kanal Cizme

iki u¢ noktasi ve yaricapla kanal Slot i I@,
cizmek icin asagidaki yonergeleri uy- =
gulayiniz. v Options
e Slot > Overall Slot komutunu ¢a- 43 Construction =

histiriniz. K = J, Look At
e |ki nokta ile Slot u¢ noktalarini Sketeh Grid “

isaretledikten sonra yaricap 6lgi- Sniap 4]

su olan noktay! belirleyiniz. Siice o

' g ] Ol [}
Show Paints [}
Show Dimensions @
Show Constraints &
Show Projected Geomelies ()
3D Sketch o

Gorsel 3.27: ki u¢ noktasi ve yarigcapla kanal ¢izme

3.3.8. Polygon (Cokgen)

Polygon, eskenar cokgenler ¢cizmek icin kullanilan komuttur. Eskenar cokgenlerin (i¢ ¢izim yontemi vardir.

Uygulama: Daire Disina Cokgen Cizme

Daire disina cokgen ¢izmek icin asagidaki yonergeleri uygulayiniz.

e Oncelikle bir daire ¢iziniz. & SKETCHPALETTE
¢ Polygon > Circumscribed Polygon komutu- Theatire Sptions
nu calistiriniz. y < AT o I o
e Dairenin merkez noktasini isaretleyiniz. : Haniers
e Acilan deger penceresine gokgenin kenar i =
saylisini yaziniz. Look At
* ki nokta ile dairenin merkezini ve yarigapi- s @
ni isaretleyiniz. Srap “
Slice (-]
Show Profile (¥
Showi Paints @
Show Dimensions (%)
Showi Constraints @
Show Projected Geometiies ()
3D Sketch ]

Gorsel 3.28: Daire disina ¢okgen ¢izme
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Uygulama: Daire icine Cokgen Cizme
Daire igine ¢okgen gizmek icin asagidaki T
yonergeleri uygulayiniz. v Feature Options

Polygon £ 0y l

e Polygon > Inscribed Polygon komutunu

cahstiriniz. v Options
e Dairenin merkez noktasini isaretleyiniz. Construction <
e Acllan deger penceresine gokgenin ke- Lock At
nar sayisini yaziniz. m | @
e ikinokta ile dairenin merkezini ve yarica- i @
pini isaretleyiniz. g a
Show Profile @
Shaw Points @
Show Dimensions @
Show Constraints @
Show Projected Geometries (¥
3D Skelch g

Gorsel 3.29: Daire icine ¢cokgen ¢izme

Uygulama: Kenar Boyutunu Vererek Cokgen Cizme

Kenar boyutunu vererek ¢cokgen ¢izmek icin asagidaki yonergeleri uygulayiniz.

e Polygon > Edge Polygon alt komutunu o SKETCHPALETTE
¥ Feature Options
cahstiriniz.
. . . . / Polygon I @ ©
e Dairenin merkez noktasini isaretleyi- / 5 -
// ¥ Options
niz. 7 ‘
/|3 Construction <
* Aclilan deger penceresine gokgenin ke-  { i
/
nar sayisini yaziniz. L/ Sketeh G @
H . . . . . . //
e |ki nokta ile dairenin merkezini ve yari- Lf Snep @
/
capini isaretleyiniz. frhesieofiephin] Sico =
+ Show Profile @
Show Points @
Shaow Dimensions @
Shaw Constraints @
Show Projectsd Geometries @
3D Sketch o

Gorsel 3.30: Kenar boyutunu vererek ¢okgen ¢izme
3.3.9. Ellipse (Elips)

Bir merkez, dar ve genis ug olcileri verilerek elips cizilebilir.
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Uygulama: Ellipse (Elips) Cizme

e Ellipse komutunu ¢alistiri-
® SKETCHPALETTE

niz. v Options
e ilk nokta ile elipsin B riint s o
merkezini isaretleyiniz. s
e Diger iki nokta ile elipsin 0 @
dar ve genis uglarini isaret- @
leyiniz. - o
Show Profile ()
Show Points (¥}
Show Dimensions @
Show Constraints @
Show Projected Geometries (&)
3D Sketch ™)}

Gorsel 3.31: Elips ¢izme

3.3.10. Conic Curve (Konik Egri)

Conic Curve, bir koninin kesit ayriti demektir. Disli cark yuvarlanma yuzeylerinin, dis profillerinin

ciziminde kullanilir. Baslangig, bitis noktalarinin ve odak uzakliginin isaretlenmesiyle olusturulur.

Uygulama: Conic Curve (Konik Egri) Cizme

e Conic Curve komutunu galistiriniz.
@ SKETCHPALETTE

e ki nokta ile egrinin u¢ noktalarini ¥optons

isaretleyiniz.

i

o .. .- o. Construction
e Egrinin u¢ noktasinin ylkselecegi £

. . . - Look At
yondeki noktayi isaretleyiniz. 3

Sketch Grid

Snap

Slice

Showe Profile

Show Points

Showe Dimensions

Show Constraints

Show Projected Geometries

3D Sketch

(0 C O G T G G I O C (N

Gorsel 3.32: Konik egri ¢izme
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Spline, farkli noktalar ya da dogrulardan gecen birlesik egriler ¢izmek icin kullanilir. isaretlenen

3.3.11. Spline (Egri)

noktalardan gecen egriler ekranda cizilebilir. Olusan isaretleme noktalari ve egri teget cizgileri
Olgllendirilerek parametrik sinirlar verilebilir.

Uygulama: Spline (Egri) Cizme

Egri cizmek icin asagidaki yo-

@ SKETCHPALETTE
nergeleri uygulayiniz. v Options

e Spline komutunu galistiriniz.

Construction &

e Onceden belirlenmis nokta- Look At
lara ya da ekrandaki belirli Sketeh Grid ¥
yerlere istenilen siklikta isa- Snap @
retleme yapiniz. T o

e Yesil daire icinde yer alan tik | show Profile @
semboliline tiklayarak Spline SRl @
nesnesini tamamlayiniz. St DESE @

e Egri Uzerindeki noktalarin Sty Gasiciis @
konumu degistirilebilir. ST e [
Noktanin stliinde goriinen 4D Skatch ()]

Anchor (Capa) dogrularinin Gorsel 3.33: Egiri cizme
uglarini  ¢ekerek egrinin
noktalarda yaptigi kavis hare- : .

ketini yeniden diizenleyiniz.

Uygulama: Kontrol Noktali Egri Cizme

Secilen kontrol noktalari tarafindan yonlendirilen bir Spline olusturur. Kontrol noktal egri gcizmek igin
asagidaki yonergeleri uygulayiniz. ;

e Spline komutunu calistiriniz. .

e Egriyi baslatmak icin ilk noktayi seginiz.

e Kontrol noktalari olarak ek noktalar seginiz ve gizime 2 if o
. \\\\
devam ediniz. ﬁ e

e Tik semboliine tiklayarak ¢izimi tamamlayiniz. \

Gorsel 3.35: Kontrol noktali egri
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3.3.12. Text (Metin)

Bir baslangi¢ noktasi gosterilerek istenilen 6zellikte yazi olusturulabilir.

Uygulama: Text (Metin) Olusturma

Metin olusturmak i¢in asagidaki yonergeleri uygulayiniz.
e Text komutunu calistiriniz.
e saretlenen nokta ile ekranda beliren yazi alanina bir metin yaziniz.
¢ Text Palette menisiinden ayarlari degistirerek metni gdzlemleyiniz.

® TEXT
Text Wesleki EGitim
Height 10 mm v
Angle 1550 deg -

Textstde B 1T U

Fant Arial >.
Flip & X
10 - 1550deg ¥ i ) oK Cancel

Gorsel 3.36: Metin olusturma

3.3.13. Point (Nokta)

Point; cizim ortamina noktalar yerlestirmek, ¢izim ortaminda olusturulan noktalarin delik merkezlerini
belirlemek, egri ciziminde kilavuzluk etmek gibi islemlerde kullanilabilir. Cizim elemanlari izerine noktalar
yerlestirilebilir, 6lctlendirilebilir veya parametrik sinirlamalar yapilabilir.

3.3.14. 3D Sketch (Ug¢ Boyutlu Taslak)

3D Sketch olusturmadan 6nce Preferences (Tercihler) > Design (Tasarim) > Allow 3D Sketching of
Lines and Splines (Dogru ve Egrilerle 3D Taslak Olusturmasina izin Ver) secenegi isaretlenmelidir. 3D

Sketch; U¢ boyutlu cizgi, egri, daire, yay ve dikdortgen gizmek icin kullanilir.

Uc boyutlu taslak olusturmak icin asagidaki yo- 55
nergeleri uygulayiniz.
e Bir Sketch olusturarak dikdortgen ciziniz.
e Boyu 50 mm, eni 70 mm olacak sekilde dikdortge-
ni Olglilendiriniz. L :

e  Finish Sketch komutu ile Sketch olusturunuz.

70.00

Gorsel 3.37: Dikdértgen olusturma
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& OFFSET PLANE

e Bu dikdortgene belli bir
uzaklikta asagl ya da yukari
yonde Offset Plane (Diizle-

mi Otele) komutu ile Plane Plane
olusturunuz. Bxtent Ml Distance -
e Plane Uzerinde bir Sketch Distance 6000 mm 5
olusturarak Project (P) ko- o oK ] [Gareal
mutu ile dikdoértgenin ke-
narlarini izdsirindz.
e Taslagi kapatiniz.
o  GOrunUumu izometrik hale Gorsel 3.38: Diizlem otele
getiriniz. 35
e Spline komutunu calisti- \*\\ S b IeP
riniz. Noktalari gorseldeki s ol 5o 4’
gibi ilk dikdértgenin koése- _,,,\7“5{\ B |4 FROJECT
sinden baslayarak isaretle- \\\\, = o
yiniz. \\\\\ Selection Filter B (O
e Son noktayi isaretlediginiz- b > ProjectionLink (&)
de Enter tusu ile islemi son- ) oK | [Cancel
landiriniz.

Gorsel 3.39: zdiisiim

S
Gorsel 3.40: Ug boyut/?; taslak
3.3.15. Fillet (Yuvarlatma / Kavis)

Fillet daha ¢ok keskin koseleri yuvarlatmak igin kullaniimaktadir. Yuvarlatilacak nesnelerin kesismesi
sart degildir. Yuvarlatilacak kenar cizgilerinin secimi yeterlidir. iki ¢izgi secildikten sonra deger penceresine
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yarigap Olc¢list yazilarak ya da mavi ok tusu hareket ettirilerek yuvarlatma islemi yapilir. OK (Tamam)

butonuna tiklanarak islem tamamlanir.

= e Y 4
\ £
N | Select first line or arc ‘ q
\ | ; 1000 mm | *
\|
‘ J Select first line or arc

Gorsel 3.41: Yuvarlatma

3.3.16. Trim (Budama)
Trim; birbirini kesen nesnelerden birini, digerine gére kirparak silme islemidir. Kisayolu T tusudur. Ug¢

bicimde budama yapilabilir.

e Ug Gostererek Budama: Cakisan cizgilerin uglari gosterilir. Gosterilen bolim kirmizi renk alir.

e Fareyi Siriikleyerek Budama: Farenin sol tusuna basili tutulur ve uzanti uglarinin tzerinden gegilir.
Uclar cakisma noktasina kadar budanir.

e Tek Bir Nesneyi Gostererek Budama: Silme islemine benzer. Herhangi bir cakisma yapmayan nesneye

tiklanarak nesnenin silinmesi saglanir.

Select curve section ko trim |
— — = — — ) O - — _

5 —— = — S — - \ L 5%} = /\\

o &

Gorsel 3.42: Budama

3.3.17. Extend (Uzatma)

Extend, bir nesneyi baska bir nesnenin sinirina kadar uzatmak igin kullanilir. Modify komut nesnesinin
altinda yer alir. Nesneler cizgi, yay veya egri olabilir. Nesnelerin uzantisinin kesismesi gerekir. Uzatilacak
nesnenin Uzerine fare ile gelindiginde otomatik olarak uzayacagi sinira kadar kirmizi gizgi belirir, tiklaninca

¢izgi uzar. Cizginin uzantisinda kesisecegi baska nesneler varsa ayni islem devam eder.

Select curve to extend

..r_) I . — '-j L "

Gorsel 3.43: Uzatma
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Offset; cizgileri, kenarlari, egrileri ve profilleri belirli bir mesafede 6teleyerek ¢cogaltma islemidir.

3.3.18. Offset (Oteleyerek Cogaltma)

Uygulama: Offset (Oteleyerek Cogaltma)

Oteleyerek cogaltma islemi icin asagidaki yonergeleri uygulayiniz.
e Modify>Offset komutunu ¢alistiriniz. Ekrana Offset diyalog kutusu gelir.
¢ Nesne ya da nesneleri seciniz. Offset Position kismina 6teleme mesafesini yaziniz.
e Oteleme yoniinii ekran {izerinde isaretleyiniz. imleci fare ile basili tutup kaydirarak Offset miktari ve

yoniunu elle degistirebilirsiniz.

2 |35 & (=
o3 © 3
T— I 2 &
4l — — O
5167 mm : y e, .&
=]
<
@ OFFSET g
Sketch curves |
= | [ w
&= Chain Selection [ | &=

Offset position 3187 mm
Flipy &

[i ] ok Cancel p.

|
|
f

)|
5
]
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3.3.19. Mirror (Aynalama)

Mirror; cizgileri, kenarlari, egrileri ve profilleri belirli bir referans nesnesine gore aynalayarak ¢cogaltma
islemidir. EndUstriyel Grlnler genellikle simetrik olarak tasarlandigi igin ¢ok sik kullanilan bir komuttur.

Uygulama: Aynalama (Mirror) Yapma

Aynalama islemi icin asagidaki yonergeleri uygulayiniz.

e Bir taslak olusturunuz.

e Referans alacaginiz bir nesne ¢iziniz. Referans nesnesi olarak bir dogru cizebilirsiniz.

e (Cizgi secili iken Sketch Panel menusiinden Construction ifadesine tiklayiniz ve ¢izdiginiz dogruyu kesik
cizgili hale donustiriniz (Kesik ¢izgi yardimci geometridir, tasarimin bir pargasi degildir.).

e Komut ikon ¢ubugu altinda Create > Mirror komutunu seginiz.

@ MRROR
Objects Iy 18 selected X
Mirror Ling X
i) OK | Cancel
?
— : =
= i
= ] =
|
() Iy
19 . il -
I
I
=il I .
= I
= i y
j &

Gorsel 3.45: Aynalama

e Aynalanacak nesneyi ve Mirror Line (Aynalama Dogrusu) seginiz.
e OK tusuna basiniz.

’ Sira Sizde 4

Asagida olclleri verilen sekli dijital Gretim programinda giziniz.

2
|

Chiamfer 2x45° —\
F
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Circular Pattern, secilen nesneleri bir eksen etrafinda dairesel olarak ¢ogaltmak icin kullanihr.

3.3.20. Circular Pattern (Dairesel Cogaltma)

Uygulama: Dairesel Cogaltma

Dairesel cogaltma yapmak icin asagidaki yonergeleri uygulayiniz.

e Circular Pattern komutunu galistiriniz.

e Objects ile dondirilecek nesneyi seginiz.

e Dondirme merkezi olarak ekranda olusturulmus bir nokta veya koordinat merkezi seginiz.

e Type ile acisal, tam dairesel ya da simetrik se¢cim yapiniz.

e Suppress secimiyapilirsa cogaltilan nesnelerin yaninda onay kutucuklari gikar. Bu kutucuklarin isaretini
kaldirarak ¢ogaltilan nesneyi silebilirsiniz.

e Quantity kismina ¢ogaltma adedini giriniz.

e OK tusuna basarak islemi tamamlayiniz.

2
=

6\\ | /EW\
Lt ESE b e CIRCULAR PATTERN

0§

Objects b1 selected X

Center Point

A ‘ VAT :
g SR SRR l\j | Typs
\ & : B T Suppress (%)
'\\\ | y Quantity &} -
/w 11 1| ( [i ] OK Cancel
=
oA

Gorsel 3.46: Dairesel cogaltma
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3.3.21. Rectangular Pattern (Dikdortgensel Cogaltma)

Rectangular Pattern, bir nesnenin verilen satir ve siitun sayisinda dikdortgensel olarak ¢ogaltiimasi
icin kullanilir. Sadece bir yon verilerek cogaltma yapilirsa dogrusal ¢ogaltma, iki yon verilerek cogaltma

yapilirsa dikdortgensel cogaltma adini alir.

Uygulama: Dikdortgensel Cogaltma

e Rectangular Pattern komutunu calistiriniz.

e Cogaltilacak nesneyi seginiz ya da komutu ¢alistirdiktan sonra Objects kismini tiklayarak nesne se¢imini

yapiniz.

e Direction/s secimi ile ekrandaki oklar yatay ve dikey olarak siriiklenebilir. Tek yonde ¢ogaltma igin

sadece o yondeki ok isaretini siirlikleyiniz.
e Distance Type alaninda adim ya da ¢ogaltilacak boy segimini yapiniz.
e Quantity kisimina cogaltilan nesnelerin adedini yaziniz.
¢ Distance bolimiine ¢cogaltma yapilacak boyu yazabilirsiniz.

e Direction Type alaninda simetrik ya da tek yonll secim yapabilirsiniz.

{,,/h\ \ /ﬁ \ & RECTANGULAR PATTERN
@ \ . / K = 'j Objects 7 d
b L e

Direction/s I Select
@ Distance Type  hos Extent
Suppress @
/—"‘ /—“ Quantity 3
@ @ K } Distance 10000 mm
J "_// Direction Type ¥ One Direction
Quantity &
Distance -100.00mm
10000mm  * 3 s
//_“‘ //‘\ //‘\- Direction Type 5% One Direction
K@ \ (\ il ‘ \ i) OK
P EAREEE

Gorsel 3.47: Dikdértgensel cogaltma

3.3.22. Move / Copy (Tas! / Kopyala)

Move / Copy; cizim alani Gzerindeki nesne ya da nesneleri ve nesnelerin detaylandirmalarini bir

noktadan baska bir noktaya tasimak, kopyalamak ve déndiirmek igin kullanilir.

Uygulama: Tasi / Kopyala

Tasi / Kopyala islemi icin asagidaki yonergeleri uygulayiniz.
e Komutu calistiriniz. Ekrana Move / Copy diyalog kutusu gelir.
e Selection kismindan tasinacak nesneleri seginiz.

112/ 3. OGRENME BIRIMi

v

v

Cancel



DiJiTAL URETIM

e Move Type (Tasima Tiirii) kisminda Free Move (Serbest Tasima), Translate (XYZ Eksenlerine
Doniistir), Rotate (D6ndiir), Point to Point (Noktadan Noktaya Tasi), Point to Position (Noktadan
Konuma Tasima) seceneklerini segebilirsiniz.

e Set Pivot ile yeni bir tutma noktasi belirleyiniz.

e XYZ Distance kisminda nesnenin XYZ eksenlerine olan mesafesini belirleyiniz.

e XYZ Angle kisminda nesnenin XYZ eksenleri ile arasindaki a¢i degerini giriniz.

e Create Copy kutucugunu isaretlerseniz nesnenin siiriiklendigi yerde bir kopyasini olusturabilirsiniz.

e Ok yonleriyle veya kigik bir kare bicimindeki diigmeden tiklayarak striikleme yapabilirsiniz.

e Nesnenin tasinacak noktasini farenin sol tusuna basili tutarak seciniz. Bu noktadan basili tutup nesneyi

surikleyerek istenilen yere birakiniz.

14009mm | v | 17277mm (¥ | 000mm | v LE S MOVECOPY

Wowe Object I

Selection

Mave Type I ERES

Set Pivot 1

¥ Distance 14.009 mm v
¥ Distance 17277 mm -
Z Distance 0.00mm -
HoAngle 00 deg v

e

= Y Angle 0.0deg v
ZAngle 0.0 deg =
i ] OK | |Cancel

Gorsel 3.48: Tasi

3.3.23. Scale (Olgeklendirme)

Scale, cizim alani Uzerindeki nesne ya da nesneleri bir nokta merkez alinarak belirlenen olcekte

blyultmek ya da kic¢tltmek amaci ile kullanilir.

Uygulama: Olgeklendirme

Olgeklendirme yapmak icin asagidaki yonergeleri uygulayiniz.
e Komutu galistiriniz. Ekrana Sketch Scale diyalog kutusu gelir.
e Entities kismindan 6lgeklendirilecek nesneyi seginiz.
e Point kismindan o6lgeklendirme islemi icin referans noktasi seginiz.
e Scale Factor kismina Olgeklendirme faktoriinii (blytltme ya da kiiglltme miktarini) yaziniz.

e OK tusuna basiniz.
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® SKETCHSCZALE

Entities Iy 4 selected X
& Faint
Scale Factor 15 i
© oK Cancel
£ L 4
15 v

Select sketch points or work points as a reference to scals |

Gérsel 3.49: Olgceklendirme
3.3.24. Sketch Dimension (Olgiilendirme)

Sketch Dimension, bir ya da daha ¢ok nesneyi dl¢iilendirmek icin kullanilir. Cizilen nesnelerin ol¢ilerini
dahasonradegistirmek miimkiindiir. Olciilerde yapilan degisiklikler otomatik olarak geometrinin konumuna
ve blyulkligine yansir. Batlin 6lgllendirme gesitlerini tek olcllendirme komutu ile yapma imkani sunar.

Uygulama: Olgiilendirme

Olcilendirme yapmak icin asagidaki yénergeleri uygulayiniz.

e Sketch Dimension komutunu calistiriniz.

e Olgiilendirilecek nesneyi seciniz. Olgii gizgisini yerlestirince ekrana deger diyalog kutusu gelir.

e istenilen dlciiyii yazip Enter tusuna basiniz. Ol¢iilendirilecek baska bir ¢izim elemani varsa ona tiklayarak
Ol¢lilendirmeye devam ediniz.

o ki dogru arasindaki aciyi da élgiilendirebilirsiniz.

e D kisayol tusuna basiniz. Sketch Dimension aktif iken birinci dogruya, ardindan ikinci dogruya tiklayiniz.

e Dogrular arasindaki agi Olglistinii girerek degistiriniz.

140.00

50.00

00 0g

590.00

Gorsel 3.50: Oiciilendirme

3.3.25. Split Body / Split Face (Kesisim Egrisi)
Split Body / Split Face; secilen gévdeleri bir profil, yiz veya diizlem kullanarak béler ve yeni gévdeler olusturur.
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Uygulama: Split Body (Kesisim Egrisi)

Kesisim egrisinin kullanimi igin
asagidaki yonergeleri uygulayiniz.

e XY dizleminde bir Box olustu-

runuz.
e Construct > Midplane komutu-
nu calistiriniz. b
e Kutunun alt ve Ust tabanlarini
seciniz. Segilen bu iki dizlem
arasinda bir orta dizlem olus-

turulur.

Gorsel 3.51: Orta diizlem olusturma

e Modify > Split Body komutunu
cahstiriniz.

e Body to Split olarak bélinmesi
. . . .. ® SFPLITECDY
istenen govdeyi seginiz.
Body to Split I+ 1 selected X
e Splitting Tool(s) olarak Cons-
. . Splitting Tool(s)
truct > Midplane komutu ile

olusturulan, modeli kesen orta o

dizlemi seginiz.
e OK tusuna basarak islemi

tamamlayiniz.

Select the splitting Tool(s!

Gorsel 3.52: Split body

Uygulama: Split Face (Kesisim Egrisi)

Kesisim egrisinin kullanimi igin asagidaki yonergeleri uygulayiniz.
e XY dizleminde bir kiire olusturunuz.
e XZ dizleminde bir Sketch olusturunuz.
e Spline komutu ile egri giziniz.
e (Cizgi ya da egri nesnelerini ylizey nesnesine ¢evirmek icin Surface (Ylizey) komut ikon penceresini

3. OGRENME BIRIMi Wi



secerek altindaki Create > Extrude komutunu calistiriniz.

e OK tusuna basarak islemi tamamlayiniz.

e EXTRUDE

Profile

Chaining @

Start b Profile Plane v

Direction 4 Symmetric -
Extent Il Distance v
Measurement [l &2

~ Distance 100,00 mm i

Taper Angle 0.0deg v

Operation I MNew Body v

i ] \.7OK7I {ancgl-

e Nesneyi seginiz.

e Egriile olusturulan ylzeyi seginiz.
e OK tusuna basarak islemi tamamlayiniz.

© SPLITBODY

Body to Split Ik 1selected X

Splitting Tool(s)

Extend Splitting Tool{s) @

oK | [cancel

Gorsel 3.54: Egri ile gévde bélme

3.4. Komut Yardimiyla Objeler Olusturma

Dijital Giretim programinda gesitli komutlar yardimiyla yeni nesneler olusturulabilir.
3.4.1. Profil Nesnelerini Dondiirerek Yeni Nesne Olusturma

Dijital Uretim programinda iki boyutlu gizimler belirli yontemlerle bir eksen etrafinda dondirilerek
yeni nesneler olusturulabilir.

3.4.1.1. Revolve (Dondiirerek Nesne Olugturma)

Revolve, iki boyutlu nesneleri belirlenen bir eksen etrafinda dondirerek yeni bir nesne olusturma
komutudur. Déndlrme ekseni siirekli gizgi veya eksen c¢izgisi olabilir.
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Revolve komutunu kullanarak 80 cm ¢apinda yuvarlak masa tablasi olusturmak igin
asagidaki yonergeleri uygulayiniz.

e XY dizlemini segerek asagida olgileri verilen iki boyutlu sekli giziniz.

o Sekli cizdikten sonra Finish Skecth tiklayiniz.

@

320.00

st

e3

35.00

&\
« Y
2
0002
\
A
<

25.00

5500

Gorsel 3.55: ki boyutlu gizim
e Create > Revolve komutunu seginiz.

e Dondirilecek Profile (Profil) ve Axis (Eksen)’i seginiz.
e OK tusuna basarak islemi tamamlayiniz. Calismanizi kaydediniz.

Gorsel 3.56: Yuvarlak masa tablasi

3.4.1.2. Sweep (Yol Kullanarak Nesne Olusturma)

Sweep, secilen kapall bir geometrinin kapali ya da acik bir yolu stplrerek nesne olusturmasi icin
kullanilan komuttur.

http://kitap.eba.gov.tr/KodSor. =4
. php?KOD=21377 &
Uygulama: Késegen Dolap Kulpu Olusturma

Sweep komutunu kullanarak 7,5 cm uzunlugunda,

1 cm genigliginde dolap kulpu

C

olusturmak icin asagidaki yonergeleri uygulayiniz. 2N 2
e XY dizlemini secerek 25 mm yuksekligi, 75 mm g g
uzunlugu olan ters U bicimindeki sekli ¢iziniz.
i

Gorsel 3.57: ki boyutlu ¢izim
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e XY dizleminde sekli ¢izdikten sonra Fillet komutu ile R10 olacak sekilde yuvarlayiniz. Sekli gizdikten
sonra Finish Skecth tiklayiniz.

e XZ dizlemini segcerek 5 mm yarigapinda bir altigen giziniz.

e Sekli gizdikten sonra Finish Skecth tusuna tiklayiniz.

e Create > Sweep komutunu secerek Profile (Profil) olarak XY diizleminde ¢izdiginiz sekli ve Path (Yol)
olarak XZ diizleminde gizdiginiz sekli seginiz.

e OK tusuna basarak islemi tamamlayiniz. Calismanizi kaydediniz.

© SWEEP
Type (i) Single Path -
Profile [» 1selected X

Path k1 zelected [

Chain Selection A

Distance 1.00 -
Taper Angle 0.0 deg -
Twist Angle 0.0 deg -
Orientation f‘@ Perpendicular r %
Operation Cﬁ New Body r
i ] oK Cancel

Gorsel 3.58: Sweep komutu

° Sira Sizde 6 [

Yandaki resimde gordigliniiz ¢ay fincani ve tabagini
tasarlayiniz. Cay fincani 60 mm yiksekliginde (taban
yaricapi 20 mm, agiz yaricapl 60 mm), tabagi 5 mm
yuksekliginde olmalidir.

3.4.1.3. Loft (Profiller ve Yiizeyler Arasinda Nesne Olusturma)

Loft, farkh dizlemlerde ve taslaklarda cizilmis profiller arasina malzeme atayarak nesne olusturur.

Komutun kullanilabilmesi igin profillerin kapali olmasi ve farkh diizlemlerde gizilmesi gerekir.
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http://kitap.eba.gov.tr/KodSor. & J"-‘.“
php?KOD=21378 o

Uygulama: Dolap Ayagi Olusturma

Loft komutunu kullanarak taban yarigapi 3,5 cm altigen, ortasi 60 mm ¢apinda ve 90 mm uzunlugunda

dolap ayagi olusturmak icin asagidaki yonergeleri uygulayiniz.

e XY dizlemini segcerek 35 mm yarigapinda bir altigen giziniz.

e Sekli cizdikten sonra Finish Skecth tiklayiniz.

e Construct > Offset Plane seciniz ve XY diizlemine 40 mm uzaklikta yeni bir diizlem olusturunuz. Bu
diizlemde 40 mm ¢apinda bir daire giziniz.

e Construct > Offset Plane seciniz ve XY dizlemine 25 mm uzakhkta yeni bir diizlem olusturunuz. Bu
diizlemde 60 mm ¢apinda bir daire giziniz.

Select ﬂane; ﬂanar face

‘)5|l"\ﬂ
@ OFFSET PLANE

Plane k1 selected B

Extent H Distance

25 L4

Distance 25 mm

[i ] OK Cancel

Gorsel 3.59: Offset Plane olusturma

s : e Construct > Offset Plane seciniz ve XY diizlemine 25 mm

uzaklikta yeni bir dizlem olusturunuz. Bu diizlemde 50
mm genisliginde bir altigen giziniz.

e Create > Loft komutunu segip ilk gizdiginiz profilden
baslayarak sirasiyla profil cizimlerini seginiz.

Gorsel 3.60: Cizimlerin gériinimu
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@ LOFT

Profies

Profile 1
Profile 2
Profile 3

Profile 4

+

Guide Type

Rails

+

B
iy B connected
Vi
Vi
i B connected

&4

=

Chain Selection &)

Closed

a

Tangent Edges U |:|j

Operation

(T Mew Body -

oK Cancel

Profillerin secim sirasina dikkat edilmelidir. Secim sirasi farkli olursa istenilen nesne elde

. edilemeyecektir.

@ LOFT

Profiles

Profile 1 U:ﬂ E’ Connected

Profie2 (1
L]

Profile 3 1]

Profied M - £ connected -
+ x

Guide Type m Q-ﬁ

Rails 3

+

Chain Selection )

Closed w

Tangent Edges u E[ﬂ

Operation Eﬁ New Body v
[i] oK Cancel

Gorsel 3.62: Loft komutu ile nesne olusturma segim sirasi degisirse farkli bir nesne olusumu
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3.4.2. Profil Nesnelerinde Destek Elemani (Payanda) Olusturma

Dijital Uretim programinda gerekirse belirli yontemlerle nesnelerin (zerine destek elemanlari
olusturulabilir.

3.4.2.1. Rib (Nesneler Arasinda Diisey Tasiyici Olusturma)

Rib, nesneler Uzerinde gerekli olan yerlerde payanda (destek elemani) olusturmak igin kullantlir.

Payanda Sketch ortaminda cizilen bir gizgi, yay, egri ya da daire olabilir.

Uygulama: Masa Ayagi Payanda Olusturma

Masa ayagini gliclendirmek amach bir payanda olusturmak icin asagidaki yonergeleri uygulayiniz.

e XY diizlemini secerek kenar uzunlugu 300 mm olan bir kare giziniz. Sekli gizdikten sonra Finish Skecth
tiklayiniz.

e E kisayol tusuyla Extrude komutunu galistiriniz ve gizdiginiz sekle 40 mm kalinlik veriniz.

e Create > Cylinder seciniz ve tablanin orta noktasina 150 mm ¢apinda, 60 cm uzunlugunda silindir
olusturunuz.

e Construct > Midplane (Orta Diizlem) komutunu kullanarak iki ylzey ortasina yeni bir dizlem
olusturunuz.

@ MIDPLANE

0K Cancel

/
y
Select two planar faces, planes or a sketch profile

Gorsel 3.63: Midplane (orta diizlem) olusturma

e Olusturdugunuz orta diizleme L kisayol tusunu kullanarak tablanin dis ylizeyinden 20 mm uzaklikta
120° agiyla silindiri kesen bir yardimci dogru pargasi giziniz.

Gorsel 3.64: Payanda igin yardimci dogru pargasi ¢izimi
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Tablanin diger yliziine gelerek dis
ylzeyinden 20 mm uzakhkta 60°
acityla silindiri kesen bir yardimci

dogru pargasi ciziniz.

-8 Q- O-EH B

Gorsel 3.65: Payanda icin nesnenin diger yanina yardimci dogru pargasi ¢izimi

Create > Rib komutunu seginiz.

Curve olarak cizdiginiz yardimci © REB

dogruyu seginiz. Curve x

Thickness degerini 30 mm olarak Thickness Options 5 symmetric =

veriniz. Depth Options -+ To Next -
Thickness 30 mm -

Flip Direction &

oK Cancel

Gorsel 3.66: Rib komutu ile payanda olusturma
Ayni islemi diger yardimci ¢gizgi icin de gercgeklestiriniz.

OK tusuna basarak islemi tamamlayiniz. Calismanizi kaydediniz.

3.4.2.2. Web (Nesneler Arasinda Destek Elemani Olusturma)

Web, nesneler lGzerinde gerekli olan yerlerde destek elemani olusturmak igin kullanilir. Destek elemani

Sketch ortaminda cizilen bir ¢izgi, yay, egri ya da daire olabilir.

Cizgi izleyen araba tekerlegi olusturmak icin asagidaki yonergeleri uygulayiniz.
XY dizlemini segerek asagida 50 mm ¢apinda bir daire giziniz. Sekli ¢izdikten sonra Finish Skecth
tiklayiniz.
O kisayol tusu ile ¢izdiginiz daireyi 4 mm disa dogru ofsetleyiniz.
E kisayol tusu ile gizdiginiz sekle 30 mm kalinlik veriniz.
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@ EXTRUDE
Profile x
Start |+ Frofie Plane -
Direction h One Side hd
Extent H Distance r
Distance 30.00 mm -
Taper Angle 0.0 deg -
Operation Cﬁ' New Body b
o oK | Cancel
e

Gorsel 3.67: Extrude ile kalinlik verme

e XY dizleminde Sketch olusturunuz ve Line komutu ile merkezden daireye bir dogru parcasi ciziniz ve

Circular Pattern komutu ile 6 adet ¢ogaltiniz.

Click to select sketch paint or crcular arc.

@ CIRCULAR PATTERN
Objects [x 1 selected

Center Point (LSSt % |

Type D Full

Suppress @

Quantity 6

Li ] oK

Gorsel 3.68: Sketch ortaminda dogru pargasi ¢izimi ve ¢ogaltma

e Create > Web komutunu seginiz. e wee

Curve olarak ¢izdiginiz dogru  cure
parcalarini seciniz. Depth Options = Thickness Options [ symmetric =

olarak Depth seciniz. Thickness = Deptn Options k-l Deptn ¥
degeri olarak 2 mm, Depth degeri  Thickness 2.00 mm v
olarak 15 mm giriniz. Depth 15 -
Flip Direction =
- Extend Curves (%)
Li ] oK Cancel |

Gorsel 3.69: Web komutu ile destek elemanlarini olusturma
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e Create > Hole komutunu seginiz. Origin noktasinda bir |o o.c

delik olusturunuz. Delik capi olarak 2 mm giriniz ve uzun- | pacement

luk olarak All seginiz. Face h 1 selected Y
e OKtusuna basarak islemi tamamlayiniz. Calismanizi kay- | Refersnce Select

dediniz. Reference Select

* Shape Settings

Extents o Al v &
Hole Type z I
Hole Tap Type m ﬂ E ﬁ
Drill Point ]
(A -
S | 118.0 deg -
|4—b| 2 mm 4

P Objects To Cut

(i ] oK Cancel

Gorsel 3.70: Hole komutu ile delik agma

3.4.3. Profil Nesnelerini Cogaltma

Dijital Gretim programinda istenilen nesneler ve 6zellikler belirli ydntemlerle ¢ogaltilabilir.

3.4.3.1. Govdeleri Tagima / Kopyalama / Déndiirme

Cizim alanindaki nesnelerin konumlarini degistirmek icin kullanilir. Modeller tasinir, kopyalanir,

dondurilir ya da diger modellerle iliskilendirilir.

Uygulama: Cizilen Bir Nesnenin Tagsinmasi / Kopyalanmasi

Belirlenen nesneyi tasima ve kopyalama islemlerini yapmak icin asagidaki yonergeleri uygulayiniz.
e Box komutu ile bir kutu, Cylinder komutu ile bir silindir olusturunuz.
e Modify > Move / Copy komutunu seginiz.
e Silindirik parcayi seciniz. Fare yardimiyla ya da XYZ eksenlerinden tasimak istediginiz mesafeyi giriniz

ve kutunun yanina taslyiniz.
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Move Object Ej Faces -

/@,' Selection k 1selected [

@ MOVE/COPY

(IP s Move Type . }" C u'(u .I:o"HE|

Set Pivet L+

e X Distance 55.00 mm -
Y Distance 0.00 mm hd
Z Distance 0.00 mm >
X Angle 0.0 deg >
% Angle 0.0 deg =
Z Angle 0.0 deg =
[i] oK Cancel

Gorsel 3.71: Move / Copy komutuyla tasima islemi

e ki parcanin belirlenen noktalardan birlestirilmesi icin Move diyalog kutusundan Move Type olarak
Point to Point komutunu seginiz.
e Origin Point icin silindirin orta noktasini seginiz.

e Target Point icin kutu ylizeyinin orta noktasini seginiz.

@ MOVE/COPY

Move Object ﬂ Faces b
St Selection [s1selected X
/.//' Move Type B L C . J‘IF

| Origin Point [ 1selected X

A Target Point k1 selected
~

» (i ] oK Cancel

. |Select second point =

Gérsel 3.72: Move / Copy komutuyla Point to Point tasima islemi

e Kopyalama islemi yapmak icin Move Object olarak Bodies seciniz. Kopyalanacak gévde nesnesini
seginiz.

e Diyalog kutusundan Create Copy isaretleyiniz.

e Govde nesnesinin kopyalanacagi mesafeyi giriniz ya da fare yardimiyla gévdeyi istenilen yere siiriikleyip

birakiniz.

Kopyalama islemi i¢in kopyalanacak parga secildikten sonra Create Copy isaretlenmelidir

—————

yoksa tasima islemi yapilmis olur.
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@ MOVEICOPY

Move Object (] Bodies... -

Selection x
Move Type . Al e n.(“ }‘.J" " B
Set Pivat | i o @

X Distance 0.00 mm - T

Y Distance 0.00 mm - e

Z Distance 0.00 mm - s -~

X Angle 0.0 deg - e

¥ Angle 0.0 deg 4 :

ZAngle 0.0 deg -

Create Copy @

[i ] Cancel

@ MOVE/COPY

Move Object ] Bodies... -

x
Move Type . AES g R
L >

Set Pivot -
X Distance 0.00 mm . o

W Distance 0.00 mm -

Z Distance 50.00 mm -

X Angle 0.0 deg v

" Angle 0.0 deg -

ZAngle 0.0 deg -

7

[i] OK Cancel

s L4 Select bodies to e 5000mm| |~ [

Gérsel 3.73: Move / Copy komutuyla Point to Point kopyalama islemi

3.4.3.2. Rectangular Pattern (Dogrusal veya Dikdértgensel Cogaltma)

Rectangular Pattern; nesneleri, ylizeyleri ya da kati gbvdeleri dogrusal olarak belirlenen mesafede ve
sayida cogaltmak icin kullanilir. Tek yénde islem yapilirsa dogrusal cogaltma yapar. ikinci yén segilir ve iki

yonde islem yapilirsa dikdortgensel cogaltma yapar.
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Uygulama: Cizilen Bir Nesnenin Dogrusal Olarak Cogaltilmasi

Gizilen bir nesnenin dogrusal © FECTANGULAR PATTERN
olarak ¢ogaltiimasi icin asagidaki patemype | () Bodies -
yonergeleri uygulayiniz. s I 1sslected | X
e Daha o6nce cizdiginiz cizgi iz-
Directions x
leyen araba tekerlegi mode-
L. Distance Type  hgh Extent b
lini aginiz.
Suppress @
e Pattern > Rectangular Pat-
.. i 3 o
tern komutunu seciniz. Dumoiy '
e Rectangular Pattern diyalog e 0.0l e o
kutusundan Objects olarak Direction Type [y One Direction -
tekerlegi seciniz. Quantity 3 =
e Directions olarak X eksenini Ditance 0.00 mm e
seciniz. Direction Type h One Direction -
e Quantity olarak her iki yon
L] [ ok | [ cancel

icin de 3 degerini giriniz.
Gorsel 3.74: Rectangular Pattern diyalog kutusu

© RECTANGULAR PATTERN
Pattern Type D Bodies
Objects [y 1selected X

Directions k1 selected [

Distance Type 4 Extent

Suppress a
Quantity 3
Distance 130.00 mm

Direction Type @ One Direction
Quantity 3
Distance 145.00 mm

Direction Type h One Direction

° ok ] [Ganeal|

=

Gorsel 3.75: Rectangular Pattern komutu ile ¢ogaltma islemi

e OK tusuna tiklayiniz ve islemi tamamlayiniz.
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15,8 mm genisliginde, 31,8 mm uzunlugunda, 9,6 mm
yuksekliginde, Uzerinde 8 tane 5 mm c¢apinda silindir
olan parcayi tasarlayiniz .

3.4.3.3. Circular Pattern (Dairesel Cogaltma)

Circular Pattern; nesneleri, ylizeyleri ya da nesne gévdelerini bir eksen etrafinda déndirerek belirlenen
acida dairesel olarak ¢ogaltma igin kullanilir. Dondiirme ekseni olarak parganin eksen gizgisi veya dairesel
parcanin kenar cizgisi secilebilir.

Uygulama: Cizilen Bir Nesnenin Dairesel Olarak Cogaltiimasi

Cizilen bir nesnenin dairesel olarak cogaltil-

. . o P . @ EDIT FEATURE
masi icin asagidaki yonergeleri uygulayiniz.

. o . 3 Placement
e 50 mm gapinda, 20 mm yiksekliginde bir si-
. . .. Length 5.00 mm -
lindir ¢iziniz.
Width 5.00 mm -
e (Cizdiginiz silindirin Gstline kenar uzunlugu 5
X . L Height 5.00 mm -
mm olan bir kiip ¢giziniz ve Operations olarak
Operation Eﬁ' Mew Body -
New Body seciniz.

[i] 0K Cancel

Gorsel 3.76: Box komutu ile olusturulan silindir (izerine kutu ekleme
e Pattern > Circular Pattern komutunu e,

seciniz. Objects olarak ¢izdiginiz kiipd ;. 0. () Bodes <

seciniz. Objects [s1selectsd X

e Axis olarak silindirin dairesel ylizey ¢iz- . -

gisini seciniz ve Quantity olarak 4 de- . ™) Ful -

gerini giriniz. Suppress (@)
Quantity ‘ﬂ
i ] oK Cancel

Gorsel 3.77: Circular Pattern komutu

Eksen cizmeden ¢ogaltma yapilmak istenirse parcanin dis silindirik ylizeyi ya da kenar
cizgisi segilebilir.

3.4.3.4. Pattern on Path (Yol Uzerinde Cogaltma)

Bu yontem ile bir unsur, ylizey ya da nesnenin gizilen bir egri yol boyunca belirlenen sayida ¢cogaltiimasi
saglanir. Cizilecek yol, tek parca olmalidir.
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Uygulama: Cizilen Bir Nesnenin Yol Boyunca Cogaltilmasi

Cizilen bir nesnenin yol boyunca g¢ogaltiimasi L

icin asagidaki yonergeleri uygulayiniz.

e Dairesel Cogaltma konusunda gizdiginiz silin-

05|
<
004
0S4
=

dirik parcanin XY diizleminde bir Sketch aciniz.

/
e Spline komutu ile sekildeki gibi rastgele egri- /
/
sel bir yol ¢iziniz. /
e Finish Sketch tiklayiniz. //
/

@ PATTERN ON PaTH  [Select faces or features to pattern |

Gorsel 3.78: Spline komutu ile egrisel yol gizimi

R W . o Pattern > Pattern on Path komutunu seginiz.
iy % 1 sclected g . Objects olarak silindirik basit modeli seginiz.

it K et . Path olarak cizdiginiz egri yolu seginiz.

o i @ o Quantity olarak 5 degerini giriniz. Fare yardimiyla
Distance Type g Extent x cizdiginiz yolu tarayiniz veya belirlenen Distance
Direction h One Direction A deéerini giriniz.

Orientation Hq Identical v

0 (5] [Ganee |

Gorsel 3.79: Pattern on Path komutu

@ EDT FEATURE

/ Pattern Type O Bodies -

/ Objects [; sselected X
/ < Path R 1 selected [P

Suppress

Cuantity 5 i

Distance 50.805 mm -

Start Point 0.00 -

Distance Type ﬁn Extent v
/ Direction h One Direction r

Orientation H-| ldentical r

o oK | [cancel |

90905 mm | v My Dy~

Gorsel 3.80: Pattern on Path komutuyla Distance ayari
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3.4.3.5. Mirror (Profil Nesnelerini Aynalama)

Mirror, nesnelerin ya da ylizeylerin bir eksen ile simetrigini alma islemi i¢in kullanilir. Simetri ekseni
olarak diizlemler veya nesnelerin yizeyleri alinabilir.

Uygulama: Cizilen Bir Nesnenin Aynalanmasi

Cizilen bir nesnenin aynalanmasi igin agsagidaki yonergeleri uygulayiniz.

e XY dizleminde Length 55 mm, Width 40 mm ve Height 15 mm olacak sekilde bir dikdortgen prizma
Giziniz.

e Dikdortgen prizma Ust ylizeyinde bir Sketch olusturunuz ve
Text komutunu kullanarak MEB yaziniz.

e E kisayol tusunu kullanarak yaziya 10 mm kalinhk veriniz.

e Create > Mirror komutunu seginiz.

e Objects olarak olusturdugunuz nesneyi seginiz.

e Mirror Plane olarak XY dizlemini seginiz.

e OKtusuna basarak islemi tamamlayiniz. Calismanizi kaydediniz.

Gorsel 3.81: Nesnenin aynalanmis hali

3.5. Komut Yardimiyla Nesneleri Diizenleme

Dijital Giretim programinda olusturulan nesneler, komutlar yardimiyla diizenlenebilir.

3.5.1. Nesneden Bagka Bir Nesne Cikarma

Dijital Giretim programinda gizilen nesneler, birbirinden gikarilarak yeni nesneler olusturulabilir.

3.5.1.1. Dondiirerek Katilari Birbirinden Cikarma

Kullanilan yéntemler ve parametreler Revolve komutu ile aynidir. Diyalog kutusundan Operation
boliminde Cut segimi yapilip keserek gikarma islemi gergeklestirilir. Komutun aktif olabilmesi igin ¢izim
alaninda bir nesnenin bulunmasi gerekir.

Uygulama: Vida Bagsi Olusturma

Vida basi olusturmak icin asagidaki yonergeleri uygulayiniz.

e XZduzleminde 30 mm yarigcapinda bir altigen ciziniz.

e E kisayol tusu ile altigene 20 mm kalinlik veriniz.

e Sketch ortaminda XY dizleminde Line komutu ile
olusturdugunuz nesnenin bir kdsesini 2 mm kesen Ug¢gen giziniz.
Finish Sketch tiklayiniz.

Gorsel 3.82: Ucgen cizimi
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e Create > Revolve komutunu seciniz. Ekrana gelen diyalog
kutusundan Profil olarak ¢izdiginiz licgeni seginiz.

e Axis olarak X eksenini seciniz.

e Angle olarak 360° giriniz.

e Operation olarak Cut islemini seginiz.

e OK tusuna tiklayarak islemi tamamlayiniz. Calismanizi
kaydediniz.

Gorsel 3.83: Cikarma / kesme islemi sonrasi vida basi

3.5.1.2. Yol Kullanarak Nesneleri Birbirinden Cikarma

Komutun kullanimi ve gizim mantigi Sweep komutu ile aynidir. Operation boliminde Cut segimi
yapilip keserek ¢ikarma islemi gerceklestirilir. Komutun aktif olabilmesi icin ¢izim alaninda bir nesnenin
bulunmasi gerekir.

Uygulama: Yol Kullanarak Nesneleri Birbirinden Cikarma
Yol kullanarak nesneleri birbirinden ikarma islemiyle sehpa tablasi olusturmak igin asagidaki yoner-

geleri uygulayiniz. g

e Sketch ortaminda XY diizlemine 50 cm kenar uzunlugunda s
bir kare giziniz.

e Finish Sketch tiklayiniz.

e E kisayol tusu ile ¢izdiginiz kareye 36 mm kalinlik veriniz.

e Sketch ortaminda XY dizleminde olusturdugunuz nesne-
nin kose noktasini merkez alarak 15 mm capinda bir daire
Giziniz.

e Finish Sketch tiklayiniz.

Gorsel 3.84: Daire ¢izimi

e Create > Sweep komutunu seginiz.

e Diyalog kutusundan Profile olarak gizdiginiz daireyi seginiz.
e Path olarak ilk gizdiginiz karenin kenarini seginiz.

e Distance olarak 1 degerini giriniz.

e Operation olarak Cut seginiz.

Gorsel 3.85: Kenarlari ¢ikarilmis sehpa tablasi
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3.5.1.3. Profiller ve Yiizeyler Arasinda Cikarma

Loft komutu, farkli diizlemlerde ve taslaklarda gizilmis profiller arasinda ¢ikarma islemi yaparak nesne
olusturur.

Uygulama: Profiller ve Yiizeyler Arasinda Cikarma

Profiller ve ylzeyler arasinda nesneleri birbirinden c¢ikararak sehpa ayagi olusturmak icin asagidaki
yonergeleri uygulayiniz.

e XY dizleminde 300 mm yarigapinda uzunlugunda bir altigen ciziniz.

400,00
o
=]
| \
=
. /—\ gﬂ
'y

000#

Gorsel 3.86: Cizimlerin yukaridan ve yandan gériiniisii

e O kisayol tusunu kullanarak ¢izdiginiz altigeni 50 mm iceri dogru ofsetleyiniz. Finish Sketch tiklayiniz.

e Construct > Offset Plane seciniz ve XY diizlemine 300 mm uzakhkta yeni bir diizlem olusturunuz. Bu
diizlemde 300 mm ¢apinda bir daire giziniz.

e O kisayol tusunu kullanarak ¢izdiginiz daireyi 50 mm iceri dogru ofsetleyiniz. Finish Sketch tiklayiniz.

e Construct > Offset Plane seginiz ve (st diizleme 300 mm uzaklikta yeni bir diizlem daha olusturunuz.

e Yeni diizlem Uzerine bir Sketch ac¢iniz ve 400 mm kenar uzunlugunda bir kare giziniz.

e O kisayol tusunu kullanarak ¢izdiginiz kareyi 40 mm iceri dogru
ofsetleyiniz. Finish Sketch tiklayiniz.

e Create > Loft komutunu galistiriniz ve ilk ¢izdiginizden baslayarak
dis profilleri sirasiyla seginiz.

e Bodyl gérinimuni kapatiniz.

e Create>Loft komutunucalistirinizve ofsetleyerek olusturdugunuz

ic profilleri ilk cizdiginizden baslayip sirasiyla seginiz.

Gorsel 3.87: Nesnenin olusturulmasi
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Profiles

Profile 1 [J:ﬂ B:) Connected

Profie2 [}

profies (I ~ G Cconnected ~
+ X

Guide Type @ ﬂ-ﬁ

Rails [

+

Chain Selection )

Closed (]

Tangent Edges n |:|:ﬂ
b : Operation Cut -
: S 5 &

>

¥ Objects To Cut
Gorsel 3.88: Loft komutu ile nesnenin ¢ikarilmasi

e Operation olarak Cut seginiz.

e Bodyl gérinimini aginiz.

Profiles

Profile 1 iy B connected

Profiez

Profies (I - G2 Connected -
+ X

Guide Type @ Q-g

Rails 13

+

Chain Selection )

Closed (W]
Tangent Edges u |:|:H
Operation E Cut -

P Objects To Cut

Gorsel 3.89: Loft komutu ile nesnenin ¢ikarilmasi

e OK tusuna tiklayarak islemi tamamlayiniz.

Gorsel 3.90: Cikarma islemi sonrasi nesnenin (stten gérinimd
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3.5.1.4. Silindirik Yiizeylere Dis Agma

Silindirik ylizeylere dis agma iki bicimde gergeklestirilebilir.

Birinci yontem, Threat komutuyla silindirik ylzeylere dis agmadir. Threat komutu, var olan standartlara

gore silindirik ylzeylere dis acilmasini saglar.

Uygulama: Threat Komutuyla Dis Agma

Threat komutuyla nesnenin ylizeyine
belirlenen uzunlukta dis agarak civata
yapmak icin asagidaki yonergeleri
uygulayiniz.

e Revolve komutu ile daha &nce
olusturdugunuz vida bashgi nesnesini
aciniz.

e Create > Cylinder komutu ile vidanin
arka ytiztine bir silindir olusturunuz.

e Oparetion olarak Join seginiz.

@ CYLINDER
Placement x
Diameter 45.00 mm -
Height a0 -
Operation . Join v
i ]

Gorsel 3.91: Vida basligina silindirin eklenmesi

e Modify > Fillet komutunu seginiz. | erer "

e Silindirin baslangi¢ ve vida basi ile
birlestigi ylzeyleri 2 mm yuvarlama
yapiniz.

e Create > Threat komutunu seginiz.

e Faces olarak silindir nesnesini
seginiz.

e Modeled secimini yapip dislerin
fiziksel olarak acgilmasini saglayiniz.

e Full Length secimi ile silindirin
tamamina dis agilmasini saglayiniz.

e Full Length secimini kaldiriniz.
Baslangi¢ noktasi icin Offset olarak
0 mm, dis uzunlugu belirlemek igin
Length degeri olarak 50 mm giriniz.

istenirse farkl bir capa goére
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Disin anma Olgisl, secilen ylzeyi olusturan ¢apa gore otomatik olarak belirlenecektir.

Type Y Fillet -
1 Feature, 1 Edge Y 2mm v [P Tangent(G1) ~
+ X

Radius Type D Constant Radius -

Edges/Faces/Features

@

Tangent Chain

Corner Type @ Rolling Ball

Gorsel 3.92: Silindirin baslangig ve birlesim ytizeylerinin yuvarlanmasi

dis profilinde vida da acilabilir.
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© THREAD
Modeled &)
Fullen.. @
Dffset 0.00 mm v
Length 50.00 mm v
Thread ... 150 Metric profile - ) / /)/) RN ;
Size 450 mm = /)/)QQQO{:)
Designa... M45xd.5 A / ///////;r I’}
=)

Class 6g -
Direction  Right hand A
Rememt... J

(i ] OK Cancel

K\\\\\l i

Gorsel 3.93: Belirlenen uzunlukta dis agilmasi

e OK tusuna tiklayarak islemi tamamlayiniz. Calismanizi kaydediniz.

ikinci yontem ise Coil komutuyla silindirik yiizeylere dis agmadir. Mevcut standartlarin disinda bir
oOlcliyle vida acilacagl zaman Coil komutu kullanilabilir. Komutun kullanilabilmesi icin c¢izim alaninda dis
acilacak nesnenin bulunmasi gerekir.

Uygulama: Coil Komutuyla Dis Acma

Coil komutuyla nesne ylizeyine belirlenen uzunlukta dis agarak civata yapmak icin asagidaki yonergeleri
uygulayiniz.
e Threat komutu ile daha 6nce olusturdugunuz civata nesnesini acginiz.
e Timeline bélimiinden Threat komutunun dncesine geliniz.
e Create > Coil komutunu seginiz.
e Cizim duzlemi olarak civatanin dairesel ylizeyini seginiz.

e Cizim merkez noktasi ile silindirin merkez noktasini eslestiriniz ve yay olusturunuz.

@ COoL

Profile x

Type Revolution and Height ~

Rotation O

Diameter 43.00 mm -

Rewvolutions 3 A

Height 45.375 mm -

Angle 0.0 deg -

Section . Circular b

Section Position * On Center v

Section Size 10.75 mm -
] Operation E Cut -

P Objects To Cut

) OK | [ Cancel |

Gorsel 3.94: Coil komutuyla yay olusturma
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e Coil diyalog kutusundan Diameter degerini 43 mm, Height degerini -55 mm, Section Size degerini 2
mm olarak giriniz.

e Coil diyalog kutusundan Revolutions degerini 15 mm giriniz. Section olarak Triangular (Internal)

seginiz.
@ ColLL

Profile x

Type Revolution and Height ~
Rotation l::]

Diameter 43.00 mm -
Revolutions 15 -
Height -55 mm -
Angle 0.0 deg v
Section E-‘ Triangular ({Internal) =
Section Position * On Center hi
Section Size 2 mm -
Operation ﬂ Cut L

4300 mm | -
P Objects To Cut

[ ] oK Cancel

Gorsel 3.95: Dis tipi ve dis tur degerinin ayarlanmasi

e Operation olarak Cut seginiz.
e OKtusuna tiklayarak islemi tamamlayiniz. Calismanizi kaydediniz.

Coilile dis agilirken gizilecek yayin ¢capi dis agilacak ylizeyden ¢ok kiiglik olursa parganin
ylzeyine degil icine dis acilir.

3.5.2. Chamfer (Nesnelerde Pah Kirdirmak)

Chamfer, nesnelerin kenar ya da koselerine farkl sekilde pahlar kirmak icin kullanilir.

Uygulama: Pah Kirma

Pah kirdirarak nesnenin kenarlarini dizletmek icin asagi-
daki yonergeleri uygulayiniz.
e XY dizleminde Length 90 mm, Width 60 mm, Height 20
mm olacak sekilde bir kutu olusturunuz.
e Olusturdugunuz kutunun Ust ylzeyine Length 40 mm, D
Width 25 mm, Height 10 mm olacak sekilde bir kutu

daha olusturunuz.

Gorsel 3.96: Box komutu ile ikinci nesnenin olusturulmasi

136 3. OGRENME BIRIMi



Modify > Chamfer komutunu seginiz.
Edges (Kenar) olarak blylk kutunun
uzun kenarini seginiz.

Chamfer Type olarak Equal Distance
(Esit Uzakhk) seciniz. Distance degeri

olarak 3 mm giriniz.

Chamfer komutunu seginiz. © ="

Edges

Edges olarak kii¢ik kutunun

Tangent Chain
uzun kenarini seginiz. S
Chamfer Type olarak Two
Distance (ikili Uzaklik) seci-

niz. X ekseni Distance degeri @

Distance

Distance

olarak 15 mm, Y ekseni Dis-
tance degeri olarak da 5 mm

giriniz.

DIJITAL URETIM

© CHAMFER

k1 selected [

Tangent Chain @

Edges
Chamfer Type Vﬂ Equal distance -

Distance 3 mm -

[i] oK Cancel

Specify distance, or hold Ctrl/CMD to modify selections

Gorsel 3.97: Chamfer komutu ile Equal Distance (Esit Uzaklik) pah kirma

& 1 selected Y e
@ e S
*ﬂ Two distances i

19| -

5.00 mm b

OK Cancel

Gorsel 3.98: Chamfer komutu ile Two Distance (ikili Uzaklik) pah kirma

Modify > Chamfer komutunu seginiz.
Edges olarak blylk e caaires

kutu ile kiiglik kutunun

Tangent Chain @

birlestigi kisa kenari

Chamfer Type

Distance 5.00 mm

seginiz.

Angle 65.0 deg

Chamfer Type olarak
Distance and Angle = =
(Uzakhk ve Agl) seginiz.

Distance degeri olarak

5 mm, Angle degeri

olarak 65° giriniz. :

OK tusuna tiklayarak
islemi  tamamlayiniz.

Calismanizi kaydediniz.

VJ Distance and angle ~

Edges k1 selected B P

-

-

Gorsel 3.99: Chamfer komutu ile Distance and Angle (Uzaklik ve A¢i) pah kirma
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3.5.3. Diizenleme Komutlariyla Nesneler Olusturma

Dijital Giretim programinda diizenleme komutlari araciligiyla nesneler olusturulabilir.

3.5.3.1. Fillet (Nesnelerde Yuvarlatma)

Fillet; nesnelerin kenarlarini, kdselerini, kenarlar veya yuzeyler arasini yuvarlatmak igin kullanihr.

Uygulama: Nesnelerde Yuvarlatma

Nesnelerin kenarlarini yuvarlatmak igin asagidaki yonergeleri uygulayiniz.
e Pah kirdirmada olusturdugunuz nesneyi aginiz.
e Modify > Fillet komutunu seginiz.
e Edges olarak biyiik kutunun Ug¢ kenarini seginiz.

@ FILLET

Type [ Fillet -
3Edges % 000mm * [P Tangent(ct) ~
+ %

. Radius Type D Constant Radius -

Edges/Faces/Features

Tangent Chain %]

Corner Type @ Roliing Ball -

[i ] Cancel

Select edges, faces, or features

Gorsel 3.100: Fillet komutu ile kenarlarin segimi

e Radius Type olarak Constant Radius seginiz.
e Yuvarlatma yarigapi olarak 4 mm giriniz.

e OK tusuna tiklayarak islemi tamamlayiniz.

@ FILLET

Type D Fillet -
3 Edges [ 2mm * B Tangent (G1) =
+ X

Radius Type D Constant Radius -

Edges/Faces/Features [LSE=w

Tangent Chain B
Corner Type @ Roling Ball -
[i] oK Cancel

Gorsel 3.101: Fillet komutu ile sabit yarigapli yuvarlatma

e Modify > Fillet komutunu seciniz. Edges olarak kiiclik kutunun g kenarini seginiz.
e Radius Type olarak Chord Length seciniz. Uzunluk olarak 4 mm giriniz.
e OK tusuna tiklayarak islemi tamamlayiniz.
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Gorsel 3.102: Fillet komutu ile sabit

e F kisayol tusu ile Fillet komutunu aginiz.
e Edges olarak biyik kutunun arka uzun kenarini seginiz
L]

Radius Type olarak Variable Radius seciniz.

e

Gorsel 3.103: Fillet komutu ile sabit

e Fare yardimiyla ikinci yuvarlatma noktasini belirleyiniz.

DIJITAL URETIM

@ FILLET
Type D Fillet -4
3Edges 4 mm + [P Tangent (81} ~
+ %
Radius Type Chord Length v
Edges/Faces/Features LSt

Tangent Chain

Corner Type @ Setback -
(i ] 0K Cancel
uzunlukla yuvarlatma
Type [V Fillet -
1Edge [F) Variable B Tangent (G1) =
+ %
Radius Type B Mariable Radius %
Tangent Chain )
¥ Radius Points
Start 0.00 mm 0.00
End 0.00 mm v 1.00
+
Corner Type '-"j Setback -
Li]

Cancel

uzunlukla yuvarlatma

© FILLET
Type [ Fillet -
1 Edge [® wvariable £ Tangent (61) ~
+ %
Radius Type @ Variable Radius -
Tangent Chain  [&)

Start
Point 1
End

+ x

Corner Type

e
Gorsel 3.104: jkinci yuvarlatma

¥ Radius Points

0.00 mm 0.00
0.00 mm * (0435 -
0.00 mm 100

Setback
Cancel

noktasi belirleme
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e Fillet diyalog kutusu Radius Points (Yaricap Noktalari) béliminden Start degerini 2 mm, Point 1
degerini 10 mm, End degerini 0 mm olarak giriniz.

e OK tusuna tiklayarak islemi tamamlayiniz. Calismanizi kaydediniz.

@ FILLET

Type D Fillet hd

1 Edge (3 variable B Tangent (61)

+ X

Radius Type @ Variable Radius hd

Tangent Chain @

¥ Radius Points

10.00mm |~ 0435 |+

Start 2.00 mm 0.00
Point 1 10.00 mm (0435 -

End 0.00 mm 1.00

+ x

ComerType  [Fj Setback -

(i ] 0K Cancal
Gorsel 3.105: Degisken yaricapli yuvarlatma

Silindir basli, altigen alyan anahtar oyuklu, uzunlugu
70 mm, dis uzunlugu 35 mm, vida adimi, M25x1,5 olan
civatayi olusturunuz.

3.5.3.2. Draft (Yiizeylere Egim Verme)

Draft, nesne Uzerinde secilen bir veya birden fazla yiizeye istenilen acida egim vermek icin kullanilir.

Uygulama: Nesnelerin Yiizeylerine Egim Verme

Nesnelerin ylzeylerine egim vermek icin asagidaki yonergeleri uygulayiniz.
e Box komutu ile XY diizleminde

_® DRAFT
Length 150 mm, Width 55 mm, < w—
Height 5 mm olacak sekilde bir 5 x
kutu olusturunuz. ; Tangent Chain @

e Nesnenin (st ylzeyinde bir FipDirection 2%

Sketch olusturunuz. Text ko- Angle 30.0 deg -
mutu ile M E B yaziniz. Height & Direction Yy One sice v
(i ] oK Cancel

degerini 50, Angle degerini
-180° giriniz.

e E kisayol tusunu kullanarak ya-
ziniza 10 mm kalinlik veriniz.

Gorsel 3.106: Yiizeylere egim verilmesi
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e Modify > Draft komutunu seginiz. | @ errEaTRe

Plane [}1 selected X

Faces & 7 selected B4

Tangent Chain @

e Plane olarak “M” harfinin st ylze-

yini seginiz.

e Faces olarak “M” harfinin yan ylize-

Fip Direction &
. . « . Angh 30.0 de: -

yini seginiz. e :

Direction By one side -

e Angle olarak 30° giriniz.

[ oK Cancel
e OK tusuna tiklayarak islemi tamam-
layiniz.
e Draft komutunu seciniz. Plane ola-
rak “M” harfinin Ust ylizeyini seginiz.
e Faces olarak Ctrl tusuyla birlikte
egim vermek istediginiz ylzeyleri se-
ciniz. Gorsel 3.107: Yiizeylere egim verilmesi

e Angle olarak 30° giriniz.

3.5.3.3. Shell (Nesnelere Et Kalinhgi Verme)

Shell, nesneleri belirli bir et kalinligina bagh kabuk model haline getirmek icin kullanilir.

Uygulama: Nesnelere Et Kalinhgi Verme

Nesnelere et kalinligi vermek icin asagidaki yonergeleri uygulayiniz.

e Bir onceki uygulamada yazdiginiz MEB

@ SHELL

Faces/Body k 3selectsd B

yazisini aginiz.

. .. Tangent Chain [%]
e Modify > Shell komutunu seginiz. i SE et :
e Faces / Body olarak MEB harflerinin irecton o ousge -

(i ] Cancel

hepsini seginiz.

e Direction olarak Outside seciniz. Out-
side Thickness degerini 1 mm giriniz.

e OKtusuna tiklayarak islemi tamamlayi-

niz. Calismanizi kaydediniz.

Gorsel 3.108: Et kalinligi verilecek yiizey segcimi

Gorsel 3.109: Et kalinhdi verilen yiizey
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3.5.3.4. Split (Nesneleri Pargalara Ayirma)

Split, bir nesneyi lizerine ¢izilmis ¢izgiler yardimiyla bélerek pargalara ayirmak igin kullanilir. Cizgilerin
uzantisi nesneyi kesebilecek sekilde olmalidir. islem sonunda iki ayri gévde olusur.

Uygulama: Nesneleri Pargalara Ayirma

Nesneleri pargalara ayirmak icin asagidaki yonergeleri uygulayiniz.

e XZ dizlemine bir silindir giziniz.

~
o

e Sketch ortaminda XY dizlemine bir Spline ciziniz.

e Modify > Split komutunu seginiz.

e Bolinecek nesne (Body to Split) olarak olusturdugu-
nuz silindiri seginiz.

e Bolme araci (Spliting Tool) olarak cizdiginiz Spline seci-

niz.
3 g R
@ SPLITBODY Gorsel 3.110: Silindir tizerine spline ¢cizme
Body to Spiit X
Splitting Tool(z) X _
Extend Splitting Tooli=) &) =
e ok | [ cancel |

Gorsel 3.111: Split komutu ayarlari ve nesneyi bélme

3.5.3.5. Combine (Birlestir)

Combine, ayni calisma ortaminda bulunan farkh nesnelerin birlestirilmesinde, cikarilmasinda veya
kesisimlerinin alinmasinda kullanilir. Komutun uygulanabilmesi icin ayni ¢alisma sayfasinda birden fazla

nesne bulunmahdir.

Uygulama: Nesneleri Birlestirme

Nesneleri birlestirmek icin asagidaki yonergeleri uygulayiniz.
e Splitile iki parcaya ayirdiginiz nesneyi aginiz.
e Modify > Combine komutunu seciniz. Target Body olarak alttaki blylk nesneyi seginiz.
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«4 BROWSER @
=
4 o [EETTR@
[ -ﬁ Decument Settings
[ | Namt;:IViews
[» @ @l Origin
4d ©® Bl Bodies
®
Lol @ Body2
[ ©® B8 Sketches

Select bodies to combine with target bod

@ COMBIME
Target Body [ 1selected X
Tool Bodies
Operation . Join -

New Component  [J

Keep Tools D

i ] [ O | | Cancel |

Gorsel 3.112: Combine birlestirilecek nesne segme

e Tool Bodies olarak Ustteki bliylik nesneyi seginiz.

. . .. <4 BROWSER @
e Operations olarak Join seginiz. 4 o (TEE@
e OK tusuna tiklayarak birlestirme islemini tamamlayiniz. b 4 ioomeiiconce:
[ Bl Named Views
e Bu islemden sonra unsur agacindaki Bodies menisiin- D © @@ on
. . . v P 4 o @ ies
de nesnelerin birleserek tek bir Body oldugu gorliir. — Dﬂmﬂm
[> © Bl Sketches

Gorsel 3.113: Birlestirilmis nesne

3.5.3.6. Press Pull (Yiizey Oteleme)

Press Pull, nesnelerin secilen ylizeylerini belirli bir miktar 6telemek ve tasimak icin kullanihr.

Uygulama: Yiizeyleri Oteleme

Ylzeyleri 6teleme islemi icin asagidaki yonergeleri uygulayiniz.
e Daha 6nce olusturdugunuz MEB yazi uygulamanizi aginiz.
e Modify > Press Pull komutunu seginiz.
e Selection olarak yazinin Ust ylzeyini seginiz.
e Distance degeri olarak 15 mm giriniz.
o Offset Type kisminda Automatic isaretleyip segilen yiizeyi toplam 15 mm 6&teleyiniz.
e Qkisayolu ile tekrar Press Pull komutunu aginiz, ayni ylizeyi seginiz.
e Distance degeri olarak 15 mm giriniz.

3. OGRENME BIRIMi W43



o Offset Type kisminda New Offset isaretleyip secilen ylizeyi 15 mm 6teleyerek toplamda 30 mm kalinhk

elde ediniz.
—

@ OFFSET FACE

Faces k1 zelected 4

Offzet Tvpe New Offzet T

Distance 15 mm -

15 -

Gorsel 3.114: Secilen ylizeyi 6teleme

3.5.4. Align (Nesnelerin Hizalanmasi)

Align, nesnelerin segilen ylizeylerini ve noktalarini birbirlerine gore hizalamak igin kullanihr.

Uygulama: Yiizeyleri veya Noktalar Hizalama

Yizeyleri veya noktalari hizalamak igin asagidaki yonergeleri uygulayiniz.
e XZ dizleminde uzunlugu 60 mm, genisligi 40 mm, yik- e /
sekligi 10 mm olacak sekilde bir kutu ve 35 mm ¢apinda otect (3] Bodies 2
50 mm yuksekliginde bir silindir olusturunuz. From
e Modify > Align komutunu segciniz. From olarak kutunun

. . .. .. [i ] Cancel
st ylizeyinin orta noktasini seciniz.

e To olarak silindirin Ust tablasinin orta noktasini seginiz.

Angle tiklayarak kutunun yonini degistiriniz.

© ALGH /

Object (] Bodies... -

&
To [ 1 selected %
- @2 Gorsel 3.115: Align komutu ile noktalari segme
Angle -.‘ﬂ>
P R T e Ctrl+Z kisayol tusu ile yaptiginiz hizalama islemini geri

aliniz.
e Modify > Align komutunu seginiz.

e From olarak kutunun st ylizeyini seginiz.

Gorsel 3.116: Nesneleri hizalama
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e To olarak silindirin Ust ylzeyini seginiz.

© ALGN (24
Obiect (1) Bodies... -
From [} 1 selected X

To

[i] Cancel

@ ALIGN
Object 1) Bodies... -
I From k 1selected S
el
To [s1selected X
Flip S
Select target geometry or snap point
Rt [i ] 0K Cancel

Gorsel 3.117: Align komutuyla yiizeyleri secme

Gorsel 3.118: Align komutuyla yiizeyleri hizalama

3.6. Assembly (Nesnelerin Montaiji)

Assembly; bir makineyi, bir sistemi veya bir mekanizmayi olusturan pargalarin belirli bir siraya ya
da diizene gore bir araya getirilmesi islemidir. Montaj birkac parcadan olusabildigi gibi binlerce parcadan
da olusabilir. Bu nedenle montaj sirasinda kiiglk kiiclik montaj gruplari olusturularak montajlama islemi
kolaylastirilabilir. Bu sekildeki montajlama islemine alt montaj adi verilir. Nesneler, yiizlerce alt montajdan
olusabilir.

3.6.1. Montaj Sayfasinin Agilmasi

Dijital Gretim programinda montaj islemi Design ortaminda dogrudan yapilabilmektedir.

3.6.2. Montaj iliskisi EkKleme ve Esleme

Dijital Uretim programinda As-Built Joint ve Joint komutlari ile yararlanilabilecek yedi farkh Joint
(Montaj iliskisi) tiri bulunmaktadir. Her montaj iliskisinin farkli bir kullanimi vardir ve hareket tanimlamak
icin izin verilen serbestlik bicimleri farklidir. Her montaj iliskisinde, iliski degerlerinin parametrik bir sayisal
deger olusturacagina da dikkat edilmelidir. Montaj iliskileri ile ¢alisirken mimkiin olan en az serbestlik
derecesi acik tutulmalidir.

Montaja baslanacagizaman birtane temel parca olmasinda fayda vardir. Montajiliskilerinin bu parcadan
yiritilecegi dusiinilmelidir. ilk getirilecek par¢a bu nedenle iyi secilmelidir. Parga, montaj amaciyla gizim
alanina getirilirse unsur agacinda parganin tzerindeyken farenin sag tusuna tiklanir ve Ground (Yer) se¢imi
yapilir. Joint (Eklem) komutu c¢alistirildiginda program bu pargadan baslayarak montaj iliskisi olusturur.

Montajiliskisi; bir kenara, bir ylizeye, bir koseye ve bir noktaya gore verilebilir. Montaj iliskisi belirlenirken

parcalarin neresinin secilecegi, diger parca ile montaj iliskisine gore belirlenmeli ve kararlastirilmahdir.

Uygulama: Montaj i¢in Taslak Cizim Olusturma

Gorselde yer alan taslak gizimi olusturmak icin asagidaki yonergeleri uygulayiniz.
e Sketch komutu ile bir taslak olusturunuz.
e Taslak gizimleri yapiniz.
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Gorsel 3.119: Yatak nesnesi ve kayan nesne taslagi

¢ Finish Sketch komutu ile taslagi tamamlayiniz.

e Extrude komutunu her iki ¢cizim icin ayri ayri ¢alistiriniz.
e Yatak Nesnesi icin Distance degerini 300 mm, Kayan Nesne icin Distance degerini 20 mm olarak

belirleyiniz.

Gorsel 3.120: Nesneler

e Unsur agacindaki Bodies dali altinda nesneleri listeleyiniz.

e Bodyl nesnesinin adini Yatak, Body2 nesnesinin adini da Kayan Nesne olarak degistiriniz.

e Browser > Bodies altinda listelenen 6gelerin her birinin Gzerine farenin sag tusu ile ayri ayri tiklayiniz.

Gelen sag tus menisiinden Create Companents from Bodies komutuyla nesneleri bilesen haline

getiriniz.

e Yatak bileseni tizerine farenin sag tusu ile tiklayip meniiden Ground secenegini isaretleyiniz ve Yatak

bilesenini yere sabitleyiniz.

Uzerinde calisiimak istenen Companent, Browser altindan secilmelidir. Segme islemi,
bilesen (zerine farenin sag tusu ile tiklanip gelen menliden Activate (Etkinlestir)

 secenegiyle gerceklesir.

' onceki yerine geri gelir.
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Uygulama: Rigid (Sabit) Montaj iliskisi

Rigid, iki montaj bilesenini hicbir harekete olanak vermeyecek sekilde birlestirir. Sabit montaj olustur-
mak i¢in asagidaki yonergeleri uygulayiniz.
e Asssemble>Joint komutunu seginiz.
e Joint komut menisinden Motion sekmesini seciniz.
e Motion Type (Hareket Tipi) olarak Ri-
gid (Sert) hareket tlrini seginiz.
e Componentl ve Component2 alan-
larini kullanarak montaj nesnelerini N \
seginiz. A , ST 4/ :
e Secim esnasinda pargalarin monte - =

edilecegi Joint Origin noktalarini sira-

siyla gbsteriniz.
Gorsel 3.121: Yatak pargcasi montaj noktasi belirleme
e Angle alanindan agisal konumu; Offset X, Off-
set Y ve Offset Z alanlarindan da dogrusal ko-
numu belirleyiniz.
e OK digmesine basarak islemi bitiriniz. Calis-
manizi kaydediniz.

Gorsel 3.122: Rigid Joint islem sonucu

Uygulama: Revolute (Déniis) Montaj iliskisi

Donls montaj iliskisinde kullaniimak Gzere 6rnek nesneleri olugsturmak igin asagidaki yonergeleri

uygulayiniz.

e Genisligi ve uzunlugu 50 mm, yiksekligi 10 mm bir kutu olusturunuz.

e Kutunun ortasina Hole komutu ile 20 mm genisliginde bir delik aginiz.

e XY dizlemine 19 mm ¢ap genisliginde bir silindir giziniz ve silindire 40 mm ylikseklik degeri veriniz.

e DOnls hareketini gorebilmek icin silindirin ist tabaninda bir Sketch olusturup 4 mm c¢apli bir cember
Giziniz.

e Extrude komutu ile yukari yonli 5 mm yikseklik veriniz.

e Operation tirini Join olarak ayarlayiniz.

e Unsur agacindan Body1 adini Yatak, Body2 adini D6nen Nesne olarak degistiriniz.

e Create Companents from Bodies komutuyla nesneleri bilesen haline getiriniz.

e Yatak bilesenini Ground olarak seciniz ve yere sabitleyiniz.

e Asssemble > Joint komutunu seginiz.

e Joint komut menisliinden Motion sekmesini seciniz.

e Motion Type olarak Revolute (Doniis) hareket tiiriini seginiz.
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Componentl ve Component2 alanlarini kullanarak montaj nesnelerini seginiz.

Angle alanindan acisal konumu; Offset X, Offset Y ve Offset Z alanlarindan da dogrusal konumu
belirleyiniz.

Yatak ve Donen Nesne tabanlarinin ayni hizada olmasi igin
Joint paletinde Offset Z degerini -10 mm olarak giriniz.
Motion sekmesinde bulunan Rotate kismindan donis ek-
senini belirleyiniz.

Animate digmesine tiklayarak islemin dogrulugunu kont-
rol ediniz.

OK diigmesine basarak islemi bitiriniz. Calismanizi kaydediniz.

Gorsel 3.123: Revolute Joint islem sonucu

Uygulama: Slider (Siirgii) Montaj iliskisi

Slider, iki montaj bilesenini bir eksende dogrusal hareket yapabilecek sekilde birlestirir. Stirgli montaj

iliskisi icin asagidaki yonergeleri uygulayiniz.

Daha Onceki taslak uygulamasini aginiz.

Yatak bilesen nesnesine Ground 6zelligi veriniz.
Asssemble > Joint komutunu seginiz.

Joint komut menisiinden Motion sekmesini seciniz. Motion Type olarak Slider (Suirgii) hareket tiirtini
seginiz.

Joint paleti Position sekmesinden Componentl ve Component2 alanlarini kullanarak montaj nesne-
lerini seginiz.

Angle alanindan agisal konumu; Offset X, Offset Y
ve Offset Z alanlarindan da dogrusal konumu belir-
leyiniz.

Motion Type olarak Slider seciniz. Slider alanindan
kaydirilacak aks (eksen) icin -Y eksenini seginiz.
Animate digmesine tiklayarak islemin dogrulugunu
kontrol ediniz.

OK diigmesine basarak islemi bitiriniz.

Gorsel 3.124: Slider Joint islem sonucu

Uygulama: Cylindrical (Silindirik) Montaj iliskisi

Cylindrical, iki montaj bilesenini bir eksende dairesel ve dogrusal hareket yapabilecek sekilde birlestirir.
Silindirik montaj iliskisi icin asagidaki yonergeleri uygulayiniz.

Revolute montaj iliskisi konusunda kullanilan taslak gizimleri aginiz.

Yatak bilesen nesnesine Ground 06zelligi veriniz.

Asssemble > Joint komutunu seginiz.

Motion Type olarak Cylindirical hareket tiirlinl seginiz.
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e Joint paleti Position sekmesinden Componentl ve Component2 alanlarini kullanarak montaj
nesnelerini seginiz.

e Pargalarin monte edilecegi Joint Origin noktalarini sirasiyla gosteriniz.

e Angle alanindan agisal konumu; Offset X, Offset Y ve Offset Z alanlarindan da dogrusal konumu
belirleyiniz.

e Axis kismindan dogrusal ve dairesel hareketin yapilacagl mil eksenini -Z ekseni olarak belirleyiniz.

e Animate diigmesine tiklayarak islemin dogrulugunu kontrol ediniz.

e OK diigmesine basarak islemi bitiriniz.

e JOINT

Position | Motion |

Type = n @
©

Axis % 7 Axis T

Animate .

Cylindrical
o Cancel

Gorsel 3.125: Cylindirical Joint islem sonucu

Uygulama: Pin-Slot (Yuva-Kanal) Montaj iliskisi

Pin-Slot, iki montaj bilesenini bir pin yuvasi ve kanal iliskisi ile birlestirir. Bir eksende dairesel, bir ek-
sende dogrusal hareket yaptirir.

Pin-Slot montaj iliskisi icin asagi-
daki yonergeleri uygulayiniz.

e XY dizleminde genisligi ve uzunlu-
gu 50 mm, yiiksekligi 10 mm olan
bir kutu olusturunuz.

e Kutunun Ust yizeyine Sketch olus-
turarak 10 mm c¢apinda iki cember
¢iziniz. Cemberlerin alt ve st nok-
talarindan 30 mm uzunlugunda
cemberlere teget olacak bicimde

iki dogru ciziniz.

Gorsel 3.126: Pin Slot Joint yatak nesnesi taslagi
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e Extrude komutunu calistirarak olusturulan kama yolunun
icini bosaltiniz.
e Bodyl nesnesinin ismini Yatak olarak degistiriniz.

Gorsel 3.127: Pin Slot Joint yatak nesnesi

e XY dizlemine taban ¢api 9 mm, yiksekligi 40 mm olan bir silindir olusturunuz.
e Body2 ismini Donen Nesne olarak degistiriniz.

e Create Companents from Bodies komutuyla nesneleri bilesen haline getiriniz.
e Yatak bilesen nesnesine Ground 6zelligi veriniz.

e Asssemble > Joint komutunu seginiz.

e Joint komut menisiinden Motion sekmesini seginiz.

e Motion Type olarak Pin-Slot hareket tlrlni seginiz.

e Componentl ve Component2 alanlarini kullanarak montaj nesnelerini seginiz.

e Parcalarin monte edilecegi Joint Origin noktalarini sirasiyla gosteriniz.

~le JOINT
Paosition | Motion
¥ Component 1 - Component2:1

Mode E B ¢

Snap Ik 1 selected %

¥ Component 2

1 ; ~ - Mode E & -

Select a shap point to place the joint origin
3 : Snap

— = Joint Alignment

Flip .

[} 0K | [cancel|

Gorsel 3.129: Yatak pargasi montaj noktasi belirleme

e Angle alanindan acisal konumu; Offset X, Offset Y ve Offset Z alanlarindan da dogrusal konumu
belirleyiniz.

e Rotate kismindan dairesel hareketin yapilacagl mil eksenini -Z ekseni olarak belirleyiniz.

e Slider kismindan dairesel hareket yapilirken izlenecek yuva eksenini -X ekseni olarak belirleyiniz.

e Animate diigmesine tiklayarak islemin dogrulugunu kontrol ediniz.
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e JOINT

Fosition | Motion
Type had er) ! :i:rH &

Cl

e OK digmesine basarak islemi bitiriniz.

Rotate & 7 Axis x
Slide Yw K AXS ¥

Animate .

(i) OK Cancel

Gorsel 3.130: Pin- Slot Joint islem sonucu

Uygulama: Planar (Diizlemsel Yériinge) Montaj iliskisi

Planar, iki montaj bilesenini bir diizlemde dogrusal hareket yapabilecek sekilde birlestirir. Hareket
daha ¢ok bir yoriinge olarak tanimlanmalidir.
Dizlemsel yoriinge montaj iliskisi icin asagidaki yonergeleri uygulayiniz.
e XY dizlemine iki kutu giziniz. Birinci kutu i¢in 50x50x10 mm, ikinci kutu igin 25x25x5 mm ebatlarini kullaniniz.
e Bu kutulari bilesen nesnesine donistlriiniz.
e Bodyl nesnesinin adini Yatak, Body2 ismini Planar Nesne olarak degistiriniz.
e Create Companents from Bodies komutuyla nesneleri bilesen haline getiriniz.
e Asssemble > Joint komutunu seginiz.
e Joint komut meniisi Motion sekmesinden Planar segimini yapiniz.
e Componentl ve Component2 alanlarindan montaj nesnelerini seginiz.
e Parcalarin monte edilecegi Joint Origin noktalarini sirasiyla gosteriniz.
e Angle alanindan agisal konumu; Offset X, Offset Y ve Offset Z alanlarindan da dogrusal konumu belirleyiniz.
e Normal kisimdan hareketin yapilacagi ekseni -Z ekseni olarak belirleyiniz.
e Slider kismindan daire-

sel hareket yapilirken e

Fasition | Motion
e @& = b oo [g

izlenecek yoringe ek-
senini -X ekseni olarak

belirleyiniz.

e Animate diigmesine (i i

Slide “w K A *

Animate .

(i) oK Cancel

tiklayarak islemin dog-
rulugunu kontrol edi-
niz.

e OK dugmesine basarak

islemi bitiriniz.
Gorsel 3.131: Planar Joint islem sonucu
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Uygulama: Ball (Kiire) Montaj iliskisi

Ball, iki montaj bilesenini bir eklem hareketi yapacak sekilde birlestirir. Hareket daha ¢ok bir kiresel
yatak icinde gerceklesen dirsek hareketi olarak tanimlanmaldir.

Kire montaj iliskisi icin asagidaki yonergeleri uygulayiniz.
e XZ dizleminde bir Sketch olusturunuz.

Gorsel 3.132: f¢i bos kiire taslak ¢izimi

e Yukarida goruldigu gibi daire ve dogru ciziniz.

e Trim komutu ile gerekli yerleri budayiniz.

e Offset komutu ile igeri dogru 1 mm o6teleyiniz. Cizimin diizlem olmasi icin bosta kalan daire kesitinin
uglarini Line komutuyla birlestiriniz.

e Finish Sketch komutu ile ¢izimi sonlandiriniz.

e Revolve komutunu kullanarak cizilen diizlemi ve aks dizlemini seciniz. Ayarlari uygulayip OK tusuna
basarak i¢i bos bir kiire olusturunuz.

e REVOLVE
Profile [ 1 selected X
Axis X
Type < Angle .
Angle 360.0 deg| -

Direction %1 One Side -
Operation O Mew Body -
(i ] OK Cancel

Gorsel 3.133: Revolve komutu ile igi bos kiire olusturma
e XZ dizleminde 18 mm gapli bir kiire giziniz.
e XZdizleminde yeni bir Sketch olusturunuz ve 20 mm uzunluk, 1 mm genisliginde bir dikdértgen giziniz.
Dikdoértgenin sol alt kdsesinin, i¢i dolu kiirenin merkezinde olmasina dikkat ediniz.
e Finish Sketch komutu ile ¢izimi sonlandiriniz.
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e REVOLVE
Profile [ 1 selected %
Axis
Type < Angle x
Angle 3600 deg ¥
3600dea - Direction M One Side v

Operation &1 Join -
e OK | |Cancel

Gorsel 3.134: Kiire ve uzantisini olusturma

Gizilen dikdortgensel dizlemi Create > Revolve komutuyla kendi uzun kenari etrafinda dondiirerek
Join islemi ile kiireye bagh bir uzanti haline getiriniz.

Body1 nesnesinin adini Yatak, Body2 nesnesinin adini Ball Nesne olarak degistiriniz.

Create Companents from Bodies komutuyla nesneleri bilesen haline getiriniz.

Asssemble > Joint komutunu seginiz.

Joint komut menisiinde Motion sekmesinde yer alan Ball hareket tlrini seginiz.

Componentl ve Component2 alanlarini kullanarak montaj nesnelerini seciniz. Pargalarin monte
edilecegi Joint Origin noktalarini gosteriniz.

Angle alanindan acisal konumu; Offset X, Offset Y ve Offset Z alanlarindan da dogrusal konumu
belirleyiniz.

Pitch kismindan dairesel eklem hareketinin yapilacagi eklem eksenini belirleyiniz.

Yaw kismindan bir pusula ylizeyinde yapilirken dairesel hareketin izlenecek yoriinge eksenini
belirleyiniz.

Animate digmesine tiklayarak islemin dogrulugunu kontrol ediniz.

OK diigmesine basarak islemi bitiriniz.

e JOINT
Fosition | Mation
Type had 5 = .iu -;.r)» &

Pitch & 7 Axis -

Yaw A K Axis Y
Animate .
o OK | [Cancel

Gorsel 3.135: Ball Joint islem sonucu

3. OGRENME BIRIMi W53



Uygulama: As-Built Joint Montaj iliskisi

Montaj bilesenleri, yapilislari acisindan belli bir konumda bulunabilir veya bir alt montajda yer alabilir.
Bir montajda yer alan parcaya montaj iliskisi atanacaginda tiim montajin bu iliskiye uymasi beklenir. Bir
alt montaj, diger bir alt montaja montaj iliskisi ile baglanacaginda o alt montajin tim konumlari korunarak
montaj olusturulmahdir.
As-Build Joint montaj iliskisi icin asagidaki yonergeleri uygulayiniz.
e Asssemble > As-Built Joint komutunu seciniz.
e Komut menilsiinde Component alani kullanilarak montaj nesnelerini seciniz. Se¢im esnasinda
parcalarin monte edilecegi Joint Origin noktalarini sirasiyla gosteriniz.
e Motion alanindan montaj iliskisini olugturacak Joint tipini seginiz.
e Animate diigmesine tiklayarak islemin dogrulugunu kontrol ediniz.
e OK digmesine basarak islemi bitiriniz.

3.6.3. Motion Link (Hareket Baglantisi) Kurmak

Motion Link, iki ya da daha fazla montaj iliskisini birbirine baglayarak hareketi saglamak igin kullanilir.

Uygulama: Hareket Baglantisi Kurma

Hareket baglantisi kurmak i¢in asagidaki yonergeleri uygulayiniz.
e Daha 6nceden olusturdugunuz siirgli montaj iliskisi uygulamasini aginiz.
e Yatak nesnesinin yan ylizeyinde bir Sketch olusturup 10 mm c¢apinda bir cember ciziniz.

e Extrude komutu ile cembere 40 mm ylkseklik degeri veriniz.

\ e EXTRUDE

= Profile % 1 selected g
\ Start b Profile Flane  ~

Direction  Fg One Side

Extent - Distance
Distance  40.00 mm

Taper Ang. 0.0 deg

Operation & Join

(i ] OK | |Cancel
4000mm |- :

Gorsel 3.136: Yan ylizeyde Sketch olusturmak
e Herhangi bir diizlemde i¢ ice 50 mm ve 10 mm ¢apinda iki gember ¢iziniz. Cemberler arasinda kalan
diizlem segili iken Extrude komutunu g¢aligtiriniz ve diizleme 10 mm ylikseklik degeri veriniz.

e Carkin dondlgiini gorebilmek icin carkin Gzerine bir cember c¢iziniz ve Extrude komutunu calistirarak
cembere hacim kazandiriniz.
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e Create Companents from Bodies komutuyla nesneleri bilesen haline getiriniz.

e Asssemble > Joint komutunu tekrar ¢alistiriniz.

e Joint komut mentisiinde Motion sekmesini seciniz. Motion Type olarak Revolute hareket tirini
seginiz.

e Componentl ve Component2 montaj nesnelerini seginiz.

e Anglealanindan agisal konumu; Offset X, Offset Y ve Offset Z alanlarindan da dogrusal konumu belirleyiniz.

e Joint paletinde Offset Z degerini -10 mm olarak belirleyiniz.

e Motion sekmesinde bulunan Rotate kismindan donis eksenini belirleyiniz.

e Flip secimine tiklayarak parcanin konumunu degistiriniz.

e Animate digmesine tiklayarak islemin dogrulugunu kontrol ediniz.

e OK digmesine basarak islemi bitiriniz.

e Bilesenlere iki montaj turlni ayri ayri uyguladiktan sonra Asssemble > Motion Link komutunu
calistiriniz. Motion Link paleti acilir.

e Calisma sayfasinda birbirine baglanacak hareketleri seginiz.

© JOINT
Position | Mation

Type = H E L & B
©

Rotate % ZAxis

Animate .

o OK | |Cancel

Gorsel 3.137: Montaj islemi sonucu

3.6.4. Contact Sets (Birlestirme Seti)

Bu arac aktif oldugunda bir bilesenin hareket araligi boyunca karsilasacagi miidahaleleri analiz eder.
Contact Sets araci yardimiyla bir bilesenin hareket aralgi kisitlanabilir ya da tanimlanabilir.

Uygulama: Contact Sets

Contact Sets icin asagidaki yonergeleri uygulayiniz.

e Motion Link uygulamasini aginiz.

e Yatak nesnesinin her iki ucunda R kisayolu ile genisligi 70 mm, uzunlugu 10 mm olan bir dikdértgen
cizerek gerekli taslak ¢izimlerini olusturunuz.

e Extrude komutu ile 15 mm olacak sekilde taslagi nesneye donustiiriiniz.

3. OGRENME BIRIMi W55




e EXTRUDE

Profile % 1| selected [ifd

Start b Profile Plane -
Direction % One Side X
Extent I Distance -
Distance  15.00mm i

Taper Ane.  0.0deg A

Operation & Jain -
(] OK | |Cancel

7000

Gorsel 3.138: Yatak nesnesinin uglarinin kapatilmasi

e Carknesnesikendietrafindaddndirildiginde Kayan nesnenin kapatilan uglardan gikip uzaklasabilecegi
gorilebilir.

Gorsel 3.139: Yatak nesnesi ve kayan nesne

e Bu durumun 6niline gegmek, Kayan nesnenin Yatak nesnesinin kapatilan uclarina gelince durmasini
saglamak icin Contact Set atamasini yapiniz.

e Assemble > Enable Contact Sets komutu ile ¢alisma sayfasinda Contact Sets kullanimini etkinlestiriniz.

e Yatak bileseni icin New Contact Set komutunu galistiriniz.

e Contact Set iliskisi kurulacak nesneleri seginiz ve OK tusuna basarak Kayan nesnenin Yatak nesnesinin
uglarindan gecmedigini gériniz.

/

© NEWY CONTACT SET
Bodies or Components IREECIEWERE X

OK | [Cancel

Gorsel 3.140: New Contact Set paleti
3.6.5. Motion Study (Calisma Hareketi)

Motion Study, montaj iliskilerine dayali kinematik hareket analizi yapar. Eklenecek montaj iliskileri
secilir, ardindan hareket icin noktalar ve degerler belirtilir.
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Uygulama: Motion Study

Motion Study icin asagidaki yonergeleri uygulayiniz.
e Assemble > Motion Study komutunu seciniz. Gelen pencerede montaj iliskisi icin Slider3 slirgtsini
seginiz.

Mation Study n

Joint DOF  Value
A1 = Sliders t -214.. @

Distal A

0 20 Step 39 | 60 50 100)| < >
@@@@ Mode ® = O 2 Ora Speed OK Cancel

Gorsel 3.141: Motion Study penceresi
e (Cizgi Uzerinde bir Key (Anahtar) seciniz. Secilen anahtarin baslangi¢c konumuna gore Distance degeri
ile 0 mesafeyi kag adimda (Step) alacagini belirleyiniz.

e Play (Oynat) tusuna basarak baslangic ile belirtilen anahtar arasindaki hareketi oynatiniz.

Sira Sizde 9

Sabit kisminin genisligi 20 mm, uzunlugu 90 mm, ytksekligi 3 mm olan kapi mentesesini
olusturunuz ve montaj iliskilerini belirleyiniz.

3.6.6. Montajda Yeni Pargca Olusturma

Assemble > New Component komutu, montaj ortamina yeni bir parga eklemek istenildiginde kullanilr.

Uygulama: Montajda Yeni Parca Olusturma

e Assemble > New Component komutunu seciniz. istenirse unsur agacinda en ustteki montaj ikonuna
sag tiklanip New Component secimi de yapilabilir.

e Cizim yapilacak dizlemi secip Sketch aginiz ve gizim yapiniz. Cizim sirasinda montaj seffaflasir. Cizim
kaydedildiginde parca, montaja eklenmis olur.

Kaydedilen parcayi istediginiz gibi hareket ettirebilirsiniz. Parcanin tasarlandigi ylizeyle

bir montaj iliskisi yoktur. Par¢canin montaj iliskisini burada yapabilirsiniz.

e Unsur agacinda kaydedilen yeni parganin Ustlinde sag taraftaki daire secilirse diger montaj unsurlari
seffaflasir ve yeniden gerekli diizenleme islemleri yapabilir. Yapilan diizenlemeler, montaj ortamina
otomatik olarak yansir.
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© BROWSER "
4 © (5 (Unsaved)

D £+ Document Settings

D @ Named Views

D 8 Origin

D M Sketches

PA @ Component1:1 [c]

D ® (J Component2:1

Gorsel 3.142: Montaj ortaminda yeni parga olusturmak
e Olusturdugunuz yeni parcay! Ustline cizdiginiz parca ile iliskilendirebilirsiniz.

Parcanin ayritlari Project komutu ile izdlsurilerek olusturulmussa o parga lizerinde

yapilan degisiklikler, iliskili oldugu yeni pargaya da yansir.
e Olusturulan parganin galisma klasorinin icinde ayrica kayith olarak yer almasini isterseniz unsur

agacinda Uzerine sag tus tiklayip Save Copy As secerek ayri bir parca kaydi yapabilirsiniz.

3.6.7. Montaja Alt Montaj Ekleme

Ana montaja eklenen montaj gruplarina alt montaj denir. Bu islem, bliyiilk montaj ortamlarina kiguk
montajlarin ¢agrilip eklenmesidir. Montaj sayfasina nesneler eklenebilir veya baska bir montaj dosyasi da
parca gibi eklenebilir. Genellikle cok parcali montajlarda montaji rahatlatmak i¢in bu yontem kullanilir.

Uygulama: Montaja Alt Montaj Ekleme

Alt montaj eklemek icin asagidaki yonergeleri uygulayiniz.

e New Componentseciminiyaparak montajin altinda yeni bir montajacginiz. Assemble > New Component
komutunu secerek de ayni islemi gerceklestirebilirsiniz.

e Unsuragacinda Componentl:1 adinda olusan montajin altina bos bir parga eklediginizde yeni parganin
dogrudan Component2:1 adini aldigini gozlemleyiniz.

e Alt montaj grubuna baska parca eklenecekse alt montaji aktiflestirmek gerekir. Bunun icin sag taraftaki
daireyi tiklayarak alt montaji aktiflestiriniz.

e Alt montaj aktif degilse birlestirmelerle eklenen parcalari veya delik islemlerini genel montaja

uygulayiniz. Bunun i¢in unsur agacinda alt montajin izerinde iken sag taraftaki daire secilmelidir.
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Montaj sayfasindan ¢ikmadan parca ya da bilesenleri diizenlemek igin kullanilir. Montaj ortaminda

3.6.8. Edit Component (Montaj iliskilerini Diizenleme)

olusturulmus parcalar dogrudan degistirilebilir. Montaj, Data Panelde ilgili klasor icindeki parcalar
suriklenip montaj ortamina birakilarak olusturulmussa bu parcalar (izerinde degisim ancak parcanin
Gzerinde sag tusa basarak Open islemi ile gerceklestirilir. Parca tizerinde yapilan degisiklikler glincellenerek
montaj yenilenmelidir.

Surikle birak ile yerlestirilen pargalar tzerinde bulunan zincir isaretiyle (Link) pargalarin ayri bir parga
olarak baglandigianlasiimalidir. Par¢a, o montaja ait bir parcaya donistirilecekse lizerinde sag tusa basarak
Break Link komutu calistiriimalidir. Bu islem sonrasinda parga, asil parga ile olan iliskisinden kurtulur ve o

montaja ait hale gelir. Uzerinde yapilan degisiklikler artik asil (klasdrde kayitli) pargay etkilemez.

Uygulama: Montaj iliskilerini Diizenleme

e (Cizim alanindan ya da unsur agacindan diizenlenecek parca ya da montaji sag taraftaki daireyi secerek
aktif ediniz.

e Unsur agacinda secilen parca oldugu gibi kalirken aktif parca disindakiler seffaflasir.

e Design sayfasinda calisiyor gibi gerekli ¢izim ve dizenlemeleri yapiniz.

e Parca Ulzerinde yapilan degisiklikler unsur agacinda bilesene ait kisma yansir. Kaydetme islemi

yapildiginda ise hem montaja hem de pargaya yansir.

3.6.9. Montaja Akilli Baglanti Elemanlari Ekleme

Add-Ins, firmalar ya da programihazirlayan kurumlar tarafindan olusturulan hazir parca kitliiphanesidir.
Buradan civata gibi standart montaj elemanlari alinip montaja yerlestirilebilir.

Uygulama: Montaja Akilli Baglanti Elemanlari Ekleme

Montaja akilli baglanti elemanlari eklemek icin asagidaki yonergeleri uygulayiniz.

e Tools > Add-Ins ara¢ cubugundan Scripts and Add-Ins seciniz. Ekrana Scripts and Add-Ins diyalog
kutusu gelir.

e Eklenecek montaj elemanini seginiz (6rnegin bolt / civata). Run tusuna basiniz.

e Ekrana Create Bolt menisu gelir. Uygun degerleri girerek civata olusturunuz.

e Solid > Insert ara¢ cubugundan firma bilesenlerini seginiz. Ekranda firmanin Grlnleri listelenir.

e Magazadan istenilen Urin segilir, Griin adedi belirlendikten sonra lcret 6denip Companent siparis
edilebilir.

e Uriini projeye eklemek icin Product Details (Uriin Detayi) baglantisina tiklayarak iiriin detay sayfasina
gidebilirsiniz.

e Uriiniin hangi dijital Giretim programi igin indirilecegi belirlendikten sonra Save (Kaydet) tusuna basarak
bileseni projeye ekleyiniz. Bilesen unsur agacinda secili Companent altina eklenir.

3. OGRENME BIRIMi W59



3.6.10. Show / Hidden Components (Montaj iliskilerini Goster / Gizle)

Show / Hidden Components, ¢ok sayida par¢adan olusan montajlarda secilen parganin gérintisin
ekrandan kaldirmaya veya tekrar geri getirmeye yarar. Gercekte nesne montajdan kaldirilmaz, sadece
parcanin ekrandaki gorunirligh kalkar. Show / Hidden Components komutu ile saklanan parganin
unsur agacindaki gz semboli siliktir, Gzerinde sola yatik bir ¢izgi olur. Bu komut ile birden fazla parganin

ekrandaki goranarltga kaldinlip geri getirilebilir.

Uygulama: Montaj iliskilerini Goster / Gizle

Montaj iliskilerini goster / gizle icin asagidaki yonergeleri uygulayiniz.

e Unsur agacindan parga secildiginde ekrana gelen pencereden Hide Component (Bilesenleri Gizle)
seciniz. Parca ekrandan gizlenir.

e Tekrar gorinir hale getirmek icin unsur agacindan pasif durumda olan pargay! seginiz.

e Agcilan pencereden Show Component (Bilesenleri Goster) komutunu seginiz.

G, RepeatFit

(B Press Pull

Hole

Delete X

MovedCopy <

Sketch v L\ .

B Create Selection Set
4 Create Sketch
@ Exrude =
() Offset Plane
Shell

Edit Feature
4 EditProfile Sketch

@ Appearance a
¢f  Texture Map Controls
Remove Appearance Cwverride
Properties

Selectable/Unselectable

Find in Browser
Find in Windowe

Gorsel 3.143: Montaj iliskilerini géstermek / gizlemek
3.6.11. Assembly Features (Montaja Unsur Ekleme)

Assembly Features, pargalar lizerine bazi nesne unsurlarini eklemek igin kullanilir. Montaj sayfasina
montaj elemanlari eklendigi zaman aktif hale gelir. Montaja eklenen unsurlar pargaya da otomatik olarak

yansir.
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Montaja unsur eklemek icin asagidaki yonergeleri uygulayiniz.

e Unsur agacinda en Ustte yer alan montaj elemanina sag tiklayip New Component isaretleyiniz ya da
Assemble > New Component tiklayiniz. Unsur agacinin sonunda Component adinda yeni bir unsur
olusur.

e Calismaalanindan bir diizlem secerek yeni montaj bileseni olusturunuz. islem sonrasinda diger parcalar

seffaflasir ve calisma yeni parga lizerinde gerceklesir.

3.6.12. Hole Wizard (Delik Sihirbazi)

Hole Wizard, montaj sayfasinda iken montaj
parcalari lzerinde belirlenen noktalardan hizl delik
acmak icin kullanilir. Bu komutla montaj pargalari
Gzerine acilan delikler, parcanin modeline de yansir
ve unsur agacina delik unsuru eklenir. Delme islemi,
montaji olusturan parcalara denk gelirse bu parcala-

rin timande delik boyu kadar delik agiimis olur.

Delik sihirbazi igin asagidaki yonergeleri uygulayiniz.

e Create > Hole komutunu seginiz.

e Ekrana gelen menide Placement boliminden At Point (Single Hole) secimi yapiniz. Parca lzerinde
deliklerin agilacagi kati yiizeyi (Face / Point) seciniz.

e Hole Type kismindan delik tipini seginiz.

e Depth ve Diameter kismindan delik dlgulerini, Tip Angle kismindan da matkap ug agisini giriniz.

e Delik boyu ve yonilni belirleyiniz.

e OKtusu ile delme islemini tamamlayiniz.

Uygulama: Delik Dizisi

Delik dizisi igin asagidaki yonergeleri uygulayiniz.

e Create > Hole komutunu seciniz.

e Ekrana gelen meniide Placement bélimiinden From Sketch (Multiple Hole) secimini yapiniz. Parca
Uzerinde deliklerin acilacagi kati yiizeyi (Face / Point) seciniz ve birden cok delik icin taslaktaki ayrit
veya noktalari sirasiyla seginiz.

¢ Hole Type kismindan delik tipini seciniz.

e Depth ve Diameter kismindan delik 6l¢ilerini, Tip Angle kismindan da matkap ug agisini giriniz.
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e Delik boyu ve yonini belirley

niz.
e  OKtusuile delme islemini
gerceklestiriniz.

Gorsel 3.145: Delik dizisi

3.7. Tasarlanan Modelin Ug Boyutlu Baskisini Alma

Dijital Gretim programinda hazirlanan modellerin baskisi, dilimleme programlari ve {i¢ boyutlu yazicilar
aracihgiyla alinabilir.
3.7.1. Slicing (Dilimleme) Programi

Dilimleme programi, belirlenen parametrelere gére modeli katlara bélen ve yazici i¢in yapacag her
islemitarif eden bir komut kiimesi olusturur. Bu komutlara G-code adi verilir. G-code temel olarak {i¢ boyutlu
yazicinin X-Y-Z koordinatlarini, nozzle (agizlik) sicakligini, tabla sicakligini ve sogutma fani ¢alismasini igerir.
G-code komutlari CNC cihazlar icin standarttir. CNC cihazlarin buyik bélimi G-code komutlari ile ¢alisir.

Dilimleme yaziliminin olusturdugu G-codelar U¢ boyutlu yaziciya hafiza karti ya da USB baglantisi
Gzerinden seri iletisimle gonderilir.

Ug boyutlu tasarim (CAD) programlari aracihigiyla cizilen ii¢ boyutlu nesnelerin ii¢ boyutlu yazicilar
tarafindan baski yapabilmesi icin dilimleme programlarinca taninan dosya formatiyla disa aktarilmasi
gereklidir.
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Tasarimi Gi¢ boyutlu yaziciya aktarmak icin asagidaki yonergeleri uygulayiniz.

e Dijital Gretim programini ag¢iniz. Daha 6nce olusturdugunuz ti¢ boyutlu MEB yazi nesnesini aginiz.
e File > 3D Print komutunu

@ 3D PRINT
Selection
aciniz. B
Preview Mesh @

e Selection olarak dilimleme

Wumber of Triangles 480

programi igin tim nesneyi ¢

Refinement Low "

Segi niZ. P Refinement Options

e Preview Mesh secerek ¥ Output
mesh yapisinin gériinmesi- St Dk ey

. v Print Utility Custom -
ni saglayiniz.
Application [CuraCL[} =

e oK Cancel

Gorsel 3.146: Mesh yapisi goriintiisii
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e Refinement olarak baski kalitesine uygun secenegi isaretleyiniz.

e Refinement Options kismindan istenirse daha detayli ayarlar yapilabilir.

e Output ozelliklerinden Send to 3D Utility secenegini kaldiriniz ve .stl uzantili dilimleme programi igin
kaydediniz.

e Bilgisayarinizdabirdilimleme programiyiikliiyse Send to 3D Utility secenegini kaldirmayiniz. Application

boliminden dilimleme programini segerek dogrudan dilimleme programina génderebilirsiniz.

3.7.2. Dilimleme Programi Yardimiyla Ug Boyutlu Baski Alma

Kurulum tamamlandiktan sonra model, dilimleme yazilimiile agilarak ti¢c boyutlu yaziciya génderilebilir.

Uygulama: Dilimleme Programi Yardimiyla http://kitap.eba.gov.tr/KodSor. ik
.. php?KOD=21382
Ug Boyutlu Baski Alma

Dilimleme programi yardimiyla li¢ boyutlu baski almak igin asagidaki yonergeleri uygulayiniz.

e Ug boyutlu baskisi alinacak dosyayi aginiz.

e Baski alinacak nesneyi uygun sekilde tablaya yerlestiriniz. Gerekirse nesneyi déndirme ve tasima
islemi yapabilirsiniz.

e Konfigiirasyon panelinden kullanilacak malzeme (filament) ve renk gibi ayarlari seginiz.

e Yazdirma Ayarlan panelinden baski i¢in gerekli ayarlari yapiniz.

e Gerekli ayarlari yaptiktan sonra Dilimle diigmesine tiklayiniz.

Dosys Dizenle Gorunum Ayarfar Uzantiar Terchler Yardm

icPLA 2)| GenericPLA < = Fine-0.1mm B3 20% &l Kapali =+ Agk rd

A Nesne listesi
& Uuss MEB3d V1

150.0%55.0 x 20.0 mm

Se T oo

Dilimle

Gorsel 3.147: Dilimleme yazilimi

e Ug boyutlu yaziciya gdndermek icin G-code dosyasini kaydediniz.
e Modele ait G-code dosyasini yazicida galistirarak yazdirma islemini baslatiniz.
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— Olgme ve Degerlendirme

Asagidaki sorulari dikkatle okuyarak dogru segenegi isaretleyiniz.

1. Tasarim gizgisi cizmek icin agagidaki komutlardan hangisi kullanilir?

A) Control Point Spline B) Construction Line C) Spline
D) Fit Spline E) Line

2. Taslak gizim olusturmak igin asagidaki hangi komut kullanilmaktadir?

A) Exit Sketch B) 3D Sketch C) Sketch Xpert
D) Sketch E) Finish Sketch

3. Yatay ¢izgi ¢cizmek igin asagidaki Sketch Palette komutlarindan hangisi kullanilmalidir?

A) As Sketched B) Parallel C) Coincident
D) Vertical / Horizontal E) Angle

4. Asagidakilerden hangisinde Polygon (Cokgen) komutu ile gizilen en az kenar sayisi verilmistir?

A)3 B) 4 Q)5
D) 6 E) 8

5. Nesne kdselerine kavis vermek icin agagidaki hangi komut kullanilir?

A) Fillet B) Ellipse C) Extend
D) Trim E) Chamfer

o

Asagidaki komutlardan hangisi uzantilari kesistirmek icin kullanilir?

A) Trim B) Extend C) Corner
D) Closest E) Node
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7. Nesnelerin yiizeyler ya da diizlemler iizerine izdliisiimiiniin alinmasi igin asagidaki hangi komut
kullanihr?

A) Intersection B) Offset C) Project
D) Entities E) Chain Selection

8. Asagidaki komutlardan hangisi bir eksen etrafinda dairesel ¢cogaltma yapar?

A) Circular Pattern B) Sketch Pattern C) Linear Pattern
D) Stretch Pattern E) Pattern on Path

9. Asagidaki geometrik iliskilerden hangisi secilen nesneleri es merkezli hale getirir?

A) Collinear B) Concentric C) Coincident

D) Equal E) Parallel

10. Asagidaki nesne kenetleme komutlarindan hangisi segilen 6biir nesneye dik olan noktadan

yakalar?

A) Quadrant B) Nearest C) Perpendicular

D) Intersection E) Tangent

11. Sketch ortaminda olusturdugunuz bir ¢izimi belirli bir eksen etrafinda dondiirerek nesne

olusturmak i¢in asagidaki komutlardan hangisi kullanilir?

A) Extrude B) Revolve C) Loft
D) Sweep E) Web

12. Farkli diizlemler Gizerinde ¢izilmis profiller arasina malzeme atayarak nesne olusturan komut

asagidakilerden hangisidir?

A) Revolve B) Web C) Sweep
D) Extrude E) Loft
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13. Nesneleri tasimak i¢in asagidaki hangi kisayol tusu kullanilir?

A)C B) D
D) F E) K

14. Civatanin dislerini olusturmak igin asagidaki komutlardan hangisi kullanilir?

A) Threat ve Coil B) Extrude ve Spline
D) Loft ve Cut E) Web ve Rib

15. Circular Pattern komutunun kullanim amaci asagidakilerden hangisidir?

A) Nesnenin dairesel olarak ¢ikariimasi
B) Nesnenin dogrusal olarak c¢ikariimasi
C) Nesnenin dairesel olarak ¢ogaltilmasi
D) Nesnenin dogrusal olarak ¢ogaltilmasi
E) Nesnenin aynalanmasi

16. Payandalar asagidaki hangi komut kullanilarak gizilir?

A) Shell B) Revolve
D) Hole E) Rib

17. Belirli bir yol {izerinde gizimin siipiiriilmesiyle model olusturmak igin kullanilan komut

asagidakilerden hangisidir?

A) Revolve B) Sweep
D) Loft E) Coil

18. Hole komutunun gérevi asagidakilerden hangisidir?

M

C) Hole

C) Draft

C) Web

A) Cizim alani temizler.  B) Nesnelerin 6zelliklerini degistirir.  C) Cizimleri silerek ortadan kaldirir.

D) Nesnelerin Gizerinde delik acar. E) Nesnelere vida disi agar.

19. Yiizeye paralel yeni bir diizlem olusturmak i¢in hangi komut kullanilir?

A) Point B) Horizantal
D) Offset Plane E) Split

16 3. OGRENME BIRIMi
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20.

21.

22.

23.

24,

25.

DiJiTAL URETIM

Yuvarlatma isleminde kullanilan Variable Radius anlami asagidakilerden hangisidir?

A) Degisken yaricaph yuvarlatma B) Degisken pah kirma C)Kavis olusturma
D) Yarigapli yuvarlatma E) Degisken yaricaph vidalama

Montaj sayfasi ve yeni parga olusturulmasi igin programin acilisinda asagida verilen hangi
komutun kullanilmasi gerekir?

A) Motion Link B) New Component C) New
D) Drawing E) Motion Link

Montaj sayfasina klasérdeki bir pargayr eklemek igin asagida verilen hangi islem uygulanmalidir?

A) Edit Component komutu ile parca eklenmelidir.

B) Move Component komutu ile parga tasinmalidir.

C) Rotate Component komutu ile parga donistirilmelidir.

D) Data Panelden parca siriklenerek montaj ortamina birakilmahdir.
E) Govde, Split Body komutu ile pargalara bélinmelidir.

Secilen silindirik pargalari ortak merkezli hale getirmek icin asagida verilen hangi eslestirme

komutu kullanilir?

A) Cylindirical B) Parallel C) Width
D) Coincident E) Revolute

Asagida verilen parga iliskilendirmelerinden hangisi standart iliskilerden degildir?

A) Revolute B) Rigid C) Cylindirical
D) Pin-Slot E) Width

Asagida verilen gelismis montaj iliskilerinden hangisi ¢oklu pargalara montaj iligkisi

vermek icin kullanihir?

A) Revolute B) Path Mate C) As-Built Joint
D) Angle E) Joint Origin
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26. Asagidaki mekanik montajlardan hangisi silindirik pargalara donme iliskisi verir?

A) Hinge B) Rack Pinion C) Gear

D) Contact Sets E) Revolute

27. Bir eksen etrafinda kiiresel hareket saglayan mafsal gibi parcalari birlestirmek icin hangi yontem

kullanihr?

A) Ball B) Gear C) Rack Pinion
D) Screw E) Pin

28. Montaj sirasinda pargalara montaj iliski merkezi eklemek igin asagidaki hangi komut kullanilhir?

A) New Part B) Copy With Mates C) Edit Component
D) Joint Origin E) Motion Study

29. Montaj sayfasindan ¢cikmadan parca ya da bilesenleri diizenlemek icin asagida verilen

komutlardan hangisi kullanilir?

A) Rotate Component B) Linear Component Pattern C) Edit Component

D) Circular Component Pattern E) Revolute Cut

30. Asagidakilerden hangisi Add-Ins kiitiiphanesinde hazir bulunan birlestirme elemanlarini otomatik

olarak montaja ekler?

A) Bill of Materials B) Assembly Features C) Show / Hidden Components
D) Ground E) Script and Add ins

Asagidaki climleleri dikkatle okuyarak bos birakilan yerlere dogru sozciikleri yaziniz.
31. Chamfer komutu nesnelerin ........ccooeeceevececeececececeeeeee e icin kullanilir.

32. Draft komutu model lizerinde segilen bir veya birden fazla ylzeye .......ecnvenccenncceseeeeseee

icin kullanilir.
33. Nesneleri hizalamak igin ....cccccoveevveeceneeneneenne, komutu kullanilir.
34. Olusturulan bir nesneye et kalinhigli vermek ........cccceevvvvveveevienvenen. komutu kullanilr.
35. Split KOMULU NESNEIETT w..oveeeeeece e icin kullantlir.
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1. ®GRENME BIiRiMi / TEMEL TEKNIiK RESIM

Cevabiniz yanlis ise Cizgi Cesitleri ve Cizgilerin Kullanildigi Yerler konusunu gézden geciriniz.

Cevabiniz yanlis ise Teknik Resimde Kullanilan Arag Geregler konusunu gézden gegiriniz.
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Cevabiniz yanlis ise Standart Yazi Tipleri ve Norm Yazi konusunu gozden gegiriniz.

m

Cevabiniz yanlis ise Teknik Resimde Kullanilan Arag Geregler konusunu gézden gegiriniz.

Cevabiniz yanlis ise Standart Kagit Olciileri konusunu gdzden gegiriniz.

Cevabiniz yanlis ise Dogru Cizimi konusunu gozden gegiriniz.

Cevabiniz yanlis ise izdiisiim Tanimi ve Siniflandirilmasi konusunu gdzden gegiriniz.

Cevabiniz yanlis ise izdiisiim Tanimi ve Siniflandiriimasi konusunu gézden geciriniz.
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Cevabiniz yanlis ise izdiisiim Tanimi ve Siniflandirilmasi konusunu gdzden gegiriniz.

=
e
m

Cevabiniz yanlis ise Noktanin izdiisiimii konusunu gdzden gegiriniz.

11. Cevabiniz yanlis ise izdiisiim Diizlemleri konusunu gézden geciriniz.

12. Cevabiniz yanlis ise Noktanin izdiisiimii konusunu gdzden gegiriniz.

13. Cevabiniz yanlis ise Olgeklendirme konusunu gdzden gegiriniz.

14. Cevabiniz yanlis ise Olgekler konusunu gézden gegiriniz.
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15. Cevabiniz yanlis ise Olgekler konusunu gdzden gegiriniz.

el | Sira Sizde Cevap Anahtarlari
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’ ISTIKLAL MARSI

Korkma, sonmez bu safaklarda yiizen al sancak;
Sonmeden yurdumun iistiinde tiiten en son ocak.
O benim milletimin yildizidir, parlayacak;
O benimdir, o benim milletimindir ancak.

Catma, kurban olayim, ¢ehreni ey nazli hilal!
Kahraman wikima bir giil! Ne bu siddet, bu celal?
Sana olmaz dokiilen kanlarimiz sonra helal...
Hakkidwr, Hakk'a tapan, milletimin istiklal!
Mehmet Akif ERSOY
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—_— I Olgme ve Degerlendirme Cevap Anahtari

2. OGRENME BIRIMi / BILGISAYARLI GiziM

1. B Cevabiniz yanlis ise Temel islem Kontrolleri konusunu gdzden gegiriniz.

2. B Cevabiniz yanlis ise Goriiniim Kontrolleri konusunu gézden gegiriniz.

3. C Cevabiniz yanlis ise Goriiniim Kontrolleri konusunu gézden gegiriniz.

4, D Cevabiniz yanlis ise Gruplama konusunu gozden gegiriniz.

5. C Cevabiniz yanlis ise Hizalama konusunu gézden gegiriniz.

6. D Cevabiniz yanlis ise ige Aktar konusunu gézden gegiriniz.

7. D Cevabiniz yanlis ise Diga Aktar konusunu gézden gegiriniz.

8. A Cevabiniz yanlis ise Goriiniim Kontrolleri konusunu gézden gegiriniz.

9 B Cev'a.bl.mz yanlis ise Ug Boyutlu Yazicilarda Tasarimi Yazdirma konusunu gézden
geciriniz.

10. C Cev.a.bl.nlz yanlis ise Ug Boyutlu Yazicilarda Tasarimi Yazdirma konusunu gézden
gegiriniz.

el | Sira Sizde Cevap Anahtarlari

ikinci Tasarim adinda yeni bir tasarim olusturmak icin asagidaki yonergeleri uygulayiniz.
e Yeni bir tasarim olusturunuz.
e Cizim programinin tasarim icin verdigi ismi degistirmek icin tasarim ismini tiklayiniz.

e Tasarimin adini ikinci Tasarim olarak degistiriniz.

;Ana sayfaya donerek dnceden olusturdugunuz baska bir tasarimi agmak icin asagidaki yonergeleri
izleyiniz.

e Uygulamaniz acikken son tasarimlar digmesine tiklayiniz.

1]
Digli Cark

REE

Son tasanmlar
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e [stediginiz uygulamayi seginiz ve Bunu diizenle diigmesine tiklayiniz.

Tasanmianim

' L Disa Aktarma Bunu diizenle £ - 2] ’
§ i boyutlu hale donustirme B dizenle & o

‘V‘ B Erzalltin
” Kelemlik yapimt Bunu diizenle £ - 3]

-

Bardak Yapimi Bunu diizenle - ]

'@

Bayrak Bunu diizenle &Hom

?Silindir Uzerinde temel islemleri yapmak icin asagidaki yonergeleri takip ediniz.
e Yeni bir tasarim olusturunuz.
e Tasarimin adini Sira Sizde 3 olarak degistiriniz.
e Calisma dizlemine bir silindir ekleyiniz.
e Silindirin ylksekligini 15 mm olarak 6lceklendiriniz.
e Silindirin capini 35 mm olarak 6lceklendiriniz.

[EE & ncredible Jarv
[ciabo] =

DeEo0 «~

-  Sekil
=
e Silindiri galisma alaninin sol Ust kosesine taslyiniz.
e Silindiri 15 mm yukari kaldiriniz.
e Silindiri 30 derece donddriiniz.
E?‘uz;: Incredible Jarv m A M 8"5
b O 0 « N tsemcar osaacar  Gonger

15.00
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ECikoIata tasarimini farkl sekillerle yapmak icin asagidaki yonergeleri uygulayiniz.

Yeni bir tasarim olusturunuz.

e Tasarimin adini Sira Sizde 4 olarak degistiriniz.

e Calisma dizlemine bir kutu ekleyiniz.
e Kutunun yiksekligini 5 mm olarak 6lceklendiriniz.
e Kutunun enini ve boyunu 100x100 mm olarak 6l¢eklendiriniz.
& -« Toe i | Drga aiar || @hder
e

Tinkercad
Temel Sekiller

&

Yuvarlak (at Metin
Dilim Piramit
Yanm Kure Poligon

e Cahsma dizlemine bir piramit ekleyiniz.

e Piramidi 5 mm ylkseltiniz.

e Piramidin yuksekligini 10 mm olarak 6l¢eklendiriniz.

e Piramidi Duplicate and repeat (Ctrl+D) diigmesiile 5 adet yan yana sekilde ¢ogaltiniz.
e Piramit sekillerini Gruplandir (Ctrl+G) digmesi ile gruplandiriniz.

e Piramit grubu ile kutu seklini sol alt kbsede hizalayiniz.

o QW « Ire) b Gemkar  Diaddar | Gonder

L)

Yuvarlak Catr Metin

Dilim Diramit

L7V VYV,
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e Piramit grubunu Duplicate and repeat (Ctrl+D) diigmesi ile cogaltiniz.
e Yeni piramit gruplari ile gikolata zemininin ylizeyini kaplayiniz.
iz] « IeAktar  DisaAktar  Gonder

e Butlin sekilleri Gruplandir (Ctrl+G) digmesi ile gruplandiriniz.
e Calisma dizlemine bir kutu ekleyiniz.

e Kutunun enini ve boyunu 100x100 mm olarak 6l¢eklendiriniz.
e Kutuyu 10 mm yikseltiniz.

e Kutunun 6zelligini Delik olarak degistiriniz.

e Kutuyu ve sekil grubunu sol alt koseden hizalayiniz.

B « fceAktar DisaAktar  Gonder

e Tum sekilleri gruplandiriniz.
e Seklin rengini 6zelliklerden kahverengi olarak degistiriniz.

B « IceAktar DisaAktar  Gonder
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Kalemlik tasariminda yildiz sekillerini artirmak igin asagidaki yonergeleri uygulayiniz.
e Kalemlik Yapimi uygulamasini aginiz.
e Yildizlari seciniz ve gruplandiriniz.
e Yildiz grubunu gogaltiniz.
e Yeniyildiz grubunu 10 mm yikseltiniz.
e Yildiz grubunu 22,5 derece donduiriniz.

[® « - IceAkiar  DisaAktar  Gonder

e Yildiz grubunu tekrar ¢cogaltiniz.

e Yeniyilldiz grubunu 10 mm yiikseltiniz.

e Yildiz grubunu 22,5 derece dondiriiniz.

e Yildiz grubunu tekrar ¢cogaltiniz.

e Yeniyildiz grubunu 10 mm daha yikseltiniz.
e Yildiz grubunu 22,5 derece donduriniz.

e Yazl Uzerine gelen yildizi, yildiz grubunu ¢ozerek tasiyiniz.

LU -~

Temel Sekiller

Kuty sitindir
Kuty sitindir

Scribble

e Tiam sekilleri gruplandiriniz.
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Sira Sizcle 6 |

Piyon tasarimini kale tasina donlstiirmek icin asagidaki yonergeleri takip ediniz.

Piyon Yapimi tasarimini aginiz.

e Piyon tasarimini seginiz ve Kopyala (Ctrl+C) diigmesine tiklayiniz.

Son tasarimlar digmesine tiklayiniz ve yeni bir tasarim olusturunuz.

Tasarimin adini Kale Yapimi olarak degistiriniz.

Yapistir (Ctrl+V) digmesi ile piyon tasarimini yeni tasarima aktariniz.

Sekli seginiz ve grubu ¢6ziinlz.

En Usteki kiire seklini siliniz.

e Bir Calisma Diizlemini koninin Ustline strikleyiniz.

e Calisma dizlemine bir silindir ekleyiniz.

e Silindirin yuksekligini 10 mm olarak 6l¢eklendiriniz.

e Silindirin capini 12 mm olarak ol¢eklendiriniz.

e Calisma dizlemine bir kutu ekleyiniz.

e Kutunun enini ve boyunu 20x3 mm olarak olceklendiriniz.
e Kutuyu 8 mm yikseltiniz.

e Silindir ve kutuyu merkezden hizalayiniz.
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o KeAkiar | DisaAktar  Gonder

Temel Sekiller

§ 0

Kutu Silingir

)

Kutu Silingir

e Kutuyu ¢ogaltiniz.

e Kutuyu 90 derece déndiriniz.

e Silindir ve kutulari gruplandiriniz.

e Kale basligini gbvde lzerine tasiyiniz.

e Bir Calisma Diizlemini seklin disinda bir alana surtkleyerek calisma dizlemini orijinal konumuna
getiriniz.

e Tum sekilleri secerek merkezden hizalayiniz.

e Tum sekilleri gruplandiriniz.

IgeAktar DisaAktar  Gonder

Temel Sekiller

§ 0

Kuty Silingir

Kuty Silingir

® W

Kire Scribble

)

o0 A
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—_— I Olgme ve Degerlendirme Cevap Anahtari

T 3. GGRENME BIRIMi / DIJITAL URETIM

1. E Cevabiniz yanlis ise Taslak Cizim Komutlari konusunu gbézden gegiriniz.

2. D Cevabiniz yanlis ise Taslak Cizim Komutlari konusunu gézden gegiriniz.

3. D Cevabiniz yanlis ise Kisitlamalar konusunu gézden gegiriniz.

4, A Cevabiniz yanlis ise Cokgenler konusunu gdzden gegiriniz.

5. A Cevabiniz yanlis ise Fillet konusunu gézden gegiriniz.

6. B Cevabiniz yanlis ise Extend konusunu gdzden gegiriniz.

7. C Cevabiniz yanlis ise Project konusunu gdzden gegiriniz.

8. A Cevabiniz yanlis ise Cogaltma konusunu gézden gegiriniz.

9. B Cevabiniz yanlis ise Kisitlamalar konusunu gézden gegiriniz.

10. C Cevabiniz yanlis ise Kisitlamalar konusunu gézden gegiriniz.

11. B Cevabiniz yanlis ise Déndiirerek Nesne Olusturma konusunu goézden gegiriniz.

12. E Cevabiniz yanlis ise Déndiirerek Nesne Olusturma konusunu gozden gegiriniz.

13. C Cevabiniz yanlis ise Profil Nesnelerini Cogaltma konusunu gozden gegiriniz.

14. A Cevabiniz yanlis ise Nesneden Baska Bir Nesne Cikarma konusunu gdzden gegiriniz.

15. C Cevabiniz yanlis ise Profil Nesnelerini Cogaltma konusunu gozden gegiriniz.

16. E Cevabiniz yanlis ise Destek Elemani Olusturma konusunu gézden gegiriniz.

17. B Cevabiniz yanlis ise Déndiirerek Nesne Olusturma konusunu gézden gegiriniz.

18. | D Cevabiniz yanlis ise Nesneden Bagka Bir Nesne Cikarma konusunu gozden gegiriniz.

19. D Cevgbnrnz yanlis ise Diizenleme Komutlariyla Nesneler Olusturma konusunu gézden
gegiriniz.

2. A Cev.al.:n.nlz yanlis ise Diizenleme Komutlariyla Nesneler Olusturma konusunu goézden
geciriniz.

21. B Cevabiniz yanlis ise Montajda Yeni Parga Olusturma konusunu gozden gegiriniz.

22. D Cevabiniz yanlis ise Edit Companent konusunu gdzden gegiriniz.

23. A Cevabiniz yanlis ise Joints konusunu gézden gegiriniz.

24. E Cevabiniz yanlis ise Joints konusunu gézden gegiriniz.

25. C Cevabiniz yanlis ise As Built Joint konusunu gbézden gegiriniz.

26. E Cevabiniz yanlis ise Joints konusunu gézden gegiriniz.

27. | A Cevabiniz yanlis ise Joints konusunu gézden gegiriniz.

28. D Cevabiniz yanlis ise Joints konusunu gbézden gegiriniz.

29. C Cevabiniz yanlis ise Edit Companent konusunu gozden gegiriniz.

30. E Cevgplplz yanlis ise Montaja Akilli Baglanti Elemanlari Ekleme konusunu goézden
gegiriniz.
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kenar ya da
31. koselerine pah | Cevabiniz yanlis ise Nesneden Bagka Bir Nesne Cikarma konusunu gézden gegiriniz.
kirmak icin
32 istenilen agida = Cevabiniz yanlis ise Diizenleme Komutlariyla Nesneler Olugturma konusunu gézden
* | egim vermek geciriniz.
33. Alien Cevabiniz yanls ise Diizenleme Komutlariyla Nesneler Olusturma konusunu goézden
& gegiriniz.
34. Shell Cevabiniz yanlis ise Diizenleme Komutlariyla Nesneler Olusturma konusunu gozden
gegiriniz.
35. | bolerek Cevabiniz yanlis ise Diizenleme Komutlariyla Nesneler Olusturma konusunu gozden
parcalara geciriniz.
ayirmak
— I Sira Sizde Cevap Anahtarlari
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e XY dizlemde bir taslak olusturunuz.

e -X, =Y eksenleri ve orijinden gegen Construction Line (Yardimci Geometri Cizgisi) ciziniz.

e  Orijin noktasini merkez kabul eden ve ¢api 131,2 mm olan bir cember ciziniz.

e Orijin noktasi ile yatay dogrultuda (Horizontal / Vertical kisitlamasini kullaniniz.) ve 10 mm solunda
(Sketch Dimension komutunu kullaniniz.), capi 168,2 mm olan bir gember ¢iziniz.

e Cember cizimlerinin sag tarafinda ve ¢emberlerin arasinda kalan bolgeye orijin noktasi ile yatay
dogrultuda, cemberlerile teget, 8,5 mm ¢apinda bir cember ¢iziniz (2-Points Circle komutunu kullanmak
daha islevsel olacaktr.).

e  Orijin noktasinin 185 mm solunda ve orijin ile yatay dogrultuda, ¢aplari sirasiyla 12 mm ve 32 mm olan
es merkezli iki cember ciziniz.

e 3-Point Arc komutunu kullanarak 32 mm ¢apli gember ile 168,2 mm capli cember arasinda, cemberlere
teget, 108 mm yaricapl yay ciziniz.

e 3-Point Arc komutunu kullanarak 32 mm c¢apli cember ile 131,2 mm ¢apli cember arasinda, cemberlere
teget, 145 mm yaricapl yay ciziniz.

e Trim komutu ile gerekli budamalari yapiniz.

e Calismanizi bulut ortaminda kaydediniz ya da File > Export komutu ile istediginiz dizine ¢ikartiniz.
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XY dizlemde bir taslak olusturunuz.

-X, =Y eksenlerinden ve orijinden gecen Construction Line ciziniz.

Sol alt kdsesi orijin noktasinda olan 40 mm uzunlugunda, 95 mm genisliginde bir dikdértgen giziniz.
Cizilen dikdortgenin igine 10 mm uzunlugunda, 75 mm genisliginde bir dikdértgen daha giziniz.

Cizilen ikinci dikdortgenin 75 mm’lik uzun kenarinin ilk gizilen dikdértgenin 95 mm olan uzun kenarina

uzakhgini Skecth Dimension komutu ile 10 mm olarak ayarlayiniz.

0.00) 1000

75.00

0007
000¢
|

1000

9500

Cizilen ikinci dikdortgenin 10 mm’lik olan kisa kenarlarinin ilk gizilen
dikdortgenin 40 mm olan kisa kenarlarina uzakligini Skecth Dimension
komutu ile 10 mm olarak ayarlayiniz.

Blyk dikdortgenin uzun kenarinin orta noktasindan gececek bicimde
uzunca bir gizgi ¢iziniz ve gizgiyi X kisayol tusuna basarak yardimci
geometri haline donlstirindz.

Blyk dikdortgenin uzun kenarinin orta noktasindan 20 mm yukarida,

¢ap! 20 mm olan bir cember ¢iziniz. &
Buyuk dikdértgenin uzun kenarinin orta noktasindan 100 mm 8 =

yukarida, ¢capi 40 mm ve 80 mm olan es merkezli iki cember ciziniz.

20,00

3-Points Arc komutu ile 20 mm ve 40 mm c¢apli gemberler arasinda,

=
M

cemberlere teget ve yarigcap 0Olglsli 75 mm olan bir yay ciziniz.
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e 3-Points Arc komutu ile 80 mm capli,

dikdortgenin sag Ust kosesi arasinda, o harRoR
o . e Objects [y 2 selected X
cembere teget ve yaricap Olclisii 115 mm - D
©80.00
olan bir yay ciziniz. 7 oo © oK | [Cancel

e Mirror komutunu calistiriniz. Aynalanacak
Ogeler olarak yay nesnelerini, aynalama \ \

cizgisi olarak buydk dikdortgenin uzun \\ \

kenarinin orta noktasindan gecen kesik 5

¢izgiyi seginiz. | ‘ r5 00 7
| |

* Trim komutu ile gerekli budamalari amr s

©
\\ ©20.00

10000

yapiniz.  Blyuk  dikdortgenin  uzun

kenarinin alt koselerine Fillet komutu ile

2000

drE Y@ Q- B8

10 mm yari¢capinda kavis veriniz. -

e Calismanizi bulut ortaminda kaydediniz ya

da File > Export komutu ile istediginiz dizine ¢ikartiniz.

92

e XY dizlemde bir taslak olusturunuz.
e -X, =Y eksenlerinden ve orijinden gegen Construction Line ¢iziniz.
e Orijin noktasina caplari sirasityla 30 mm ve 70 mm olan es merkezli iki cember ciziniz. Orijin noktasi ile

yatay dogrultuda, orijin noktasinin 92 mm solunda, 50 mm ¢aph bir cember ¢iziniz.

©30.00

9200 ‘ @70.00

184 'CEVAP ANAHTARI



3-Points Arc komutu ile A ve B noktalarindan gecen ve ¢cemberlere teget olan bir yay ciziniz. Sketch
Dimension komutu ile yayin yarigap 0Olgisiini 92 mm olarak belirleyiniz.

3-Points Arc komutu ile C ve D noktalarindan gegen ve cemberlere teget olan bir yay ¢iziniz. Sketch
Dimension komutu ile yayin yarigap 6l¢islinii 185 mm olarak belirleyiniz.

Trim komutu ile 50 mm ¢apindaki dairenin iceride kalan kismini budayiniz.

Offset komutu ile iceri dogru 11 mm 6teleyerek ¢ogaltma islemini gerceklestiriniz.

R9200

(4

-11.00 mm’3

23000
@70.00

Trim komutu ile gerekli budamalari yapiniz. Fillet komutu ile E ve F noktalarina 6 mm yarigapinda kavis
islemi uygulayiniz.

Calismanizi bulut ortaminda kaydediniz ya da File > Export komutu ile istediginiz dizine ¢ikartiniz.

R9200
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Chamfer 2x45° —

F

&7

e XY diizlemde bir taslak olusturunuz.

e -X,-Y eksenlerinden ve orijinden gecen Construction Line ciziniz.

e Orijin noktasina caplari sirasiyla 20 mm ve 48 mm olan iki cember ciziniz.

e Orijin noktasindan 30 mm yukarida ve 21 mm solda bulunan noktada (A noktasi) 20 mm capli cember
ciziniz.

e Circle komutunu calistiriniz. Cember ¢izmeden 6nce yakalama dogrulari ile 20 mm ¢apli cemberin alt
noktasinda (B noktasi) 48 mm capli bir cember ciziniz.

e Line komutunu ¢ahstiriniz. Cizgiyi cizmeden 6nce yakalama dogrulari ile gemberin lizerindeki noktadan
(C noktasi) yukari yonlu dik bir gizgi ciziniz.

e -Yeksenindekiyardimci geometri gizgisi lizerinde 90 mm capli bir gember ¢iziniz. Bu cember ile B noktasi

merkezli, 48 mm ¢apli cemberi Tangent kisitlamasi ile teget hale getiriniz.

24800

©20.00

30.00

@90.00
220.00

248.00

e D noktasindan yukari yonli dik bir gizgi giziniz. Cizilen gizginin bitis noktasinin orijin noktasina olan
uzakhgini Sketch Dimension komutu ile 83 mm olarak ayarlayiniz.

e Enoktasindan =Y eksenine dik bir gizgi ciziniz. Yine E noktasindan yukari yonli dik bir ¢izgi ciziniz. Cizginin
Olglstini 67 mm olarak ayarlayiniz.
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e F noktasindan =Y eksenine, ekseni dik kesecek bicimde bir

¢izgi ¢iziniz. Yine F noktasindan uzunlugu 2 mm, agi degeri 135°

04800

olan bir cizgi ciziniz. Cizilen cizginin ucundan =Y eksenine dik ...

8300

bir ¢izgi ciziniz.

e Resimde mavi renkle secili olan alan icine capt 8 mm

3000

uzunlugunda bir gember giziniz. Cizilen gemberi, C noktasindan

yukari yonli gizilen dogru ve merkezi =Y ekseninde olan 90

mm c¢apindaki cember ile teget hale getiriniz.

09000

e G ve H noktalarindan gegen ve cemberlere teget olan bir ¢izgi

ciziniz. Gerekli budamalari Trim komutu ile yapiniz. v

© MRROR
Objects I 13 selected %

Mirror Line [SNEGEEEt] X

e Mirror komutunu galistiriniz. Aynalanacak nesneleri seginiz.

L] OK | Cancel
Aynalama dogrusu olarak -Y eksenini seginiz. 3
e Calismanizi bulut ortaminda kaydediniz ya da File > Export 1
komutu ile istediginiz dizine ¢ikartiniz. N
eaam\ b
/" \‘\
Vil |
b

drE Y Q- B8

v

e XY dizlemde bir taslak olusturunuz.

e -X, =Y eksenlerinden ve orijinden gecen Construction Line ¢iziniz.

e  Orijin noktasini merkez kabul eden, gaplari sirasiyla 40 mm, 50 mm ve 70 mm olan Ug¢ ¢ember giziniz.

e Orijin noktasindan baslayarak -Y ekseninde, yukari yonli, 25 mm uzunlugunda bir ¢izgi ciziniz.

e Circular Pattern komutunu cahlstiriniz. Cogaltilacak nesne olarak 25 mm uzunlugundaki cizgiyi, merkez
nokta olarak da orijin noktasini seciniz. Cogaltma adedini 12 olarak belirleyiniz. Trim komutu ile gerekli

budamalari yapiniz.
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© CIRCULAR PATTE
It 1 selected X

e  Orijin noktasinin 46 mm solunda ve 26,80 mm

Objects

Center Point
yukarisinda bulunan noktada 10 mm ve 30 mm e o
Suppress

capli iki cember ciziniz. Quarry

OK | [Cancel

e -Y ekseni Ustlinde, orijin noktasinin 85 mm
yukarisinda, 22 mm ve 42 mm ¢apli iki cember
giziniz.

e Merkezi orijin noktasinda olan 70 mm ¢apl

¢emberden, caplari 42 mm ve 30 mm olan

cemberlere tegetler ¢iziniz.

92200
©42.00

210.00

@20.00

0058

089

089z

©240.00
250.00
70.00

4600

e 3-Points Arc komutu ile 30 mm ve 42 mm capli cemberlerin lzerindeki noktalardan yay ¢iziniz. Yayin
cemberlere teget olmasini saglayiniz. Sketch Dimension komutu ile yayin yarigap o6lctsiini 39,70 mm
olarak belirleyiniz.

e Calismanizi bulut ortaminda kaydediniz ya da File > Export komutu ile istediginiz dizine cikartiniz.

Sira Sizole 6 |

2] +r®o0aT Q@

e XZ duzlemine bir Sketch aginiz. Line ve Spline komutlari ile gérseldeki gibi ¢izim yapiniz.
e Offset komutu ile 5 mm iceri ofsetleyiniz.
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Trim komutu ile olusan fazlaliklari kesiniz ve Line komutu ile acik uclari tamamlayarak ¢izimi bitiriniz.

Finish Sketch komutunu tiklayiniz.

Revolve komutuyla kapali profil olarak cizimi ve donis icin gerekli referans eksenini seginiz.

Fincanin agiz kismindaki iki cemberi seciniz ve 2 mm yaricap degerinde Fillet komutu ile yuvarlatiniz.

Ayni islemi fincanin alt kismina da uygulayiniz.

XZ diizleminde yeni bir Sketch olusturunuz. Line ve Spline komutlarini kullanarak tabagi giziniz. Finish

Sketch komutunu tiklayiniz.

Revolve komutu ile fincan tabagi elde ediniz. Fincan tabaginin kenarlarini Fillet komutuyla 1 mm

yaricapinda, alt diizlemine 2 mm yaricapinda yuvarlatiniz.

XZ dizleminde Spline komutuyla gorseldeki gibi egriler ile fincanin kulpunu olusturunuz.
e Construct > Plane Tangent to Face At Point komutu ile bir noktadan bir ylize teget olan diizlem

olusturunuz.
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e Yeni olusan dizlemin orijin noktasinda 10 mm c¢apinda bir gember ciziniz. Finish Sketch tiklayiniz.

e Sweep komutunu seginiz. Profil olarak 10 mm ¢apli gember, Path olarak ¢izilen egri, Operation olarak
Join seginiz.

e Fincanin kulpa baglandig yeri Fillet komutu ile 2 mm yaricapinda yumusatiniz.

e Tasarimi kaydediniz.

SiraSizde 7 B

° EXY diizlemine Box komutu ile 15,8 mm genisliginde, 31,8 mm uzunlugunda, 9,6 mm yiiksekliginde bir
kutu olusturunuz.

® RECTANGULAR PATTERN

Pattern Type (D Bodies -

Objects I 1 selected X

Directions

Distance Type  hoh Extent v

Suppress @

Quantity 2

Distance 8 A
Direction Type 5 One Direction L2
Quantity 4

Distance -24.00 mm v
Direction Type ¥ Gne Direction ¥
[i] OK Cancel

e Olusturdugunuz kutunun Ust ylizeyine kenardan 3,9 mm uzaklikta, 5 mm capinda, 3,9 mm yiksekliginde
bir silindir olusturunuz.

e Rectangular Pattern komutunu ¢alistiriniz.

e Pattern Type olarak Bodies seciniz.

e Objects olarak silindirik parcayi seciniz.

e Directions olarak ¢ogaltma yoniini seginiz.
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e Distance Type olarak Extent seciniz.

Quantity ve Distance ayarlari ile 24 mm boyunca yatayda nesnenin 4 adet olmasini saglayiniz.

Quantity ve Distance ayarlari ile 8 mm boyunca dikeyde nesnenin 2 adet olmasini saglayiniz.

e Direction Type ile cogaltma isleminin yonin( belirleyiniz.

OK tusuna basarak islemi tamamlayiniz.

Olusturdugunuz nesneyi kaydediniz.

ira Sizde 8 B

e XY dizlemine 5 mm ¢apinda, 5 mm yuksekliginde bir silindir olusturunuz.

e Olusturdugunuz silindirin alt ylzeyinde orijin noktalari ayni, 3 mm ¢apinda 70 mm uzunlugunda bir
silindir daha olusturunuz.

e Fillet komutu ile silindirik ylizeylerin kenarlarini ve birlesim noktalarini 0,5 mm yuvarlayiniz.

e Threat komutunu seginiz. Faces olarak dis agilacak silindir ylizeyini seginiz.

e Modeled secenegini tiklayiniz.

e Full Length secenegini kaldiriniz ve baslangi¢ noktasi icin Offset olarak 0 mm, dis uzunlugunu belirlemek

icin Length degeri olarak 35 mm giriniz.

Civata basinin st yiizeyinde bir Sketch olusturunuz ve yaricapi 2 mm olan bir altigen ciziniz. Extrude
komutu ile ice dogru 3,5 mm kesme islemi yaparak civatanin basini altigen alyan anahtara uygun sekilde

olusturunuz.

Gira Sizde 0 B

o XY dizlemde bir taslak olusturunuz.
e -X, =Y eksenlerinden ve orijinden gecen Construction Line ¢iziniz.
e Center Rectangle komutu ile merkezi orijin noktasinda olan 20 mm ve 90 mm ebatlarinda bir dikdértgen

ciziniz. Kesik ¢izgi Uzerinde ¢api 4 mm ve orijine uzakligi 25 mm olan iki cember ¢iziniz.
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Extrude komutu ile gembere 3 mm yukseklik degeri veriniz.

Ayritlari 3 mm ve 20 mm olan mentese ylzeyinde bir taslak olusturunuz. Nesnenin hemen bitisiginde
sola dogru 3 mm yuksekliginde ve 1,5 mm genisliginde bir dikdértgen ciziniz. Dikdortgene teget, 3
mm ¢apinda bir gember ve bu cemberle ayni merkezli 2 mm capinda bir cember daha ciziniz. Gerekli

kisitlamalari vererek nesneye Fully Constrained (Tam Cakisik) 6zelligini kazandiriniz.

@2.00
150

23.00

Segcili diizlemleri Extrude komutuyla mentesenin diger ucuna 90 mm uzatiniz.

Ust ylizeyde bir taslak cizim olusturunuz. Kesme islemi icin gerekli dikdortgenleri, her iki késeye ayni
mesafe ve uzunlukta olacak bigcimde c¢iziniz. Extrude komutu ile dikdortgensel bolgeleri secip asagi
yonde uzatarak kesme islemini gerceklestiriniz. Kesme isleminden sonra size bakan yiizeyleri Offset

Face komutu ile iceri dogru 1,3 mm oGteleyiniz.

192 'CEVAP ANAHTARI



15.00 |

e Timeline cizgisini geriye ¢ekiniz.

Wb » oy ol

e Move komutunu galistiriniz. Tasinacak nesneyi Body olarak ayarlayip seginiz. Segilen nesnenin bir
kopyasini olusturmak icin Create Copy secenegini aktif hale getiriniz. Y Distance degerini -23 mm olarak
belirleyiniz.

e Timeline gizgisini ileri dogru uzatarak kopyalama islemini saglayiniz.

e Mentesenin gosterilen ylzeyi Uzerinde Sketch olusturunuz. Project komutunu calistiriniz. Project
paletinde yer alan Geometry nesnesini mentese milinin gececegi cember olarak seginiz.

e Circle komutu ile bir gember ciziniz.

© PROJECT
Geometry

Selection Filter @]
Projection Link @

°

[Select objects to project

e ki cember (kirmizi ve sari renkle gosterilen) arasi mesafeyi Sketch Dimension komutu ile 0,1 mm

olarak belirleyiniz. Extrude komutu ile icteki cembere 90 mm degerinde uzunluk vererek mil nesnesini
olusturunuz.
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e Agcikta kalan kisimlari kapatmak icin Sketch ortamina gidiniz. Sketch ortamina girebilmek icin Rectangle
komutunu calistiriniz. Dikdortgen cizmeden 6nce Project komutunu calistiriniz. Selection Filter olarak
Body, Geometry olarak da ortadan gegen mil nesnesini segerek OK tusuna basiniz. Kapatilacak alani

Rectangle komutu ile ¢iziniz.

Select sketch objects to dimension

e Sketch Dimension komutuile cizilen dikdortgen ve ylizeyler arasindaki mesafeyi 1 mm olarak belirleyiniz.
Yizeyleri secerek Extrude komutunu galistiriniz. Opeartion olarak Join seginiz ve mesafeyi 3 mm giriniz.

e Assemble > New Companent komutunu c¢alistiriniz. From Bodies secenegini aktiflestiriniz. Dizayn
sayfasindaki gévdeleri secerek OK tusuna basiniz.

® NEW COMPONENT
Empty Component ©
From Bodies ®
fy Bodics

L] OK | Cancel

e Browser altinda Companentl:1 ve Companent2:1 isminde iki bilesenin yer aldig1 goriliir. Companentl
bilesenini yere sabitlemek icin Ground komutunu calistiriniz.

e Joint komutunu galistiriniz. Motion Type olarak Revolute hareket tiirlini seginiz.

e Componentl ve Component2 alanlarini kullanarak montaj nesnelerini seciniz. Se¢cim esnasinda
parcalarin monte edilecegi Joint Origin noktalarini sirasiyla gosteriniz.

e Bilesen, mil etrafinda dondirilecegi icin Joint Origin noktalari milin orta noktasi olarak segilir. OK
tusuna basarak islem bitirilir.

e Animate komutu calistirildiginda donen nesnenin, sabit nesnenin icinden gectigini gozlemleyiniz. Bu
durumu engellemek icin Browser altinda Joints dalinda bulundan Revl (zerine farenin sag tusu ile
tiklayiniz. Gelen meniden Edit Joint Limits komutunu calistiriniz.

e Hareketin almasini istediginiz en az ve en fazla agi degerlerini giriniz.
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